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Without the prior written consent of ZKTeco, no portion of this manual can be copied or forwarded in any
way or form. All parts of this manual belong to ZKTeco and its subsidiaries (hereinafter the "Company" or
"ZKTeco").

ZK is a registered trademark of ZKTeco. Other trademarks involved in this manual are owned
by their respective owners.

This manual contains information on the operation and maintenance of the ZKTeco equipment. The
copyrightin all the documents, drawings, etc. in relation to the ZKTeco supplied equipment vests in and is
the property of ZKTeco. The contents hereof should not be used or shared by the receiver with any third
party without express written permission of ZKTeco.

The contents of this manual must be read as a whole before starting the operation and maintenance of the
supplied equipment. If any of the content(s) of the manual seems unclear or incomplete, please contact
ZKTeco before starting the operation and maintenance of the said equipment.

It is an essential pre-requisite for the satisfactory operation and maintenance that the operating and
maintenance personnel are fully familiar with the design and that the said personnel have received
thorough training in operating and maintaining the machine/unit/equipment. It is further essential for the
safe operation of the machine/unit/equipment that personnel has read, understood and followed the
safety instructions contained in the manual.

In case of any conflict between terms and conditions of this manual and the contract specifications,
drawings, instruction sheets or any other contract-related documents, the contract conditions/documents
shall prevail. The contract specific conditions/documents shall apply in priority.

ZKTeco offers no warranty, guarantee or representation regarding the completeness of any information
contained in this manual or any of the amendments made thereto. ZKTeco does not extend the warranty
of any kind, including, without limitation, any warranty of design, merchantability or fitness for a particular
purpose.

ZKTeco does not assume responsibility for any errors or omissions in the information or documents which
are referenced by or linked to this manual. The entire risk as to the results and performance obtained from
using the information is assumed by the user.

ZKTeco in no event shall be liable to the user or any third party for any incidental, consequential, indirect,
special, or exemplary damages, including, without limitation, loss of business, loss of profits, business
interruption, loss of business information or any pecuniary loss, arising out of, in connection with, or
relating to the use of the information contained in or referenced by this manual, even if ZKTeco has been
advised of the possibility of such damages.
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This manual and the information contained therein may include technical, other inaccuracies or
typographical errors. ZKTeco periodically changes the information herein which will be incorporated into
new additions/amendments to the manual. ZKTeco reserves the right to add, delete, amend or modify the
information contained in the manual from time to time in the form of circulars, letters, notes, etc. for better
operation and safety of the machine/unit/equipment. The said additions or amendments are meant for
improvement /better operations of the machine/unit/equipment and such amendments shall not give any
right to claim any compensation or damages under any circumstances.

ZKTeco shall in no way be responsible (i) in case the machine/unit/equipment malfunctions due to any
non-compliance of the instructions contained in this manual (ii) in case of operation of the
machine/unit/equipment beyond the rate limits (iii) in case of operation of the machine and equipment in
conditions different from the prescribed conditions of the manual.

The product will be updated from time to time without prior notice. The latest operation procedures and
relevant documents are available on http://www.zkteco.com.

If there is any issue related to the product, please contact us.

ZKTeco Industrial Park, No. 26, 188 Industrial Road,
Tangxia Town, Dongguan, China.

+86 769 - 82109991

+86 755 - 89602394

For business related queries, please write to us at: sales@zkteco.com.

To know more about our global branches, visit www.zkteco.com.
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ZKTeco is one of the world’s largest manufacturer of RFID and Biometric (Fingerprint, Facial, Finger-vein)
readers. Product offerings include Access Control readers and panels, Near & Far-range Facial Recognition
Cameras, Elevator/floor access controllers, Turnstiles, License Plate Recognition (LPR) gate controllers and
Consumer products including battery-operated fingerprint and face-reader Door Locks. Our security
solutions are multi-lingual and localized in over 18 different languages. At the ZKTeco state-of-the-art
700,000 square foot ISO9001-certified manufacturing facility, we control manufacturing, product design,
component assembly, and logistics/shipping, all under one roof.

The founders of ZKTeco have been determined for independent research and development of biometric
verification procedures and the productization of biometric verification SDK, which was initially widely
applied in PC security and identity authentication fields. With the continuous enhancement of the
development and plenty of market applications, the team has gradually constructed an identity
authentication ecosystem and smart security ecosystem, which are based on biometric verification
techniques. With years of experience in the industrialization of biometric verifications, ZKTeco was officially
established in 2007 and now has been one of the globally leading enterprises in the biometric verification
industry owning various patents and being selected as the National High-tech Enterprise for 6 consecutive
years. Its products are protected by intellectual property rights.

This manual introduces the operations of ZKBio Access IVS software.

All figures displayed are for illustration purposes only. Figures in this manual may not be exactly consistent
with the actual products.
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Document Conventions

Conventions used in this manual are listed below:

GUI Conventions

Convention Description
Bold font Used to identify software interface names e.g. OK, Confirm, Cancel
> Multi-level menus are separated by these brackets. For example, File > Create > Folder.
ropece
Convention Description
<> Button or key names for devices. For example, press <OK>
Window names, menu items, data table, and field names are inside square brackets. For
2 example, pop up the [New User] window
/ Multi-level menus are separated by forwarding slashes. For example, [File/Create/Folder].
Symbols

Convention Description

.
h This implies about the notice or pays attention to, in the manual

l;’. The general information which helps in performing the operations faster

The information which is significant

0 Care taken to avoid danger or mistakes
c The statement or event that warns of something or that serves as a cautionary
example.
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1 Introduction

Today, the modern companies' concern for security has rapidly increased. To achieve this, ZKTECO brings
you ZKBio Access that helps the customers to integrate the operations of access control and attendance
on one platform. The system is divided into four modules, namely: Personnel, Access, Attendance and
System Management.

Features

* |t can manage about 2000 personnel data.

* It has a powerful data processing capacity.

* Users’ data are more secured with multi-level management role-based level management.

* [tcantrack events and operations in real-time to ensure proper feedbacks of data to the management.
Configuration Requirements

* Dual-core processor with a speed of 2.4GHz or above.

* System Memory of 4GB or above.

* Available space of 10GB or above. We recommend using NTFS hard disk partition as the software

installation directory.
* Monitor Resolution of 1024 x 768px or above.
Operating System

* Supported Operating Systems: Windows 7 / Windows 8 / Windows 8.1 / Windows 10 / Windows
Server 2008/2013(32/64)

* Supported Database: PostgreSQL
¢ Recommended Browser version: IE 11+/Firefox 27+/Chrome 33+

2Note: You must use IE 8.0 or newer version for fingerprint registration and verification.

1.1 Personnel Module

The Personnel module is used to set the person details and their department. It primarily consists of two
parts: Department Management settings, which is used to set the Company’s organizational chart;
Personnel Management settings, which is used to add the personal information, assign departments,

maintain and manage personnel details.

1.2 Access Control Module

The Access Control module is a web-based management system that enables the normal access control
functions, management of interconnected access control panel via computer, and unified personnel
access management. The access control system sets door opening time and levels for the registered users.
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1.3 Attendance Module

The Attendance Module consists of timetable, shift and schedule management, cross-regional attendance
Management. You can also manage other exceptions such as leave, late, overtime etc. At the same time,
access control can be configured along with attendance management to generate attendance records.

1.4 VMS Module

The VMS Module consists of ZKBio Access VMS module and ZKBio VMS Plugin. It can be used in conjunction
with NVR, DVR, IPC, MDI, SDI network storage devices. ZKBio Access VMS Plugin is a client software
launched by ZKTeco. Users can manage video surveillance through ZKBio Access VMS module or ZKBio
VMS Plugin as they want.

1.5 System Management Module

The System Management is primarily used to assign system users and configure the roles of corresponding
modules, manage databases such as backup, initialization, and recovery, and set system parameters and

manage the system operation logs.
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2 System Operations

2.1 Login

User Login

After installing the software, double-click the ZKBio Access icon @ to open the software. You may also

open the recommended browser and enter the IP address and server portin the address bar. The IP address
is http://127.0.0.1:8098 by default.

If the software is not installed in your server, you may input the IP address and server port in the address
bar.

#Note: The username of the super user is [admin], and the password is [admin], then click [Login]. After
logging-in for the first time, you need to reset your password.

2.2 Activate the System

Please refer the corresponding license activation document.

2.3 Modify Password

You can modify the login password in [Personal Information].

Welcome, admin

Click here to open modify interface
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Personal Information

Username® admin
Usermame should be composed between 1-30 characters and

in letters,numbers, or symbols (@/./~+/_).

Reset Password !

Password™ -
Password is a ~ of 4 to 18 characters,default is
111111,

Select the check
box to reset

Confirm Password®

Superuser State 04

Raole

Auth Department
If you select no department, you will possess all depariment
rights by default.

Authorize Area

If you select no area, you will possess all area rights by
default.

Email

First Mame admin

Select the [Reset Password] check box to modify the password.

&sNote: Both the Superuser and the new user are created by the super user (the default password for the
new users is 111111). The username is not case-insensitive, but the password is case-sensitive.

2.4 About

Click the [About] button on the top right corner of the interface to check all the software version and

license information.

2.5 Help

Click the [Help] button on the top right corner of the interface to view user manual.

2.6 Exit the System

Click the [Logout] button

Welcome, admin

Click here to exit the system
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3 Personnel

You can configure the Personnel Management and Card Management in this module.

m Welcome, admin J0%
© Department Name Personnel ID Name Moer Q. @
The current query conditions None
x Personnel (
("% Refresh @ New [ Adjust Department ff* Delete [ # Export = [# Import ~ (1) Statistics
Person
Department Name(2.
P @ Personnel D~ First Name Last Name Department Name  Card Number Biological Template Create Time Status
Department Quantity
2 ZKTeco Department Name S0 ®0 § oo™ 2020-02-20 16:37:07 Normal
Temporary Personnel = " SO0 BOWOT
1 Test Department Name @o [ 1 §o gga %u 2020-02-20 16:36:56 Normal
Custom Attributes -
Parameters
I3
[ card Management 12 50rows perpage ~ JumpTo 1 /1Page  Total of 2 records.

3.1 Personnel Management

The personnel management includes these modules: Personnel, Department, Custom Attributes, and
Parameters.

3.1.1 Personnel

By using this management, the user shall register the personnel in the system, or import the personnel
information from other software or file into this system. For details, see Common Operations.

The main functions of Personnel Management include Add, Edit, Delete, Export and Import personnel, and
Adjust Department.
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> Add Personnel

1. Click [Personnel Management] > [Personnel] > [New]:

New
Personnel ID* 3 Department” Depariment Name
First Name Last Name
Gender Maobile Phone
Certificate Type @ | ——— Certificate Number
Birthday Email
Device Verification Password Card Number = Artra Sae 1305 A0
Biological Template Quantity go@o E o@o ﬁ 0 -E—r.ow-se- 0 C;;Jture
Access Control Time Attendance Personnel Detail
Levels Seftings Superuser Mo

# General

Device Operation Role

Ordinary User

Disabled

Set Valid Time

(oo non |0 Jcaa ]

Fields are as follows:

Personnel ID: An ID may consist of up to 9 characters, within the range of 1 to 79999999. It can be
configured based on your requirements. The Personnel ID contains only numbers by default but may also
include letters.

= Notes:

(1) When configuring a personnel number, check whether the current device supports the maximum
length and whether letters can be used in Personnel ID.

(2) To edit the settings of the maximum number of characters of each personnel number and whether
letters can also be used, click Personnel > Parameters.

Department: Select from the drop-down menu and click [OK]. If the department was not set previously,
only one department named [Company Name] will appear.

First Name/Last Name: The maximum number of characters is 50.

Gender: Set the gender of personnel.

Mobile Phone: Enter the phone number of the user.

Certificate Type: There are four types of certificates: ID, Passport, Driver's License and Others.
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Certificate Number: Enter the ID number.

Birthday: Input employee’s actual birthday.

Email: Input employee’s Email ID. The max length is 30.

Device Verification Password: Set password for verifying on the device using personnel accounts. It can
only contain up to 6-digits. It cannot be the same with other user’s password and the duress password.
Card number: The max length is 10, and it should not be repeated.

Personal Photo: The picture preview function is provided, supporting common picture formats, such as
jprg. jpeg, bmp, png, gif, etc. The best size is 120x140 pixels.

Browse: Click [Browse] to select a photo on your local drive to upload.

Capture: Taking photo by camera is allowed when the server is connected with a camera.

Register Fingerprint / Finger Vein: Enroll the Personnel Fingerprint, Finger Vein, Palm, or Face. To trigger
the alarm and send the signal to the system, scan the Duress Fingerprint.

How to register fingerprint:

Biological Template Quantity gogo E 0o ﬁ 0

Download Driver
Access Control E— Personnel

(1) Move the cursor to the fingerprint icon position, a registration pop-up or driver download dialog box

will appear, click [Register].

(2) Select a fingerprint, press the finger on the sensor three times, then “Fingerprint registered
Successfully” will be prompted.

(3) Click [OK] to complete registration.

Fingerprint Fingerprint
Yy Y '
- [ [ .
T | [ ~ r\’“‘\\ I, LY f |
| | I|I' ."I i LY II { | Duress Fingerprint | | / '\.._\ | Duress Fingerprint

by &JL./'/ f'f VO N
4 7 e . \
/{ ) { -~ ]

\ YA, o N /" \ e J
— N e R

Click a fingerprint to delete. If you need to register a duress fingerprint, select the Duress Fingerprint check
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box.
&sNotes:
(1) Iffingerprints are duplicated, “Don’t repeat the fingerprint entry” will be prompted.

(2) If the fingerprint sensor driver is not installed, click “Install driver” and the system will prompt to
download and install the driver.

(3) Afterinstalling the fingerprint sensor driver, if the fingerprint register button is grey in IE browser while
it is normal in other browsers (such as Firefox, Google), you can change the settings of IE browser, as
per the following:

a. In Internet Explorer, click [Tools] > [Internet Options] > [Security] > [Credible Sites], add
http://localhost to the credible sites, then restart the Internet Explorer.

b. InInternet Explorer, click [Tools] > [Internet Options] > [Advanced] > [Reset] to pop up a dialog of
Reset Internet Explorer Settings, click [Reset] to confirm; then restart the Internet Explorer (you
may try when Point 1 does not help).

c. If all the above settings do not work, please execute following operations (take IE11 browser as
an example): click [Tools] > [Internet Options] > [Advanced] > [Security], check the option of
[Allow software to run or install even if the signature is ...], and remove the select [Check for server
certificate revocation], then restart IE.

d. If the browser is below IE8, the fingerprint registration page will be different:

Fingerprint Fingerprint

The finger information:
Right Hand
Forefinger

W = | =

e. The system supports access from the Live20R fingerprint device and the fake fingerprint

prevention function.
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The finger Information:
Right Hand
Middie Finger

W =

2. Set the Access Control parameters for the personnel. Click [Access Control]:

Access Control Time Attendance Personnel Detail
Levels Seitings Add Superuser No
# General Select All : .
Unselect Al Device Operation Role Ordinary User
Disabled
Set Valid Time

Fields are as follows:

Level Settings: Click [Add], then set passage rules of special positions in different time zone.
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Aedel B0 | eeeds

T £ons D\. (E

Laval Mame |
I

| The current query conditions Mane

| Altemative SulaciediD

Larwad Mlams limea Lans Larval Memma Tima £ons

SO forws ed page =

Superuser: In access controller operation, a super user is not restricted by the regulations on time zones
and has extremely high door-opening priority.

Device Operation Role: It will define the authority level in the device of the user.
Disabled: Temporarily disable the personnel’s access level.

Set Valid Time: Doors can be set to open only within certain time periods. If the check box is not
selected, the door is always active.

#sNote: The system will automatically search for the relevant numbers in the departure library during
verification.

The Personnel Information List, by default, is displayed as a table. If Graphic Display is selected, photos
and numbers will be shown. Put the cursor on a photo to view details about the personnel.

& Notes:

(1) Not all devices support the “Disabled” function. When a user adds a device, the system will notify the
user whether the current device supports this function or not. Please upgrade the device to use this
function.

(2) Notall the devices support the “Set Valid Time” function. Some devices only allow users to set the year,
month, and day of the local time. When a user adds a device, the system will notify the user whether

the current device supports this function or not. Please upgrade the device to use this function.
3. Click [Personnel Detail] to access the details and editing interface and enter information.
Access Control

Time Attendance Personnel Detail

Employee Type v Hire Type v
Job Title Street
Birthplace Country
Home Phane Home Address
Office Phone Office Address
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4. After entering the information, click [OK] to save and exit, the personal details will be displayed in the
added list.

» Edit Personnel

Click [Personnel] > [Person], then select a person, and click [Edit].

» Delete Personnel

Click [Personnel] > [Person], then select a person, and click [Delete] > [OK] to delete.
& Note: All relevant information about the person will be deleted.

» Adjust Department

1. Click [Personnel] > [Person], then select a person, and click [Adjust Department]:

ee 0000 ==00009

Ceparimeni Hamo Prrnmna D wrar O (@
3. Click '

mE T+ Aeiman [ hiew Wmm-wmm'@m

a7 Diapansast Mansaid)

Ferzamsl 1D Firef Hames Lawei Hpmes Cepewimand kams  Card Humber Faalapea | Termpinis Cieais Tima
v [ Marketing D epanimantli Gnandy
¢ O Owselspment Depariment®) | - g AREA Deparment @U@0 fofont  FoeonTe s
¢ [ Financel Depasmaniii)
o Rt Seincied Pamcrt T @0 Eoo 01 e
LA7ET @0 @0 fo@o Rt A0e00T e
2, Select a person 1550 @U@0 oo L sonor s

(S O

Trane i Aade
I
4 "
[T s owm Efows i gage - JumpTo o HFage  Tobl of d recoen

2. Select from the dropdown list of “New Department”.
3. (Click [OK] to save and exit.

> Statistics

Click [Personnel] > [Person] > [Statistics]. View the number of personnel, the number of fingerprints, face
templates, finger vein enrolled, card numbers, gender and other statistical information.
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> Export

Statistical Type Current Total
Male 0
Female 0
Personnel Quantity 2
Fingerprint Quantity 2
Face Quantity 0
Finger Vein Quantity 0
Palm Quantity 2
Mumber of Cards Held 0
Face Picture Quantity 0

Close

Click [Personnel]> [Person]> [Export] to export personnel information, personnel biometric templates and

personnel photo.

[ Export ~ [ ¥ Import ~
I__I’ Export Personnel

r_,’ Export Biometric Template
I__I’ Export Personnel Photo

1. Select the type of file and Export mode as required.

The File Type

Export Mode

‘ EXCEL File v ‘

(@ All data (export up to 30000 pieces of data)
() Select data volume export (export up to 30000 pieces of data)
From the article 1 Strip, is derived 100 Data
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Personnel
Pessomnal [D First Kama Lot Name IJErl.n ment Dapariment Kama Card Kunksr
umber

432 EX 2 M arketing Depari ment
343 i mple 4 Financisl Dipar mes
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2. Export the Biometric Template.

The File Type EXCEL File L]
Export Mode (m) Al data (Can export up to 30000 data)
Personnel Biometric Template
Posoms D | Frst Nuve Last Maree Beretic Enoreetre Bovey Swewtic Eormetyv: Swewtre Torhe
PEC0 MAC o
PO g AEPY A SADMTWTRATLOAL ¥ %) :
o D05 -WATAYUFTwted TOaoliss ase 7
LAIVPSQLN ) AZEMDALF WiZoto!
SENFOER Py YO F TEn ) 1 12004170Y 2w 0
IV TCIGLAADF HAL S BF G VWGPV 1R 350 v
el 147 0RSA PORIR, ! 2 ppod
1 Jary Warg 1 Frgepred 10 4 ] YGAHAYSTLE 2
m:-" P e BACORS gate’
AgarIK
TN o7
o o) INRHRE RS o
AL B Pl AINA EQe

3. Export Personnel Photo.

The Fila Typa ZIP v

Cancel

> Import

Click [Personnel] > [Person] > [Import] to import personnel information and personnel biometric templates.

It only supports personnel information templates for importing.
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3 Import Biometric Template
3 Import Personnel Photo

1. Import Personnel: Select “Yes” for [Update the existed Personnel ID in the system], the original data
will be overwritten when the personnel ID is repeated; select “No”, the opposite.

File Format (®) Excel

Select File Choose file No file chosen

The default is the second row.

2. Import Biometric Template.

File Format (@) Excel

Select File Choose file |No file chosen

The default is the second row.

3. Import Personnel Photo: The personnel photo needs to be named by personnel ID, supporting

common picture formats, such as jpg, jpeg, png, gif, etc.
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Import Persannel Photo

ﬁ Please Select Photo

Total : O (Please do not delete photo while uploading)
A

T
T
T
5
{
T
T
X
w
ESl
al
m
8]
8]

Start Upload Add More

3.1.2 Department

Before managing company personnel, it is required to set a departmental organization chart of the
company. Upon the first use of the system, by default it has a primary department named [General] and
numbered [1]. This department can be modified but can’t be deleted.

Main functions of Department Management include Add, Edit, Delete, Export and Import Department.
» Add a Department

1. Click [Personnel] > [Personnel Management] > [Department] > [New]:

ZK 8 — Welcome, admin 5

@ Bemﬂ;‘m 1. Click on Personnel ]
—— S— - 3. Click on New
_ current query conditions: None:
1 Personnel Management (= Y
——
[l = (% Refresh  [® New Slete [ % Exporl [ Import
Personnel !
4 [ Depariment Name
[ | | Depariment Name Depariment Parent Depariment Parent Depariment Name  Greated Dale Operations
» [ Marketing Depariment. Number Number
) » DD D O 2019-01-10 09:35:55 Edil
> h i New
»
[ Financial Department o — RS TEAES Edit
Parameters [ Testt It the new depariment does not appear in the list, please contact the :
I administrator to re-authorize the user to edit the department Name 2019-01-10 09:35:58 Edit
2. Click on Department [ Cepartment Number* L Name 2019-01-10 08:35:58 Edil
[ Deparment hame’ Test 2019-01-10 17:57:20 Edit Delete
Sort* 99999
| Jepartment 2013-01-10 17:56:54 Edit Delete
Parent Department Marketing Department \, -
™. 4. Enter details
o]
[ card Management K ¢ 16 > 3 S0rowsperpage ~ JumpTo 1 /1 Page  Total of 6 records
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Fields are as followed:

Department Number: Letters and numbers are available. It cannot be identical to the number of other
departments. The number shall not exceed 30 digits.

Department Name: Combination of characters up to 100.In case of different levels, the department names
can be repeated.

Sort: It is used to set the priority (level) of a department within a parent department. The smaller the
number of department sort is, the higher ranks such department has. You can set any number from 1 to
999999.

BB
4 [ Department Name
4 [ Marketing Department
¥ [ ] Test
¥ [ ] Tasii
v [ Test2 :
“ Development Departne,
v [ Tests \ To ﬁletltl'lis
v [ Test3 . — ‘
¥ |_] Tast4

Financial Depariment

Parent department: Select a parent department from the drop-down list. The parent Department is an
important parameter to determine the company’s organizational chart. On the left of the interface, the
company’s organizational chart will be shown in the form of a department tree.

The current query conditions Mone

BB

i [ Department Mame
Marketing Department
Development Department

Fimancial Department

2. Afterfilling the details, you can click [OK] to complete adding; or click [Cancel] to cancel it or click [Save
and new] to save and continue adding a new department.

To add a department, you can also choose [Import] to import department information from other software
or other documents into this system. For details, see Common Operations.

> Edit a Department

Click [Personnel] > [Personnel] > [Department] > [Edit].
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» Delete a Department

1. Click [Personnel] > [Personnel] > [Department] > [Delete]:

Are you sure you want to perform the delete
operation?

2. (Click [OK] to delete.

#Note: If the department has sub-departments or personnel, the department cannot be deleted.

> Export

It can be exported in EXCEL, PDF, and CSV file format.

Thei Fib Typea EXCEL Fila L

Expart Mode w0 Al data (expor up o 30000 plecas of data)
) Select data volune export (export up to 30000 pleces of data)
Strip, is derved 100

From the article 1 Data

o J o |

Department

Department Name

Department Number

ZKTeco

1

Parent Department Number

Parent Department Name

Created Date

2018-12-21 14:10:08

Marketing Department

1

ZKTeco

2018-12-21 14:10:08

Development Department

1

ZKTeco

2018-12-21 14:10:08

Financial Department

2
3
4

1

ZKTeco

2018-12-21 14:10:08

> Import

1. Click [Personnel] > [Department] > [Import], the import interface is as follows:

File Format (®) Excel
Select File Choose file |No file chosen

The default is the second row.
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2. Import department information: can import EXCEL, CSV format files.

3. After importing the file, the system will match the imported report field and the data segment field
automatically.

3.1.3 Custom Attributes

Some personal attributes can be customized or deleted to meet different customers' requirements. When
the system is used for the first time, the system will initialize some personal attributes by default.
Customized personal attributes can be set for different projects according to requirements.

> New a Custom Attribute

Click [Personnel] > [Personnel Management] > [Custom Attributes] > [New], then edit the parameters and
click [OK] to save and exit.

ZK & © & ©

@ Display Name |:| Attribute Value Q ®
The current query conditions None
x Personnel
.:L Refresh L@ New ﬁf} Delete
Person . } . : .
Display Name Attribute Value Input Type Row Column Display in Operations
Person List
Department
Employee Type  Official Staff,Probation Staf Pull-down List 3 1 No Edit Delete
Temporary Personnel : . .
Hire Type Contract Worker;Non Contr Pull-down List 3 2 No Edit Delete
Job Title Text 4 1 No Edit Delete
Parameters Street Text 4 2 No Edit Delete
Birthplace Text ) 1 No Edit Delete
Country Text 5 2 No Edit Delete
Home Phone Text [ 1 No Edit Delete
Home Address Text 6 2 No Edit Delete
Office Phone Text 7 1 No Edit Delete
Office Address Text 7 2 No Edit Delete
Mewr
|
Digplay Mame” Test Attribute value
| Imput Type® Pull-down List [
| Attnbute Value * ABCD |
1
|
|
Ronw® 1 |
1
Calumn® 1 |
|
Display im Person List & Yes | Mo

e aaton 1ok~ acs
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Fields are as follows:
Display Name: Must be filled and should not be repeated. Max length is 30.
Input Type: Select the display type from “Pull-down List”, “Multiple Choice”, “Single Choice” and “Text".

Attribute Value: Suitable for lists displaying as “Pull-down List”, "Multiple Choice” and “Single Choice”
lists. Use a “;” to distinguish the multiple values. If the input type is “Text”, the attribute value is not suitable.

Row/Colum: The column and row of a field are used together to control the display position of the field.
Numerals are supported. The column number can be either 1 or 2, and the row number can only be 3 to
20. The combination of the column and row must not be duplicated. As shown in the following figure,
Employee Type, is in the first column and first row, and Hire Type is in the first column and second row.

Access Control Time Attendance Personnel Detail

Employse Type — v Hire Type — v
Job Title Street
Birthplace Country
Home Phone Home Address
Office Phone Office Address
Test —_ v

A

B

C

D

» Editing a Custom Attribute
Click [Edit] to modify the corresponding attributes.
» Deleting a Custom Attribute

Click [Delete] to delete an unused attribute. If the attribute is in use, the system will pop up confirmation
before confirming to delete.

& Note: The custom attribute will not be recovered once deleted.
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3.1.4 Parameters

1. Click [Personnel] > [Personnel Management] > [Parameters]:

@ Personnel ID Setting
l Personnel C The Maximum Length: 9

Support Letters: Yes ®) No
Personnel ID Auto-increment:(®) Yes No

Person

Department Card Setting
The Maxi Length: Bits(Bi

Temparary Personnel & Maximum Length:|32 its(Binary)
Card Format Display: (e Decimal Hexadecimal

Custom Attributes
Temporary Personnel Setting

Enable Temperary Personnel Auto-audit: (e Yes No

Self-service Registration

QR Code URL: |http:/iServer address:Port

2. You can set the maximum length for a Personnel ID and whether it will support letters or not. If
Personnel ID Auto increment is selected as Yes, then while adding personnel, the ID in the field
automatically updates to the next succeeding new number.

3. Set the maximum length (binary number) of the card number that the current system will support.
4. Set the card format currently used in the system. The card format cannot be switched once it is set up.

5. Click [OK] to save the settings and exit.

3.2 Card Management
There are three modules in card management: Card, Wiegand Format and Issue Card Record.

3.2.1 Card
It shows the cards issued in the system with their status.

ZI( 8 Welcome, admin 5
[G] CadNumber| | Persomel D Department Name Morew Q @

The current query conditions None

‘7) Personnel
— (% Refresh

- Card Management

Card Number Personnel ID First Name Last Name Department Department Issue Card Date Card State
Number

123456789 2 ZKTeco 1 Department Name 2020-02-20 16:41:19 Effective

Wiegand Format

Issued Card Record
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3.2.2 Wiegand Format

Wiegand Format is the card format that can be identified by the Wiegand reader. The software is
embedded with 9 Wiegand formats. You may set the Wiegand card format as needed.

At [ % ovew [ Dwwin 5 CoesFomen
L] ey Sam Cond Lz Cpwr e
Whgped Formp( Vi e - —
Rohna Formalts Viczia Dra e L
i Vi S Ll -2}
L e E
St Viunh Do L] (=]
sanmz Formail? Viccs Dra - B
] Viun D o (=]
gan=i Morrait] Viocs Drs ] Ead
¥ Vioge e -

This software supports two modes for adding Wiegand Format, if mode 1 does not meet your setting
requirement, you may switch it to mode 2. Take Wiegand Format 37 as an example:

Edit
Marne [Mhegand Fomats7
Tolal Bil* ar
Sie Coda 0
Auta F
= hlode Ore
Firg1l Parity Chackip) 1
Sacond Pamty Chackin) ar
Cdd Panty Checio(o) Even Fanty Chackia) CilKc) Sie Codais) | Marufacturar Codaim)
Start Bit II'IGIT\I.:I'-E‘ITI:..II':'.I_IM Start Bit II'ELI:EI:;':.IITI,I'I' Start B IhBI L’i::r:"lm Stmrt Bit II'IEIII.;:I:.::':'IIFH | Stari Bat 'II'ELT:;I::I:.I.':'IU'H
20 18 1 1@ 18 i z 14 | a | o
Il T
Card Check Fonmsal” PEESSESERREESS 555 COCCCOCONCDECEECEEED
Parily Check Formal® M R EEN RO 05 00 05 £ D) DT DA O R D EMHEH
-
Format Specifying:

“P" indicates Parity Position; “s” indicates Site Code; “c” indicates Cardholder ID; “m” indicates Manufactory
Code; “e” indicates Even Parity; “O” indicates Odd Parity; “b" indicates both odd check and even check; “x”
indicates parity bits no check.

The previous Wiegand Format 37: the first parity bits (p) check “eeeeeceeeceeceeeceeceee”; the second parity
bits check “0000000000000000000". Card Check Format can only be set “p, x, m, ¢, s”; Parity Check Format
can only be set “x, b, o0, e”.
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3.2.3 Issue Card Record

It records the life cycle of a card and will display the operations performed on the card.

ZK & D% @ Welcome, admin 40

[G] Card Number Action |- Morer O, ®

The current query conditions None

4,—! Personnel
fn)

(% Refresh
[l Card Management O Card Number Personnel ID First Name Last Name Action Operator ssue Card Date Change Time
123456789 2 ZKTeco Issue Card admin 2020-02-2016:4119  2020-02-20 16:41:1

Card
Wiegand Format

sued Ca

&sNote: The cards and card issuing records of an employee will be deleted altogether when the employee’s
account is deleted completely.
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4 Access

The system needs to be connected to an access controller to provide access control functions. To use these
functions, the users must install devices and connect them to the network first, then set corresponding
parameters, so that they can manage devices, upload access control data, download configuration
information, output reports and achieve digital management of the enterprise.

4.1 Device

Add an access device, then set the communication parameters of the connected devices, including system
settings and device settings. When communication is successful, you can view here the information of the
connected devices, and perform remote monitoring, uploading and downloading, etc.

4.1.1 Device

> Add Device
There are two ways to add Access Devices.
1. Add Device manually

A. Click [Access] > [Device] > [New] on the Action Menu, the following interface will be shown:

M Welcome, admin

® Device Name |:| Serial Number New 5]
The current query conditions None
E Device 3 Device Name®
Refresh N Delete [ Export Search Col ati
O Refresh [§ New [ Delete [% Q searc I Communication Type” ® TCPIIP ©) RS485 Iﬂ mmenication =
Device Name Serial Number  Area Name 1P Address” Device Ragistar Firmware Version Operations
) Model Device
1/0 Board Communication port” 4370
Door 192.168.0.105 CJHB192960013 Area Name Communication Passwerd SmartAC1 @ Ver 9.0.1.6-20190725 Edit Delete
Read 19216810232 CJI4193360005  Area Name | leon Type* Door | SpeedFace-V. & Ver 9.0.1.10-6600-01 Edit Delete
Reader
Control Panel Ty .
192.168.10.219 CUT5192460017 Area Name ontrol Panel Type One-Door Access Cont ProFace X[CF @ Ver9.0.1.10-20190820  Edit Delele
Auxiliary Input Area® Area Name
I CJT4192960006 Area Name | ProFaceX Ver 9.0.1.4-20190716 Edit Delete
Add to Level
Auxiliary Output
Clear Data in the Device when
Event Type Adding
e

Daylight Saving Time A [Clez

Device Monitoring

4 F
Real-Time Monitoring Input the details

Alarm Monitoring

Map

). Access Control

«_ — ,
0| FEES . 14 . shrowsperpage ~ Jump

Fields are as follows:

Device Name: Any character, up to a combination of 20 characters.
IP Address: Enter the IP Address of the device.
Communication port: The default value is 4370.

Communication Password: A Password should be a combination of numbers and letters of 6 digits.
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& Notes:
(1) You do not need to input this field if it is a new factory device or just completed initialization.

(2) When communication password for the standalone device is set as “0”, it means no password.
However, in case of access control panel, it means the password is 0.

(3) You need to restart the device after setting the door sensor of the standalone device.

Icon Type: It will set the representation of the device. You can choose as per the kind of device; Door and
Flap Barrier.

Control Panel Type: One-door access control panel, two-door access control panel, four-door access
control panel, Standalone Device.

Area: Select specific areas of devices. After setting areas, devices (doors) can be filtered by areas upon Real-
Time Monitoring.

Add to Level: Automatically add the device to the selected level. The device cannot be automatically
added to the selected level if the number of personnel exceeds 5000. You can add personnel after the
device is successfully added.

Clear Data in the Device when Adding: If this option is checked, the system will clear all data in the device
(except the event logs). If you add the device just for demonstration or testing, there is no need to select it.

B. After editing, click [OK], and the system will try to connect the current device.
If it is successfully connected, it will read the corresponding extended parameters of the device.

#sNote: When deleting a new device, the software will clear all user information, time zones, holidays, and
access control levels settings (including access levels, anti-pass back, interlock settings, linkage settings,
etc.) from the device, except the events records (unless the information in the device is unusable, or it is
recommended not to delete the device is used to avoid loss of information).

2, Add Device by Searching Access Controllers.

Search the access controllers in the Ethernet.
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M f:-i Welcome, admin
® Dovcatams| | Sealbumber| | e Do

The current query conditions None 4
E| DEise 3 No device found? Download Search Tools ta Local Disk
(v Refresh [® New ()t Delete [ Export Q Search Devict

Searched devices count4
| ol Progrss O | o Gt soded &

Device Name Serial Number ~ Area Name Com

/O Board T¥PE 1P Address Device Type Serial Number ®

Door 192.168.0.105 CJHBI92960013 AreaName  HTTI 1P Address MAC Address SubnetMask  Gateway Address  Serial Number  Device Type  Set Ssrver Opera

ener [ 19216810232 CJI4183360005  Area Name H1T| 192.168.0.105 265.266.256.0 (0.0.0.0 CJHB192960013  SmartACH This d¢
eager FRETRE CUTE192460017 AveaName  HTTI 192168176 2562652550 0.0.0.0 CJT4192960006  ProFace X This de

Auwsiiary Input Rl CJ74192960006 Area Name H-|-|-| 192.168.10.212 2552552550 19216810254 CJ75192460017  ProFace X[CH This de

Awiliary Output 192.168.10.232 2850852550  19216810.254 CJI4193360005  SpeedFace-V: This de

Event Type

Daylight Saving Time

Device Monitoring

Real-Time Monitoring

Alarm Monitoring

Map A The curre po

Close

Reports

[« < 14 . . GOrowsperpage v JumpTo 1 age

(1) Click [Access] > [Device] > [Search Device], to open the Search interface.
(2) Click [Search], and it will prompt [Searching...... 1.

(3) After the search is complete, the list and the total number of access controllers will be displayed.

Search Device

m Mo device found? Download Search Tools to Local Disk

Total B Searched devices count:2
otal Progress | N oo | jumiber of devices added 1

IP Address Device Type Serial Mumber ®

IF Address MAC Address Subnet Mask Gateway Address Serial Mumber Device Type Sef Server Operations
192.168.1.201 255.255.255.0  0.0.0.0 5264183100152 TDBO2 Add
192.168.213.67 255.255.255.0  192.165.213.1 CGFE184760043 SpeedFace-\! Thiz device has been added

A\ The current system communication port is 8881, please maks sure the device is set comactly.

Close

#Note: UDP broadcast mode will be used to search access devices. This mode cannot perform a cross-
Router function. IP address can provide cross-net segment, but it must be in the same subnet, and needs
to be configured the gateway and IP address in the same net segment.

(4) Click on [Add] in the search list.

If the device is a pull device, you may input a device name, and click [OK] to complete the device adding.
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Mew
Device Name®
Communication Type® @ TCPIP
IP Address™
Communication port® 4370
Communication Password
Ican Type® Door
Control Panel Type One-Door Access Coni
Area” Area Name
Add to Level
Clear Data in the Device when [}
Adding

A\ [Clear Data in the Device when Adding] will delete data in the device
(except event record), please use with caution!

Clear Data in the device when Adding: If this option is selected, after adding device, the system will clear
all data in the device (except the event logs).

If the device is a push firmware device, the following windows will pop-up after clicking [Add]. If IP Address
in [New Server Address] is selected, then configure IP address and port number. If Domain Address in [New
Server Address] option is selected, then configure domain address, port number and DNS. The device will
be added to the software automatically.

Device Name® 192.168.213.155

New Server Address” @IP Address () Domain Address
192 . 168 . 213 .25

New Server Port* 8088

Communication Password

Icon Type* Door
Area® Area Name
Add to Level —_—
Clear Data in the Device when Adding 0

ng] will delete data in the device (except event

A\ [ClearDatainthe D

}, please use
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MNew
Device Name®
Communication Type® @ TCPIP
IP Address™®
Communication port® 4370
Communication Password
Icon Type® Door
Control Panel Type One-Door Access Coni
Area” Area Name
Add to Level _
Clear Data in the Device when 0o
Adding

New Server Address: To add a device by IP Address or Domain Address, devices can be added to the
software by entering the domain address.

New Server Port: Set the access point of system.
DNS: Set a DNS address of the server.

Clear Data in the Device when Adding: If this option is selected, then after adding device, the system will
clear all data in the device (except the eventlogs). If you add the device merely for demonstration or testing,
there is no need to select it.

& Note: When using either of the above three device adding methods, if there exist residual data in the
original device, please sync original data to it after adding a new device to the software by clicking [Device] >
[Synchronize All Data to Devices], otherwise these original data may conflict with normal usage.

The current query conditions None

(¥ Refresh @ New @ Delete B Export Q Search Device 2. Device Control + @Selup v @View and Get Device Info  ~ @ Communication v

a 3 i
: : Clear Administrator permission
v Device, 2. Click on Device Control 657 L3 : RS485 Status Device Register Firmware Version
Type 1, Upgrade Fimware Parameter Model Device
4| Reboot Device
v 192.168.213.67 CGFE184760043  Area Name HTTP :11 Synchronize Time Online SpeedFace-V: @ 1.0.55
\\ ~/ Enable
( 1. Select the required device @) Disable

fi; Synchronize All Data to Devices

™ 3. Click here
N
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(5) The default IP address of the access device may conflict with the IP of a device on the local network.
You can modify its IP address: click [Modify IP Address] beside the [Add] and a dialog box will pop up
in the interface. Enter the new IP address and other parameters (Note: Configure the gateway and IP
address in the same net segment).

& Note: Some PUSH devices support SSL. To use this function, select the HTTPS port during software
installation and ensure that the device firmware supports SSL.

4.1.21/0 Board

On the device module, click [Devicel> [I/O Board]> [New] to add the I/O Board device to the software.

The current query conditions None
(C+ Refresh  [® New (f} Delete

[ | MName Area Name Owned Device Number I/O Board Type ~ RS485 Address  Operations

Door
Reader

Auxiliary Input

New
Auxiliary Qutput
S Device Name* Click to select
Daylight Saving Time 140 Board Type'
- e RS485 Add "
Device Monitoring ress
R3485 Address Code Figure ON KE
Real-Time Monitoring
o000
Alarm Monitoring 12 3 4

Map

(oo rariw 1o Jcarca ]

Enter the name of the /O Board. Select the Device by clicking the Device Name field. The device list appears
as shown below:
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pevceName [ ] ser Number Q ®

The current query conditions None

Alternative Selected(0)

Device Mame Serial Number Device Name Serial Number

0 50 rows perpage ~  Total of O records

Cancel

Select the device and click OK. Select the 1/0 Board Type. Set the RS485 Code Address by changing the
corresponding button. Click OK to save the details. You can view all the auxiliary inputs in [Auxiliary Input]
interface.

4.1.3 Device Operation

For the communication between the system and device; data uploading, configuration downloading,
device and system parameters shall be set. Users can edit access controllers within relevant levels in the
current system; users can only add or delete devices in Device Management if needed.

(% Refresh | f’ New ﬁ‘ Delete {_{ Export Q Search Device 2. Device Control ~ {§} Setup ~ @ View and Get Device Info  ~ ﬁ Communication ~

Zﬁ Clear Administrator permission

v Device Name Serial Number Area Communic: 85 Status Device Register Firmware Operations
Name Type 1. Upgrade Firmware ameter Model Device  Version
]:] Reboot Device
v SpeedFace-V5 CGFE184760043  Area Name HTTP tl Synchronize Time Offline SpeedFace-V: & 1.0.55 Edit Delete
~/ Enable
@) Disable

2 Synchronize All Data to Devices

(% Refresh E? New ﬁﬁ} Delete B Export Q Search Device 2, Device Control ~ {f;\} Setup ~ @V\ewand Get Device Info = & Communication ~

5 Set Device Time Zone
v Device Name Serial Number Area Communici  Network PA . . egister  Firmware QOperations
Name Type Connection lip Setas Registration Device evice  Version
i g‘ Set Daylight Saving Time
v SpeedFace-V5 CGFE184760043  Area Name HTTP Wired 1921 E Modify the Fingerprint Identification Threshold 1.0.55 Edit Delete
% Set Device In/Out State
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(¥ Refresh [@ New ﬁ'ﬁ‘ Delete B Export Q Search Device ;2*, Device Control ~ {g} Setup ~ @ View and Get Device Info = @ Communication ~
€23 Get Device Option
v Device Name Serial Number Area Communic: Network IP Address RS4 Register Firmware Operations
Name Type Connection Pare 8 Get Personnel Information  Device  Version
Mot [] Get Transactions
v  SpeedFace-V5  CGFE184760043 Area Name HTTP Wired 192.168.213.67 J View Rules of Devices ) 1.0.55 Edit Delete

C\— Refresh @ New @ Delete E Export Q Search Device E%

v e Device Name Serial Number Area Communic: Netwark
Name Type Connection
Mode
v SpeedFace-V5 CGFE184760043 Area Name HTTP Wired

> Edit or Delete a Device

Device Confrol ~ {g} Setup + @ View and Get Device Info  ~

o
y

(==} View Device Capacity

ﬁ Communication =
1€ Wodify IP Address

IP Address RS485 Status Device
Parameter Model f Modify Communication Password
“® Switch Network Connection
192 168 213 67 Offline SpeedFace-V! & 1.055 Edit Delete

Edit: Click the Device Name or click [Edit] to access the edit interface.

Delete: Select the device, click [Delete], and click [OK] to delete the device.

Device Name®

Communication Type™

Serial Number®

IP Address™
Communication port”
Icon Type®

Control Panel Type
Area”

Set Wiegand Reader

record), please use with cautionl

Edit

A\ [Clear Data in the Device when Adding] will delete data in the device (except event

[SpesdFace-V5

TCPNP & HTTP
CGFE184760043
192 . 168 .213 .67
6665

Door

Area Name

Click to select the reader

®

For the details and settings of the above parameters, see Device. Some details cannot be edited. The device

Name should be unique and must not be identical to another device.

Control Panel Type cannot be modified. If the type is wrong, users need to manually delete the device and

add it again.

» Export

Device information can be exported in EXCEL, PDF, and CSV file format.
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Export

The File Type EXCEL File v
Export Mode @ All data (export up to 30000 pieces of data)

Select data volume export (export up to 30000 pieces of data)

From the article 1 Strip, is derived 100 Data

G T

Device
Device Name Serial Number | Area Name[Com munic Network IP Address RS485 Status Device Register Firmware Version
ation Type [ Connection Parameter Model Device
Mode
SpeedFace-V5 CGFE184760043 |Area Name| HTTP Wired 192.168.213.67 Offline | SpeedFace- Yes 1.0.55
V5

> Disable/Enable

Select device, click [Disable/ Enable] to stop/ start using the device. When communication between the
device and the system is interrupted or the device fails, the device may automatically appear in disabled

status. After adjusting the local network or device, click [Enable] to reconnect the device and restore device
communication.

The current query conditions Mone

(v Refresh [ ® New [ Delete [# Export Q SearchDevice 2. Device Control v §0b Setup ~

1] P S
7 7 Clear Administrator permission
2. Click on Device Control 6;; [

Name—" Type 1, Upgrade Firmware
Reboot Device

v Device \

v/ SpeedFace V5 CGFE184760043  Area Name HTTP T2l Synchronize Time
\, '~/ Enable
N Dizahl
1. Select the required device \(Q) Disable

.f?% Synchronize All Data to Devices

o

.

3. Click as required

» Synchronize All Data to Devices

Synchronize data of the system to the device. Select device, click [Synchronize All Data to Devices] and click
[OK] to complete synchronization.

The current query conditions None

(* Refresh  [® New (it Delete [# Export € SearchDevice . Device Control ~ £6% Setup ~ [Q] Viewand GetDevice Info ~ & Communication ~

~  Device_ 2. Click on Device Control Com LT ClearAdmfmstrator permission RS485 Status  Device Model Register Firmware Version
ame Type ., Upgrade Firmuware Parameter Device
Reboot Device
7 SpeedFace V& CGFE184760043 Area Mame HTTP {EE] Synchronize Time Online SpeedFace-Vh @ 1.0.55
\ ~/ Enable
1. Select the required device @) Disable

¥ Synchrenize All Data to Devices

™ 3. Click here
N~/
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Synchronize All Data to Devices

Selected Device
(e) Standalone Device - SpeedFace-V5

Clear All ¥ Access Authority ¥/ TimeZone, holidays [¥JMulti-Person Open Door
(¥ First-Person Open Door

Total Progress

==

A

& Note: [Synchronize All Data to Devices] will delete all data in the device first (except transactions), and
thus download all settings again. Please keep the internet connection stable and avoid power down
situations. If the device is working normally, please use this function with caution. Execute it in rare user
situations to avoid impact on normal use of the device.

» Upgrade Firmware

Select the required device that needs to be upgraded, click [Upgrade firmware] to enter edit interface, then
click [Choose File] to select firmware upgrade file (nhamed emfw.cfg) provided by Access software, and click
[OK] to start upgrading.

Upgrade Firmware

Selected Device(Can only upgrade equipment of the same fype)
() SpeedFace-V5 - SpeedFace V5

Select File| Choose File | Mo file chosen

[Total Progress

e

& Note: The user shall not upgrade firmware without authorization. Contact the distributor before

upgrading firmware or upgrade it following the instructions of the distributor. The unauthorized upgrade
may affect normal operations.
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» Reboot Device

It will reboot the selected device.

» Synchronize Time

It will synchronize device time with the server’s current time.
» SetDevice Time Zone

If the device supports the time zone settings and is not in the same time zone with the server, you need to
set the time zone of the device. After setting the time zone, the device will automatically synchronize the
time according to the time zone and server time.

» Set as Registration device

Set the registration device only when the standalone device’s data such as personnel can automatically
upload.

Set as Registration Device

Set as Registration Device Yes

I

» Set Daylight Saving Time
According to the requirements of different regions, set Daylight Saving Time rules.

» Modify the fingerprint identification threshold (Ensure that the access controller supports

fingerprint function)

Modify the Fingerprint |dentification Threshold

The fingerprint identification threshold”™ [35-.?Dj:

.

> Set Device In/Out state

It will define the condition of the master device as Entry or Exit.
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Set Device In/Cut State

Master device state Entry r
Cut

> Get Device Option

It gets the common parameters of the device. For example, get the firmware version after the device is

updated.
> Get Personnel Information

Renew the current number of personnel, fingerprints, finger vein and face templates in the device. The

final value will be displayed in the device list.

Get Personnel Information

Selected Device
(® SpeedFace-V5 : SpeedFace VB |

You can choose the required option |

(®) Obtain personnel information (_)Obtain fingerprint information
() Obtain Face Picture Infarmation

[ Get count only

[Total Progress

T

> Get Transactions

Get transactions from the device into the system. Two options are provided for this operation: Get New

Transactions and Get All Transactions.

Get New Transactions: The system only gets new transactions since the last collected and recorded
transaction. Repeated transactions will not be rewritten.

Get All Transactions: The system will get transactions again. Repeated entries will not be shown twice.

When the network status is healthy and the communication between the system and device is normal, the
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system will acquire transactions of the device in real-time and save them into the system database.
However, when the network is interrupted or communication is interrupted for any reason, and the
transactions of the device have not been uploaded into the system in real-time, [Get Transactions] can be
used to manually acquire transactions of the device. In addition, the system, by default, will automatically
acquire transactions of the device at 00:00 on each day.

#Note: Access controller can store up to 100 thousand transactions. When transactions exceed this
number, the device will automatically delete the oldest stored transactions (deletes 10 thousand
transactions by default).

> View Rules of Devices

Shows the Access rules in the device.

View Rules of Devices

Rule Type Description Rules Details

First-Person Normally Open Not Set None |
Multi-Person Opening Door Not Set l
Door Sensor Not Set

Active Time Zone Has been set

Passage Mode Time Zone Not Set |

Between multiple rules
with a '|' separated.

A\ Linkage and global
linkage, anti-passback
and global anti-passback
are set at the same time

there may be conflicts

» View Device Capacity

It checks the capacity of personnel’s biometric details in the device.
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View Device Capacity ’

In Software In FirmWare |
- 0 ; _ '
& @ i L] Lz & ¥ “ Get All
SpeedFace-V5 510000 0710000 X 1/6000 Get '
A\ 1fyou find that the data is not consistent with the device, please synchronize the data of devices before trying again

» Modify IP Address

Select a device and click [Modify IP address] to open the modification interface. It will obtain a real-time
network gateway and subnet mask from the device. (Failed to do so, you cannot modify the IP address).
Then enter a new IP address, gateway, and subnet mask. Click [OK] to save and quit. This function is similar
to [Modify IP Address Function] in Device.

» Modify Communication Password

The system will ask for the old communication password before modifying it. After verification, input the
new password twice, and click [OK] to modify the communication password.

& Note: A Password should be a combination of numbers and letters of 6 digits.

Users can modify the fingerprint identification thresholds in the devices; it ranges from 35 to 70 and it is 55
by default. The system will read the thresholds from the device. Users can view the threshold devices list.
More than one device can be changed by using the Batch operation function.

4.1.4 Doors

1. Click [Access] > [Device] > [Door] to enter Door Management interface (click “Area Name” in the left,
the system will automatically filter and display all access devices in this area).

DoorName [ | OunedDeuics Area Name Marev O

The current query conditions: Mone

((* Refresh [[| Remote Opening “/ Ensble () Dissble || Remote Closing i3 Cancel Alam (% Remote Nommslly Open = More ~

O Door Mame Ares Mame Cwned Device Serial Mumber Door Mumber Ensble  Active Time Zone Ero:ur Sensor Verifization Mode Operations.

Typs

O 21627.0.1-1 Area Mame 216.27.0.1 14282635477750 il L 24-Hour Accessiblz MNone Card or Fingerprint Edit
O 21627.0.1-2 Area Mame 216.27.0.1 14282635477750 2 L 24-Hour Accessiblz MNone Card or Fingerprint Edit
O 21627.0.1-2 Area Mame 216.27.0.1 14282635477750 3 o 24-Hour Accessiblz MNone Card or Fingerprint Edit
O 21527.0.1-4 Area Mame 216.27.0.1 14282635477750 4 o 24-Hour Accessiblz MNone Card or Fingerprint Edit
[0 182.188.217.221-1 Area Mame 192.188.217.221 2835151800001 il L 24-Hour Accessiblz MNone Card or Fingerprint Edit
[0 182.188.217.221-2 Area Mame 192.188.217.221 2835151800001 2 L 24-Hour Accessiblz MNone Card or Fingerprint Edit
[0 182.188.217.221-3 Area Mame 192.188.217.221 2835151800001 3 o 24-Hour Accessiblz MNone Card or Fingerprint Edit
[0 182.188.217.221-4 Area Mame 192.188.217.221 2835151800001 4 L 24-Hour Accessiblz MNone Card or Fingerprint Edit
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Select the door to be modified, and click the Door Name or [Edit] button below the operations tab to open
the Edit interface:

Edit

Dawice Mame* SpeedFace-VS Dioor Mumber® 1 |
Daar Mame® E[_u_:uljri_ﬂ;r_l W51 Actve Time Long” 24-Howr Accassibls ;
Verifcation kModa” Faca Lock Opsn Duration” 5 saoond( 1-254 i
Operate Inferval® 0 sacond(0-254) Dioar Sansor Typa* Mone v |
Amli-Pessback Duration of [} it 0-1.20) Dioor Sansor Delday gactad( 1-254
Erilrance
Duress Passwoard (Mexdrmum G Bit Integer) Passage Mode Time Zong | ———
Emergency Passwond B Bit Intagar)
Dhimalbla Alarm

The gbowe sellings are copeedtoc | — ¥

o I oo

Fields are as follows:
Device Name: It can’t be edited.

Door Number: System will automatically name it according to the doors quantity of the device. This
number will be consistent with the door number on the device.

& Note: By default, the suffix number in the Door Name is consistent with the Door Number, but 1/2/3/4
in Anti-Passback and interlock refer to the Door Number, rather than the number following the Door Name,
and they are not necessarily related.

Door Name: The default is “device name - door number”. The name can be modified as required. Numbers,
letters or a combination of both are allowed up to 30 characters.

Active Time Zone: Active Time Zone must be selected, so that the door can be opened and closed
normally. A Passage Mode Time Zone must be set within the Active Time Zone.

#sNote: For a door, in Normal Open state, a person who is allowed to be verified 5 times consecutively
(verification interval should be within 5 seconds) can release the current Normal Open status and close the
door. The next verification will be a normal verification. This function is only effective during the Active
Time Zone of specified doors. And within the same day, other Normal Open intervals set for the door and
First-Person Normally Open settings will not take effect anymore.

Verification Mode: Identification modes include Automatic Identification, Only fingerprint, Only Pin, Only
Password, Pin and Fingerprint, Fingerprint and Password, Pin and Password and Fingerprint, Face, Face
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and finger, Face and Finger and Password. The default value is Card or Fingerprint. When both Card and
Password mode is selected, make sure the door is equipped with a reader that has a keyboard.

Lock Open Duration: It is the time period for which the door remains unlocked after successful verification.
The unit is second (range: 0~254 seconds), and the default value is 5 seconds.

Operate Interval: It is the time-interval between two verifications. The unit is Seconds (range: 0~254
seconds), and the default value is 0 seconds.

Anti-Passback Duration of Entrance: Only one entry is allowed with a reader in this duration. The unit is
minute (range: 0~120 minutes), and the default value is 0 minutes.

Door Sensor Type: None (will not detect door sensor), Normally Open, Normally Close. If you have selected
as Normally Open or Normally Close, you need to set Door Sensor Delay and decide whether or not Close
and Reverse-lock is required. When the door sensor type is set as Normally Open or Normally Close, the
default door sensor delay is 15 seconds, and then close and reverse state is enabled.

Door Sensor Delay: It is the delayed duration for the detection of the door sensor after the door is opened.
When the door is not in the Normally Open period, and the door is opened, the device will start the
counting. It will trigger an alarm when the delay duration is expired and stops the alarm when you close
the door. The default door sensor delay is 15s (range: 1~254 seconds). Door Sensor Delay should be greater
than the Lock Open Duration.

Duress Password, Emergency Password: Duress means any threats, violence, constraints, or other action
used to force someone into doing something against their will. In these situations, input Duress Password
(with an authorized card) to open the door. When the door is opened with Duress Password, the alarm is
triggered. Upon emergency, the user can use Emergency Password (named Super Password) to open the
door. Emergency Password allows normal opening, and it is effective in any time zone and any type of
verification mode, usually used for the administrator.

(1) Duress Password Opening (used with an authorized card): Password should be a number not
exceeding 6 digits. When Only Card verification mode is used, you need to press [ESC] first, and then
press the password plus [OK] button, then finally punch legal card. The door opens and triggers the
alarm. When Card + Password verify mode is used, please swipe legal card first, then press the
password plus [OK] button (same as normal opening in card plus password verification mode), the
door opens and triggers the alarm.

(2) Emergency Password Opening: Password must be 8 digits. The door can be opened only by entering
the password. Please press [ESC] every time before entering the password, and then press [OK] to
execute.

When using Duress Password or Emergency Password, the interval for entering each number shall not
exceed 10 seconds, and both the passwords should not be the same.

Disable Alarm: Select the Disable Alarm check box to disable the alarm voice in real-time monitoring page.
The above Settings are Copied to: It has below two options.

(1) All doors in the current device: Click to apply the above settings to all doors of the current access
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device.

(2) Alldoorsin All Control devices: Click to apply the above settings to all doors of all access devices within
the current user’s level.

2. After setting parameter(s), click [OK] to save and exit.

4.1.5 Reader

1. Click [Device] > [Reader] on the Menu, then click on reader name or [Edit].

1
® s oo | Q®

) The current query conditions None
E Device
(% Refresh
| Edit .
Device 1 I
Reader Name Door Name ara Operations
Door Name* ) 105-
e oor Name 192.168.0.105-1
(PRI NELESENERY Click to edit Name~ 192.168.0.105-1-n 4 QLT IR GTENIETIIENE N =T [V]1¢=e M nding/unbinding the camera
Door .
192.166.0.105-1-Out  192.168.0.105-1 Number 1 Edit Binding/unbinding the camera
(] 192.168.10.232-1-In 192168102321 mOut In @Out Edit Binding/unbinding the camera
Auxiliary Input 192.168.10.232-1-Out 192.168.10.232-1 ‘ ‘ Edit Binding/unbinding the camera
Auxiiary Oulput 192.168.10.219-1-In 192.168.10.219-1 Edit Binding/unbinding the camera
192.168.10219-1-0ut  192.168.10.219-1 ‘ ‘ Edit Binding/unbinding the camera
Event Type
192.166.1.76-1-In 192.168.1.76-1 Edit Bindingfunbinding the camera
); Savir
DeviohL S na e 192.168.1 76-1-Out 192.168.1.76-1 ‘ ‘ Edit Binding/unbinding the camera

Device Monitoring
Real Time Monitoring

Alarm Menitoring

Map

) Access Contro

:| RS © < 18 5 5  SDrowsperpage ~ JumpTo 1 /1Page  Total of 8 records

Name: Set the name of the reader displayed on the list page.

4.1.6 Auxiliary Input

It is mainly used to connect devices like infrared sensors, smog sensors, smoke detectors, etc.
1. Click [Access Device] > [Auxiliary Input] on the Action Menu, to access below shown interface:

2. Click on Name or [Edit] to modify the parameters as shown below:
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® Name | bewewame| | emename | Q ®

£ . Welcome, admin

E] 5 The current query conditions None
JEVIC
(% Refresh
Device
Name Device Name 4 Edit Operations
1/0 Board
Auwiliary Input-1 3 192.168.0.105 Device Name* 192.168.0.105 Edit Binding/unbinding the camera
Door .
Auxiliary Input-1 192.168.10.232 Number’ 1 Edit Binding/unbinding the camera
Reader Ao T 192.168.10.219 Name Auxiliary Input-1 Edit Bindinglunbinding the camera
: Printed Name Nt e
(2] Auwsiliary Input-1 T Edit Binding/unbinding the camera
Active Time Zene 24-Hour Accessible
Auxiliary Output Remark

Event Type
Daylight Saving Time
Device Monitoring

Real-Time Monitoring “

Alarm Monitoring

Map

Access Control

Reports “ <« 14 . . GDrowsperpage ~ JumpTo 1 /1 Page  Total of 4 records

Fields are as follows:

Name: You can customize the name according to your preference.

Printed Name: It will be the printed name on the hardware, such as IN5.

Active Time Zone: Auxiliary input will be available only in the specified time segment.
#sNote: Only Name can be modified.

3. Click [OK] to save the name and exit.

4.1.7 Auxiliary Output

It is mainly used for alarm output and with active linkage function.

1. Click [Access Device] > [Auxiliary Output] on the Action Menu to access the following interface:

Name : Device Name Printed Name

The current query conditions: None

_* Refresh '™\ Remote Open ‘" Remote Close '“. Remote Normally Open
O Name Devica Name Number Printed Name Passage Mode Time Remark Operstions
Zone
[0 Ausilisry Output-1 216.27.01 1 ouT1 Edit
[0 Auxilisry Output-1 162.168.217.221 1 ouT1 Edit
[0 Ausilisry Output-2 162.188.217.221 2 ouT2 Edit
[0 Auxilisry Output-3 162.168.217.221 3 ouT2 Edit
[0 Ausilisry Qutput-4 162.188.217.221 4 ouT4 Edit

2. Click [Edit] to modify the parameters:
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Edit
Device Mame* 192.168.213.194
Mumber® 1
Mame* Puziliary Qutput-1
Printed Mame* ouT1

Remark

Fields are as follows:
Name: You can customize the name according to your preference.
Printed Name: The printing name in the hardware, for example, OUT2.

Passage Mode Time Zone: The auxiliary output will be in normally open or normal close in the selected

time zone.
& Note: Only Name, Passage Mode Time Zone and Remarks can be modified.

3. Click [OK] to save the name and remark and exit.

4.1.8 Event Type

It will display the event types of access devices.

1. Click [Device] > [Event] to access the following page:
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@ Event Name Event Number Event Level e
The current query conditions None
E Device Ll
(% Refresh  [£% Set Audio
Device
Event Name Event Event Device Name Serial Number Operations
Number Level
Door
Normal Verify Open 0 Normal SpeedFace-V5 CGFE184760043 Edit
Reader
Verify During Passage Mode Time 7 1 Normal SpeedFace-V5 CGFE184760043 Edit
Auxiliary Input First-Personnel Open 2 Nomal  SpeedFace-V5 CGFE184760043 Edit
Auxiliary Output Multi-Personnel Open 3 Normal SpeedFace-V5 CGFE184760043 Edit
Emergency Password Open 4 Normal SpeedFace-V5 CGFE184760043 Edit
: : Open during Passage Mode Time Z 5 Normal SpeedFace-V5 CGFE184760043 dit
Daylight Saving Time
Cancel Alarm 7 Normal SpeedFace-V5 CGFE184760043 Edit
Device Monitoring
Remote Opening 8 Normal SpeedFace-V5 CGFE184760043 Edil
Real-Time Monitoring Remote Closing 9 Normal  SpeedFace-V5 CGFE184760043 Edit
Map Disable Intraday Passage Mode Tin 10 Normal SpeedFace-V5 CGFE184760043 Edit
Enable Intraday Passage Mode Tim 11 Normal SpeedFace-V5 CGFE184760043 Edit
Door Inactive Time Zone Verify Ope 21 Except SpeedFace-V5 CGFE184760043 Edit
lllegal Time Zone 22 Excep! SpeedFace-V5 CGFE184760043 Edit
Access Denied 23 Excep! SpeedFace-V5 CGFE184760043 Edit
= Anli-Passback 24 Exception  SpeedFace-V5S CGFE184760043 Edit
@ Access Control
A Multi-Personnel Authentication Wait 26 Exceplion  SpeedFace-V5 CGFE184760043 Edit

2. (lick [Edit] or click on the event type name to edit:

Edit
Device Name* SpeedFace-V5
Event Name* Normal Verify Open
Event Number* 0
Event Level® Normal v
Event Sound (@) Already Exists () Upload

Play

Copy the above setiings to all @]

devices

Fields are as follows:

Event Level: Normal, Exception, and Alarm are available.

Event Name: It cannot be modified.

Event Sound: You can set custom sound being played when the event occurs in real-time monitoring.

Copy the above settings to all devices: This event will be applied to all current devices within the purview
of the same user event number.

Set Audio: Same as the event sound. Click [Set Audio]:
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Event Name

Event Sound (@) Already Exists () Upload

You can upload audio from your local PC. The file must be in wav or mp3 format, and it must not exceed
10MB.

For more details about Event Type, please refer to Access Event Type.
4.1.9 Daylight Saving Time

The Daylight-Saving Time is a function to adjust the official prescribes local time to save energy. The unified
time adopted during the implementation is known as the "DST". Typically, regions that use daylight saving
time adjusts clocks forward one hour to standard time close to the start of spring in the summer to make
people sleep early. It can also help to save energy. In autumn, adjust clocks are adjusted backward to get
up early. The regulations are different in different countries. At present, nearly 70 countries adopt DST.

To meet the DST requirement, a special function can be customized. You may adjust the clock one hour
ahead at (hour) (day) (month) and one hour backward at (hour) (day) (month) if necessary.

» AddDST

1. Click [Access] > [Device] > [Daylight Saving Time]> [New]:
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DST Name* |

Start Time™ n‘ ‘ Second =| |Sunday =| |2 =| o'clock

End Time* |NOV nHFirst =||Sunday =||2 =|o’clock

EXTm I T

The row fields are as; "Month - Week — Day - Hour" format. For example, if the start time is set as “March -
Second -Sunday - 2 o’clock” it means the DST will start from the second Sunday of March at 2 AM. The
system will be advanced one hour at the start time. The system will go back to the original time at the end
time.

> UseaDST

Device 4 VAl
v [ 192.1680.105

~20OT 3

The user can enable the DST setting on a device: In the DST interface, select desired DST, and click [DST
Setting], select the device to apply the DST setting to and click [OK] to confirm.
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&Note:
(1) If a DST setting is in use, it cannot be deleted. Deselect DST setting and then delete it.

(2) IfaDSTsettingisin use, the latest modification will be sent to the device. Disconnection of the relevant
device will lead to transmission failure, and it will resume at the next connection.

(3) Inthe Door Management module of the access control system, you can enable or disable DST function.
If you enable DST setting, the system will be advanced one hour at the start time. The system will go
back to the original time at the end time. If you did not set a DST in the device, the system will prompt
“The Daylight-Saving Time hasn’t been set in this device” when you disable the function.

4.1.10 Device Monitoring

By default, it monitors all devices within the current user’s level. You may click [Access Device] > [Device
Monitoring] to view a list of operation information of devices: Device Name, Serial No., Area, Operation
Status, Current status, Commands List, and Related Operation.

® e S — Ceaename || SenaiNumber ®

EI Device [# Export [ Clear All Command

Device Device Name Serial Number Area Operation Status Current Status Commands List Recently Abnormal State  Operations.

192.168.0.105 CJHB192960013 Area Name Disconnected Disconnected 14 Disconnected Clear Command View Command

110 Board
192 168 10.232 CJ14193360005 Area Name Disconnected Disconnected 2 Disconnecied Clear Command View Command

Door
192168 10.219 CJ75192450017 Area Name Disconnected Disconnected 2 Disconnected Clear Command View Command

Reader T CJ74192960006 Area Name Disconnected Disconnected 2 Disconnected Clear Command View Command

Auxiliary Input
Auxiliary Output
Event Type

Daylight Saving Time

Real-Time Monitoring
Alarm Monitoring

Map

Ia)
(2] Access Control

=] Reporis (
5 Current device count : 4 @ Normal : 0 @ Exception: 4  Disable : 0 Command Sum : 20 © Suspend Monitor

> Export

Device commands can be exported in EXCEL, PDF, and CSV file format.

Export

The File Type EXCEL File k 4
Export Mode (@) All data (export up to 30000 pieces of data)
() Select data volume export (export up to 30000 pieces of data)

From the article 1 Strip, is derived 100 Data

.
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Device M onitoring

Device Name Serial Number Area 0 peration Status Current Status Com mands List Recently Abnormal State
SpeedFace-V5 CGFE184760043 Area Name Get real-time event Normal 0 Disconnected
192.168.213.99 3633160800001 Area Name Get real-time event Normal 0 Disconnected

You may clear the command as needed. Click [Clear Command] in operations column:

Click [OK] to clear.

#sNotes:

Prompt

Are you sure you want to clear command

queues?

(1) After the implementation of Clear Command, you can perform the Synchronize All Data to Devices

operation on the device list to re-synchronize data in the software to the device, but this operation

cannot be performed when the user capacity and fingerprint capacity are fully consumed on the

device. Once the maximum capacity is reached, you can replace the current device with a higher-

capacity one or delete the rights of some personnel to access this device, and then perform the

Synchronize All Data to Devices operation.

(2) Operation Status shows the state of the current device, mainly used for debugging.

(3) If the number of commands to be performed is greater than 0, then itindicates that the data is not yet

synchronized to the device, so wait for the synchronization to complete.

4.1.11 Real-Time Monitoring

Click [Access Device] > [Real-Time Monitoring].

It will monitor the status and real-time events of doors under the access control panels in the system in

real-time, including normal events and abnormal events (including alarm events).

The Real-Time Monitoring interface is shown as follows:

Icons

a
2
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Device blocked

Door sensor not set; relay closed

Icons

-

e

Status

Door Offline

Door sensor not set; relay opened
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P

Door sensor not set, and the present firmware does not support current action on the device

Online status Door closed; Relay

Online status Door closed; Relay closed )
= opened

Online status Door closed, and the present firmware does not support current action on the
device

Online status Door opened; Relay

Online status Door opened; Relay closed .
= opened

Online status Door opened, and the present firmware does not support current action on the
device

Door opened alarming; Relay closed : Door opened alarming; Relay opened

@
Door opening timeout, Relay closed i A Door opening timeout, Relay opened

Door opening timeout, and the present firmware does not support current action on the

device
Door opening timeout, Relay closed/Door o Door opening timeout, Relay opened/
Sensor Closed [ 1 Door Sensor Closed
o
Door closed alarming; Relay closed . Door closed alarming; Relay opened

Door closed alarming, Indicates that the present firmware does not support current action on
the device

Door sensor not set, Door alarming, Relay F Door sensor unset, Door alarming,
-

closed Relay opened

Door opening timeout, Without relay P‘
£

Door lockin
status/Door Sensor Closed 9

Without relay status, it indicates that the current firmware does not support action on the device.

Page |55 Copyright©2020 ZKTECO CO,, LTD. All rights reserved.



ZKBio Access IVS User Manual

Area Status e Device Name | Serial Number
Door Augxiliary Input Auxiliary Output
All Doors r Remote Opening : Remote Closing 1£gf Cancel Alarm E Remote Normally Open = More ~

B R A

SpeedFace- 192.168.213 192.168.213
-1 -1 99-2

Current Total:3 @ Online:3 @ Disable:0 @ Offline:0 & Unknown:0 Door Name

Real-Time Events

Time Area Device Event Point Event Description Card Number Personnel Reader Name Verification Mode
2018-12-27 17:48:46  Area Name 192.168.213.99(3633160800001) Device Started Other Other
2018-12-27 17:45:16  Area Name 192.168.213.99(3633160800001) Device Started Other Other
2018-12-27 17:43:24  Area Name 192.168.213.99(3633160800001) Connected to the server Other Other
2018-12-27 17:43:06  Area Name 192.168.213.99(3633160800001) Device Started Other Other
2018-12-27 17:43:.01  Area Name SpeedFace-V5(CGFE184760043) SpeedFace-V5-1 Normal Verify Open 575(Jeff) SpeedFace-V5-1-Out  Face
2018-12-27 17:4253 Area Name SpeedFace-V5(CGFE184760043) SpeedFace-V5-1 Normal Verify Open 575(Jeff) SpeedFace-V5-1-Out  Face
Total Received: 6 @ Normal:6 w Exception:0 @Alarm:0 Clear Data Rows Event Description L _Snpwfhotqs

Different icons represent status as followed:
1. Door
Remote Opening/Closing: It can control one door or all doors.

To control a single door, right click over it, and click [Remote Opening/ Closing] in the pop-up dialog box.
To control all doors, directly click [Remote Opening/ Closing] behind Current All.

In the remote opening, the user can define the door opening duration (The default is 15s). You can select
[Enable Intraday Passage Mode Time Zone] to enable the intraday door passage mode time zones or set
the door to Normal Open, then the door will not be limited to any time zones (can be opened at any time).

To close a door, select [Disable Intraday Passage Mode Time Zone] first, to avoid enabling other normal
open time zones to open the door, and then select [Remote Closing].

& Note: If [Remote Opening /Closing] fails, check whether the devices are disconnected or not. If
disconnected, check the network.

Cancel the alarm: Once an alarming door pops-up over the interface, the alarm sound will be played. Alarm
cancellation can be done for a single door and all doors. To control a single door, move the cursor over the
door icon, a menu will pop-up, then click [Remote Opening/ Closing] on the menu. To control all doors,
directly click [Remote Opening/ Closing] behind Current All.

#sNote: If [Cancel the alarm] fails, check if any devices are disconnected. If found disconnected, check the
network.

Remote Normally Open: It will set the device as normal open by remote.
® Quick Management of Doors

If you move the cursor over a door’s icon; you can perform the above-explained operations in a quick way.
In addition, you can query the latest events from the door.
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E; Status

192.168

‘gg.c Device: 192.168.213.99
Serial Number: 3633160800001
Number: 2
Door Sensor: Mo Door Sensor
Relay: Close
Alarm None

Remote Opening

Remote Closing

Cancel Alarm

@0
Remote Normally Open

Enable Intraday Passage Mode Time Zone

Disable Intraday Passage Mode Time Zone

rea Query the latest events from the door v

Query the latest events from the door: Click to quickly view the current events on the door.

Issue card to person: If you swap an unregistered card, a record with a card number will pop-up in real-
time monitoring interface. Right click that card number, and a menu will pop-out. Click “Issue card to
person”, to assign that card to one person.

® Multiple selection

You can select multiple doors at the same time to perform operations such as remote opening, remote
closing, canceling alarm, etc. Double-click the door icon to edit the door properties.

Area Status | —— Device Name More ®
Door Auxiliary Input Augxiliary Qutput
= I — 3 4 5 — &
AllDoors | | Remote Opeuing | | Remote Clos.ig g Cancel Aum 4 Remote Nonlally Open = More -
=) =) =) [y
192.168.0. [192.168.10| |192.168.10| |1921681
1051 23241 2191 76-1
1
Current Total:4 @ Online:0 @ Disable:0 @ Offline:4 @ Unknown:0 Door Name

® Event monitoring

The system will automatically acquire records of devices being monitored (by default, display 200 records),
including normal and abnormal access control events (including alarm events). Normal events will appear
in green; alarm events will appear in red; other abnormal events will appear in orange.

2. Auxiliary Input

It monitors current auxiliary input events in real-time.
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Area Status ——— Device Name Serial Number

Door Auxiliary Input Auxiliary Qutput

= =g

Auxiliary Auxiliary

Input-1 Input-2
Current Total:2 @ Online:0 @ Disable:0 @ Offine:2 @ Unknown:0 Augxiliary Input Name

Real-Time Events

Time Area Device Event Point Event Description ‘Card Number Personnel Reader Name Verification Mode

3. Auxiliary Output

Here you can perform Remote open, Remote Close, Remote Normally Open.

Area Status — Device Name Serial Number
Door Auxiliary Input Auxiliary Output
All Doors ™ Remote Open "~ Remote Close ™. Remote Normally Open
- [

Auxiliary Auxiliary
Output-1 Output-2

Current Total:2 @ Online’0 @ Disable:0 @ Offline:2 @ Unknown:0 Auxiliary Qutput Name
Real-Time Events

Time Area Device Event Point Event Description Card Number Personnel Reader Name Verification Mode

4.1.12 Alarm Monitoring

It monitors the alarm events of the doors. The alarm will be raised in case of abnormalities such as Tamper,
Passback, etc. The alarms raised by the doors will be displayed in this page. The Alarm details consists of

the Time, Device Name, Event Point, Description of the event, Person responsible for the alarm and the
corresponding reader name.
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Device Event Point Event Description Reader Name

2020-02-21 15:00:06 T Desconectado Other

2020-02-2023:31:16 T Desconectado Other
10 Bo:

Lo 2020-02-20 16:34:25  192.168.1.76 192.168.1.76-1 Puerta forzada Other
Door 2020-02-20 18:39:41  192.168.10.219 Desconectado Other
Reader 2020-02-20 18:37:32 192.168.10.219 192.168.10.219-1 Alarma de tamper Other
- 2020-02-20 18:34:06  192.168.10.219 Desconectado Other

Auxiliary Input
2020-02-20 16:22:56 192,168 10.232 Desconectado Other

Auxiliary Output
2020-02-20 16:19:43  192.168.10.232 192.168.10.232-1 Alarma de tamper Other

& Note: If the firmware version of the device supports, the Event Description will pop-up, or else only
“Alarm” will be displayed in Event Description without any details.

Select the Alarm and click Acknowledge to respond to the Alarm.

&sNote: When a door has multiple alarm states, it will display just one alarm type description in the
descending severity order, the order are as follows: tamper-resistant alarm > duress alarm (password +
fingerprint) > duress password or fingerprint alarm > unexpected opening alarm > opening timeout alarm >
device disconnects alarm.

4.1.13 Map

Click [Access Device] > [Map] > [New] to add a map.

Tost ‘
Area Namo [~ |
Choose file |/maps png

After adding, users can add a door on the map; perform zoom-in, zoom-out, etc. If users relocated some
sections or modified the map, click [Save Positions] to save. The user can view the new setting after re-
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opening the Map interface.

(G) % Refresh [ ® New [#] Edit ffj} Delete (" Save Positions P AddDoor @ Zoomin & ZoomoOut FJ Full Screen
E Device ) Map Index Test
4 (&) Area Name W Ton et J NG,
Device O Test = ARG
18 £ [
Door l A \
;; —— o [ cre 53 &\ [
Reader -~~——~a»-—-E - . = 5w o 7
; - 92 Geer cs) !
Auxiliary Input . 3 Moy \g\ s e £ {
- g\ cre : 5 |
o | emc § ¢
Auxiliary Output B |
N
Event Type — y El .l‘q ‘
CTResT € DEANKEETON 87 \| o IS
Daylight Saving Time WA o i\ G
S ' |~ e [\[e= 'i
Device Monitoring ! HEM | 8 | o84
[w #m, ol coas=y 25\ 2%
s o[ it— || Mes L %
Real-Time Monitoring — 15l eull 25 [ ) 3
H [y = c L - 5 Ne, W\ (res 1"“
\ —ﬁ- s — -+ B e 11 e o
b - - B PAT SN -
Real-Time Events
Time Area Device Event Point Event Description Card Number Personnel Reader N
A
"[_V‘] Access Control
@ Reports (o 4 D
Total Received.0 wNormal-0 w Exception 0 @Alarm:0 lear Da WS Event Reminder Sounds ¢/ Show Photosv)

Add / Delete Map: Users can add or delete a map as needed.
Edit Map: Users can edit map name, change the map or the area it belongs to.

Adjust map (includes door): Users can add a door on the map or delete an existing one (right click the
door icon, and select [Delete Door]), or adjust the map or position(s) of the door or camera icons (by
dragging the door or camera icons), adjust the size of the map (click [Zoom in] or [Zoom out] or click [Full
Screen]).

Door operation: If you move the cursor over a door icon, the system will automatically filter and displays
the operation according to the door status. Users can do remotely open/close doors, cancel alarms, etc.

Levels control:

(1) Users need to select the relevant area for the map when adding levels. The area will be relevant to the
user access levels, users can only view or manage the map within levels. If the relevant area of a map
is modified, all doors on the map will be cleared. Users need to add the doors manually again.

(2) When an administrator is adding a new user, he can set the user operation rights in role setting, such
as Save positions, Add Door, Add Camera, etc.

#Notes:

(1) In map modification, users can choose to modify the map name but not the path. Users only need to
check the box to activate the modification option.

(2) The system supports adding multi doors at the same time. After adding the doors, users need to set
the door position on the map and click [Savel].

(3) When modifying the door icon, especially when users zoomed out the map, the margin for top and
left shall not be smaller than 5 pixels, or the system will prompt error.

Page |60 Copyright©2020 ZKTECO CO,, LTD. All rights reserved.



ZKBio Access IVS User Manual

(4) Users are recommended to add a map size under 1120 * 380 pixels. If several clients access the same
server, the display effect will be different according to resolutions of the screen and the settings of
browsers.

4.2 Access Control Management

4.2.1 Time Zones

It sets usage time of a door; the reader can only be used only during a valid time period of certain doors.
Time Zone can also be used to set Normal Open time periods or set access levels so that specified users
can only access specified doors during specified time periods (including access levels and First-Person
Normally Open).

The system controls access according to Time Zones (up to 255 time zones). The format of each interval for
a time zone: HH: MM-HH: MM. Initially, by default, the system has an access control time zone named [24
hours Accessible]. This time period cannot be modified and deleted. The user can add new Time Zones as
required.

—

Time Zone Name \ 3. Click New ark l:l Q ®

The current query cond”

r:?:] Device

(" Refresh [ New [ Detets Edit
(2] docess i © [ | Time Zone Name Time Zone Name* ZK|
Z (| 24-Hour Accessible Remark

Holida) m | pate

e 09 : 30 13 © 00 14 @ 00 18 00 0 : 00 0 : 00
09 30 13 ° 00 14 © 00 12 00 0 : 00 a0 00

Set Access By Levels 09 - 30 13 - 00 14 oo 18 00 ] 00 (0] 00

Set Access By Persan 0g : 30 13 ° 00 14 00 128 o0 o : 00 0 : 00
09 : 30 13 © 00 14 @ 00 18 00 0 : 00 0 : 00

Set Access By Department 09 30 13 - 00 14 00 18 00 o0 : 00 a0 @ 00

Interlock 00 - 00 00 - 00 00 oo 00 00 oo 00 (0] 00
00 : 00 00 o0 00 :© oo ] 00 o : 00 0w : 00

Linkage 00 : 00 [ ] 00 @ 00 00 00 o0 @ 00 a @ 00
00 o 00 00 o 00 00 00 00 00 0 : 00 a0 : 00

Anti-Passhack . .
4. Provide datails ,
—, Copy Monday's Setting to Others Weekdays: |_|
First-Person Normally Opef

Multi-Person Group

o K o |

Multi-Person Opening Door

= Reports

£ < 12 > 3l 50rows perpage ~ JumpTo 1 /1 Page  Total of 2 records

1. Add Access Control Time Zone

A. Click [Access Control] > [Time zones] > [New] to enter the time zone setting interface:
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Edit

Time Zone Name® 7K
Remark ZK India
Time
Date

0g o 30 13 : 00 14 - 00 18 © 00 00 : 00 [V 11}
0g 30 13 @ 00 14 00 18 00 o : 00 o 00
0g 30 13 : 00 i4 - 00 18 : 00 00 : 00 o ;00
0g - 30 13 - 00 14 - 00 18 :© 00 0 : 00 0 - 00
0 o320 13 . 00 14 - 00 18 . 00 o 00 o 00
0g o 30 13 : 00 14 - 00 18 © 00 0o : 00 00
00 oo 00 - o0 00 - oan o 00 00 : 00 o 00
00 o oan 00 - o0 0o - oan o 00 o 00 [V 11}
00 ;a0 00 : o0 00 - a0 o 00 00 : 00 o ;00
0o - o0 00 : o0 00 - o0 o 00 0 : 00 0 - 00

Copy Monday's Setting to Others Weekdays: |

The parameters are as follows:
Time Zone Name: Any character, up to a combination of 30 characters.

& Note: Detailed description of the current time zone, including an explanation of current time zone and
primary applications. Users can input up to 50 characters in this field.

Interval and Start/ End Time: One Access Control Time Zone includes 3 intervals for each day in a week,
and 3 intervals for each of the three Holidays. Set the Start and End times of each interval.

Setting: If the interval is Normal Open, just enter 00:00-23:59 as interval 1, and 00:00-00:00 as interval 2 &
3. If the interval is Normal Close: all inputs will be 00:00-00:00. If users use only one interval, they just need
to fill in interval 1, and interval 2 & 3 will be the default value. Similarly, when users only use the first two
intervals, the third interval will be the default value. When using two or three intervals, users need to ensure
that the two or three intervals do not overlap, and the time shall not cross the days, or the system will
prompt error.

Holiday Type: Three holiday types are unrelated to the day of a week. If a date is set to a holiday type, the
three intervals of the holiday type will be used for access purposes. The holiday type is optional. If the user
does not enter one, the system will use the default value.

Copy on Monday: Select the check box to copy the settings of Monday to other weekdays.

B. After setting, click [OK] to save, and it will display in the list.

2. Modify Access Control Time Zones

Edit: Click the [Edit] button under the Operation to enter the edit interface. After editing, click [OK] to save.

Delete: Click the [Delete] button under Related Operation, then click [OK] to delete, or click [Cancel] to
cancel the operation. A time zone in use cannot be deleted. An alternative way is to select the check boxes
one or more time zones in the list and click the [Delete] button over the list, then click [OK] to delete, or
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click [Cancel] to cancel the operation.

4.2.2 Holidays

Access Control Time of a holiday may differ from that of a weekday. The system provides access control
time setting for holidays. Access Control Holiday Management includes Add, Modify and Delete.

@ Holiday Name ‘ Holiday Type — [ Recuring — -] Q ®

The current query conditions None
(¥ Refresh [ New (i} Delete:

0 Holiday Name Holiday Type Start Date End Date Recurring Remark Operations

| (| Device

B Access Control

Time Zones
| New

Holiday Name* ‘ |
(ACCeSSLoves Holiday Type® Holiday Type 1
Set Access By Levels Start Date* 2018-12-27
End Date™ 2018-12-27
Set Access By Person
Recurring No

Set Access By Department Remark

Interlock

Linkage

o]
Anti-Passback

® Add

1. Click [Access Control] > [Holidays] > [New] to enter edit interface:

MNew
Haliday Mame® Mew Year
Haoliday Type* Holiday Type 1
Start Date® 2019-01-01
End Date* 2019-01-01
Recurring es

Remark

T S T

Fields are as follows:
Holiday Name: Any character, up to a combination of 30 characters.

Holiday Type: Holiday Type 1/2/3, as explained in Holiday. A current holiday record belongs to the three
holiday types and each holiday type includes up to 32 holidays.

Start/ End Date: The date format is 2019-01-01. Start Date cannot be later than End Date; otherwise, the
system will prompt an error message. The year of Start Date cannot be earlier than the current year, and
the holiday cannot be set across two different years.

Recurring: It is used when the holiday repeats on the same date every year. The defaultis No. For example,
the Near Year’s Day is on January 1 each year and can be set as Yes. Some festival date changes every year,
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so it cannot be set a repeated and should be set as No.

For example, the date of Near Year's Day is set as January 1, 2019, and the holiday type is 1, then on January
1, Access Time Control will not follow the time of Tuesday, but the Access Control Time of Holiday Type 1.

2. After editing, click [OK] button to save, and it will display on the holiday list.
® Modify

Click Holiday Name or [Edit] button under Operations to enter the edit interface. After modification, click
[OK] to save and quit.

® Delete

In the access control holiday list, click [Delete] button under Operations. Click [OK] to delete or click [Cancel]
to cancel the operation. An Access Control Holiday in use cannot be deleted.

4.2.3 Access Levels

Access levels indicate that one or several selected doors can be opened by verification of a combination of
the different persons within a certain time zone. The combination of the different persons set in the
Personnel Access Level option.

Welcome, admin

Access Levels Browse Levels General ( Area Name ) Door Combination

1 Level Name | | Time zone a ® DoorName| | oOwmedDevie| | Q ®

The current query conditions None The current query conditions None
3
Access Control e (v Refresh  [® new (i} Delete 2, Door Control = (v Refresh (i} Delete Door [ Export

Level Name AreaName Time Zone  Door Count  Operations Door Name Owned Device

Time Zones

~ General Area Name  24-Hour Acce: 1 Edit Add Door 192.168.10 2321 192.168.10.232
Holidays
test-sz Area Name  24-Hour Acce: 1 Edit Add Door
e I AreaName  24-Hour Acce: 0 Edit Add Door
Set Access By Levels
4 New
Set Access By Person
Level Name* Test
Set Access By Department
Time Zone 24-Hour Accessible
Interlock Area Area Name
Linkage
First Person Normally Open
Multi-Person Group
Person Opening Door
TiE 42 T s, ] M Oan  TMaafdememeds . 14 . .| EDrowsperpage = JumpTo { 1 Page  Total of 1 records

® Add
1. Click [Access Control] > [Access Levels] > [New] to enter the Add Levels editing interface:
2. Set each parameter: Level Name (must not be the same as other level names), Time Zone.

3. (lick [OK] and then the system prompts “Immediately add doors to the current Access Control Level”;
click [OK] to add doors, or you can click [Cancel] to return the access levels list. The added access level
will be displayed in the list.
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Prompt

Immediately add doors to the current Access
Control Level?

& Note: Different doors of different panels can be selected and added to an access level.
® Door Control

Click [Access Control] > [Access Levels], and choose the access level, click door control, the operation will
affect all the doors of this access level.

m Welcome, admin ¢

@ Access Levels Browse Levels General ( Area Name ) Door Combination
E‘I Level Name Time Zone Q ® Door Name Owned Device Q ®
<, Device
The current query conditions None The current query conditions None
a Access Control (v Refresh @ New [ Delete %, Door Control = 2 (+ Refresh [} Delete Door [ Export
|~ Remote Opening
Time Ze Level Name Area Name Door Name Owned Device
ime Zones [] Remote Closing
Holidays v . General Area Name yg Cancel Alarm 192 168.10.232-1 192 166 10 232
v/ lesisz Area Name [ Remote Normally Open
I area Name ¥ Enable
Set Access By Levels @ Disable
[& Enable Intraday Passage Mode Time Zone

Set Access By Person 8} Bisabls Inirday Passaga|Made Time Zone

Set Access By Department

Interlock

Linkage

Anti-Passback

First-Person Normally Open

Multi-Person Group

Multi-Person Opening Door
Ij_J [EFETS & IR T oS, ) M Dnrn Tl af3 s 15 50rows perpage ~ JumpTo 1 1 Page  Total of 1 records

4.2.4 Set Access by Levels

Add/Delete Personnel for selected levels:
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Access Levels Browse Personnel Ground Level (Area Name ) From Levels
- T S = e g L
2 Device ‘ vel Name ime Zone a ® ersonnel l:l ame
. The current query condifions None | The current nuery conditions None

i Aocess Control ( Refesn [ 3. Click on Add Personnel Expor

D tee Level Mame Area Mame  Time Zone (F;:r:[a?ge] Operations | T Pesonnel 10 FirsTHame Last Mame Card Numl

Holidays Ground Level Area Name  24-Hour Acce: 0 Add Personne! ‘

Access Levely MEEET Add Personnel

(@ Conditional Cuery ) Department
Personnel ID Name Card Number More~ Q ®
| The current query conditions Mong
4. Select personnel ) Allemative Selected(0)
Py | First Last Card Gender  Departrr Personnel  First Last Card Gender  Deparim
ink: ' o Name Name Number D Name MHame Number
Linkage
) v 2 xyz - Developn
Anti-Passback =>:
1 abe — Marketing =
First-Person Nomally Open
< \\
Multi-Person Group = 5 MOVe
. - \. o
Multi-Person Opening Door
4 13
Parameters
1-2 50 rows per page ~
[
1€ < 12 PO | 50 rows perpage ~ JumpTo 1 {1Page  Total of 2 records 1€ '] o > > 50 rows perpage ~ JumpTo 1

1. Click [Access Control] > [Access Levels] > [Set Access By Levels] to enter the edit interface, then click
an Access level in the list on the left, personnel having the right of opening doors in this access level
will be displayed in the list on the right.

2. In the left list, click [Add Personnel] under Operations to pop up the Add Personnel box; select
personnel (multiple) and click > to move to the selected list on the right, then click [OK] to save and
exit.

3. Click the level to view the personnel on the list on the right. Select personnel and click [Delete
Personnel] above the list on the right, then click [OK] to delete.

4.2.5 Set Access by Person

Add selected personnel to selected access levels or delete selected personnel from the access levels.
Add/Delete levels for Selected Personnel:

1. Click [Access Control] > [Access Levels] > [Set Access By Person], click Employee to view the levels in
the list on the right.

2. Click [Add to Levels] under Related Operations to pop up the Add to Levels box, select Level (multiple)
and click = to move it to the selected list on the right; then click [OK] to save.

3. Select Level (multiple) in the right list and click [Delete from levels] above the list, then click [OK] to
delete the selected levels.

Setting Access Control for Selected Personnel:

A. Select a person in the list on the left and click [Access Control Setting].
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FirstMame | LastName = Card Number

Superuser

Device Operation Role Ordinary User ﬂ

Dizabled =]
Set Valid Time =]

Cancel

B. If required, set access control parameters and then click [OK] to save the settings.

C. Now you need to add levels to the personnel.

T

The current query conditions None
Department
Alternative Selecled(0)
[ Level Name Time Zone [ LevelName Time Zone

[ Levell 24-Hour Accessible

! v Ground Level 24-Hour Actessible

| 50rows perpage

D. After selecting the required level(s), click OK to save and exit.

4.2.6 Set Access by Department

You can add the selected department to the selected access levels or delete the selected department from
the access levels. The access to the personnel in the department will be changed.
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e

The current query conditions Nons

Altemative Selected(0)

Level Name Time Zone ] LevelMame Time Zane

Level 1 24-Hour Accessible
Ground Level 24-Hour Accessible

Master 24-Hour Accessible

21 50 rows perpage ™

4.2.7 Interlock
Interlock can be set for two or more locks belonging to one access controller. When one door is opened,
the others will be closed, or you cannot open the door.

Before setting the interlock, please ensure that the access controller is connected with the door sensor,
which has been set as NC or NO state.

® Add Interlock

1. Click [Access Control]> [Interlock] > [New] to enter the edit interface:

4. Select device

Device Name* ‘ Click to select

0l
Interlock Rule” ‘— §|

2. Select the required Device. When users are adding devices, interlocked devices cannot be seen in the
dropdown list. After deleting established interlock information, the corresponding device will return
to the dropdown list. Interlock setting will vary with the number of doors controlled by selected
devices:
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* A one-door control panel has no interlock settings.
*  Atwo-door control panel: 1-2 two-door interlock settings.

* A four-door control panel: 1-2 two-door interlock; 3-4 two-door interlock; 1-2-3 three-door
interlock; 1-2-3-4 four-door interlock.

3. Select Interlock Rule, select an item, and then click [OK] to complete. The newly added interlock
settings will be shown in the list.

& Note: During editing, the device cannot be modified, but the interlock settings can be modified. If the
interlock settings are not required for the device anymore, the interlock setting record can be deleted. If
users delete a device record, its interlock setting record, if any, will be deleted.

4.2.8 Linkage

Linkage setting means when an event is triggered at an input point of the access control system, a linkage
action will occur at the specified output point to control events such as verification, opening, alarm and
abnormal of system, and list them in the corresponding monitoring view.

Add Linkage setting:

Linkage Name” Test 2 Device” T 3
® rogetars | e
_ The current query conditions None || Linkage Trigger Conditions 4 Add Select All Unselect Al Input Point” 5
4 Device @ Inactive Auxiliary Input Time Zone Ay
’ (v Refresh [ @ New (' Delete I @ Auxiliary Input Disconnected (Open) I
| 4 Auxiliary Input Shorted (Closed) Auxiliary Input-1
ﬂ (e i) Linkage Name  Device Name
Time Zones
Holidays
Access Levels
Output Point* Video Linkage E-mail
ess By Levels
Door Auxiliary Output
ess By Person
192.168.1.76-1 6 7
Set Access By Department
Interiock
Anti-Passback
First-Person Normally Open Action type” Normally Open Action type” Open
Multi-Person Group Action time delay* 20 s(1-254)
Mul rson Opening Door
o]
K < 0 > 2 50 rows per pagl '

1. Click [Access Control] > [Linkage] > [New]

2. Enter the linkage name, select a linkage device, linkage trigger conditions, input point, output point,
and then set linkage action, video linkage and other parameters.

3. After selecting devices, corresponding linkage settings will be displayed. The System will first judge
whether the device is successfully connected and reads extended parameters. If there are no available
extended parameters, the system cannot set any linkage. If there is an available extended parameter(s),
the system will show linkage settings according to the door quantity, auxiliary input and output
quantity of currently selected device:
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4 [»4[> Door Event
[ 171 Normal Verify Open
[1[7) First-Personnel Open
[ ][] Multi-Personnel Open
[+ [ ] Emergency Password Open

[1[7] Open during Passage Made Time Zana
[+ [ Cancel Alarm

[+ [] Remote Qpening

[+ ] Remote Closing

[1[7 Operation Interval too Short

[ ][] Door Inactive Time Zone Verify Open
[1[7 Wegal Time Zone

3

&Note: Linkage Trigger Conditions contain Door Event and Auxiliary Input Event. And “Fail to connect
server”, “Recover connection”, “and Device connection off” will be filtered from Door Event.

[« Auxiliary Input Disconnected (Open)
[« Auxiliary Input Shorted (Closed)

Linkage Name” | Test | Device” T
Linkage Trigger Conditions®  Add Select All Unselect All Input Point™
[#/ Inactive Auxiliary Input Time Zone v [: Any

17 Auxiliary Input-1

Output Point™ Video Linkage E-mail
Door Auxiliary Output
[ 192.168.1.76-1
Action type” Normally Open E‘ Action type”® | Open E‘
Action time delay” |2{] |s{1-254)

4. Select the Input Point and Output Point, Linkage Action, and Email Address.
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5. It's supported to set video linkage, used with VMS Module, for more details please refer VMS module.

New
Linkage Name™ Test Devica” T
Linkage Trigger Conditions™  Add Select All Unselect All Input Point*
#| Inactive Auxiliary Input Time Zone ¥
#| Auxiliary Input Disconnected (Open) Any
#| Auxiliary Input Shorted (Closed) ) Auxiliary Input-1
Qutput Point* Videc Linkage E-mail
#| Pop Up Video Display time 10 s(5-60)
#| Video Video length 30 s(10-180)
# Capture In the monitoring page immediately pop up
Display time 10 s(10-60)

The fields are as follows:
Linkage Name: Set a linkage name.

Linkage Trigger Condition: It contains trigger conditions for Door and Auxiliary input. These conditions
trigger the event type of selected device. All events could be a trigger condition.

Input Point: Select appropriate triggering input point (the specific input point please refers to specific
device parameters).

Output Point: Select required output point (the specific output point please refers to specific device
parameters).

Action Type: Close, Open, Normal Open. The default is Close. To open, delay time or Normal Open shall be
set.

6. After editing, click [OK] to save and quit, then the added linkage setting will be shown on the list.
For example, if users select Normal Punching Open Door as a trigger condition, and the input point is Door

1, the output point is Lock 1, action type is Open, and the delay is 60 seconds. When Normal Punching
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Open Door occurs at Door 1, the linkage action of Open will occur at Lock 1, and the door will be open for
60 seconds.

#Note: During editing, you cannot modify the device, but modify the linkage setting name and
configuration. When delete a device, its linkage setting record, if any, will be deleted.

If the device and trigger condition are the same, and the system has a linkage setting record where the
input pointis a specific door or auxiliary input, it will not allow users to add (or edit) a linkage setting record
where the input point is any.

On the contrary, if the device and trigger condition are the same, and the system has linkage setting record
where the input point is ‘Any’, it will not permit the user to add (or edit) a linkage setting record where the
input point is a specific door or auxiliary input.

In addition, the same linkage setting at the input point and output point are not allowed. The same device
permits consecutive logical linkage settings. The system allows setting several trigger conditions for a
linkage setting at a time.

4.2.9 Anti-Passback

Currently, Anti-Passback settings support in and out Anti-Passback. On some special occasions, it is
required that the cardholders who entered from a door by card swiping at a door device must swipe the
cards over a device at the same door when leaving to keep the entry and exit records strictly consistent.
The user can use this function just by enabling it in the settings. This function is normally used in prisons,
the army, national defense, scientific research, bank vaults, etc.

Add Anti-Passback Settings:

1. Click [Access Control] > [Anti-Passback] > [New] to show the edit interface:

@ Device Name :l Q ®

F‘ Devi The current query conditions None
C evice
L &
O Refresh New m’ Delete

a Access Control [ |  Device Name Anti-Passback Rule

Time Zones

Holidays

New
Access Levels
Device Name” Click to select

Set Access By Levels

Anti-Passback Rule” [

Set Access By Person

Set Access By Department

Linkage

First-Person Normally Open

2. Select the required device(s). When adding Anti-Passback Rules, devices with Anti-Passback settings

Page |72 Copyright©2020 ZKTECO CO,, LTD. All rights reserved.



ZKBio Access IVS User Manual

cannot be seen in the dropdown list. When deleting established Anti-Passback information, the
corresponding device will appear in the dropdown list again. The settings vary with the number of
doors controlled by the device.

*  Anti-Passback settings of a one-door control panel: Anti-Passback between door readers.

* Anti-Passback settings of a two-door control panel: Anti-Passback between readers of door 1;
Anti-Passback between readers of door 2; Anti-Passback between door 1 and door 2.

* Anti-Passback settings of a four-door control panel: Anti-Passback of door 1 and door 2; Anti-
Passback of door 3 and door 4; Anti-Passback of door 1/2 and door 34; Anti-Passback of door 1 and
door 2/3; Anti-Passback of door 1 and door 2/3/4; Anti-Passback between readers of door 1/2/ 3/
4.

& Note: The door reader mentioned above includes Wigand reader that is connected with access controller
and Indio reader. The single and two door-controller with Wigand reader includes out and in the reader.
There is only “In reader” for four door control panel. The reader number of 1, 2 (that is RS485 address or
device number, the same below) is for door 1, the reader number of 3, 4 is for door 2, etc. No need to
consider if it is a Wiegand reader or InBio reader when you are setting the Anti-Passback between doors or
between readers, just make sure the in or out reader is set according to the actual requirements. For the
reader number, an odd number is for in reader, an even number is for our reader.

3. Select Anti-Passback Rule, and select one item, click [OK] to complete, and then the added Anti-
Passback settings will be shown in the list.

#sNote: When editing, you cannot modify the device, but can modify Anti-Passback settings. If Anti-
Passback setting is not required for the device any more, the Anti-Passback setting record can be deleted.
When you delete a device, its Anti-Passback setting record, if any, will be deleted.

4.2.10 First-Person Normally Open

This function helps to keep the door open for a specific time interval after the first verification by assigned
personnel.

During a specified interval, If the first verification is by a person having First-Person Normally Open level
access, then the door will be Normal Open, and will automatically restore closing after the valid interval
has expired.

Users can set First-Person Normally Open for a specific door (the settings include door, door opening time
zone and personnel with First-Person Normally Open level). A door can set First-Person Normally Open for
multiple time zones. The interface of each door will show the number of existing First-Person Normally
Open.

When adding or editing First-Person Normally Open settings, you may only select door and time zones.
After a successful addition, assigned personnel can open the door. You can browse and delete the
personnel on the right side of the interface.

Operation steps are as follows:
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1. Click [Access Control] > [First-Person Normally Open] > [New], select Door Name and Passage Mode
Time, and click [OK] to save the settings.

Name

Time Zones Doo ne Name L s sonnel ID irst Name Last Name

Holidays

Door Name* Click to select
Passage Mode Time Zong™ m

EXTD I BT

Door Mame* 192.168.213.252-1

Passage Mode Time Zong* |24-Hour Accessible =|

2. Click [Add Personnel] under Related operation to add personnel having First-Person Normally Open

level (this person must have access control level), then click [OK] to save.

First Person Normal Open

Door Name l:l Device Name l:l Q ®

The current query conditions None m
(v Refresh [ New [fj Delete 4

O Door Mame Device Name Passage Mode  Personnel stions
Time Zone CQuantity

1 192.168.213.252-1 192.168.213.252 24-Hour Accessib 0 Edit Add Personnel

4.2.11 Multi-Person Group

The door will open only after the consecutive verification of multiple people. Any person verifying outside
of this combination (even if the person belongs to any other valid combination) will interrupt the
procedure and you need to wait for 10 seconds to restart verification. The door cannot be opened by
verifying using just one of the combinations.
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1. Click [Access Control] > [Multi-Person Group] > [New] to access the following edit interface:

Q] ©Open Door Group Browse Personnel

Device Group Name Remark \ Q ®  PersonnellD First Namo | Mmoo Q @

= S—
The current query conditions None The current query conditions None
ﬂ Access Control (% Refresh [ New fffj* Delete ( Refresh " Delete Personnel
Group Name Personnel  Remark Operations Personnel ID. First Name Last Department
Time Zones
Quantity Name

Holidays

Access Levels New

Set Access By Levels — | ‘

Set Access By Person Remark

Set Access By Department

trock ok J cancel |

Linkage
Anti-Passback

First-Person Normally Open

Multi-Person Opening Door

Parameters

Group name: Any combination of up to 30 characters that cannot be identical to an existing group name.
After editing, click [OK] to save and return. The added Multi-Person Personnel Group will appear in the list.
2. Click [Add personnel] under Related Operations to add personnel to the group.

3. After selecting and adding personnel, click [OK] to save and return.

#sNote: A person can only be a part of only one group.

4.2.12 Multi-Person Opening Door

Set levels for personnel in Multi-Person Personnel Group.

It is a combination of the personnel in one or more Multi-Person Personnel Groups. When setting the
number of people in each group, you can configure one group (such as combined door opening by two
people in one group) or multiple groups (such as combined door opening by four people, including 2
peoplein group 1 and 2 people in group 2), and at least one group shall consist of number of door opening
people instead of 0, and the total number shall not be greater than 5. In addition, if the number of people
entered is greater than that in the current group, Multi-Person Opening Door will be disabled.

Multi-Person Opening Door Settings:

1. Click [Access Control] > [Multi-Person Opening Door] > [New]:

Page |75 Copyright©2020 ZKTECO CO,, LTD. All rights reserved.



ZKBio Access IVS User Manual

® e R T R T R

The current query conditions None

(% Reiresh New [ff Delete

B Access Control 0 | compim=—— — D fi-Person Group ‘ Operations

New

ME—uI Device

Time Zones
Door Name* 192.168.213.252-2

Holidays Combination Name* Group1

Access Levels Number of opening . .
personnel in each group
)

Set Access By Levels

Set Access By Person

@ 0 @ @ @
S @ 8 ¢

Set Access By Department

Interlock

Linkage

First-Person Normally Open

Multi-Person Group

1€ < 0 P | 50rows perpage ~ JumpTo 1 /0 Page  Total of O records

2. The maximum number of Multi-Person Opening Door people for combined door opening is 5. The
numbers in the brackets show the current actual number of people in a group. Select the number of
people for combined door opening in a group and click [OK] to complete.

&sNote: The default Card Interval is 10 seconds, it means that the interval of two personnel’s verification
must not exceed 10 seconds. You can modify the interval if the device supports it.

4.2.13 Parameters

Click [Access Control] > [Parameters] to enter the parameter setting interface:

® Type of Getting Transactions
Periodically

Device Interval: | 1+ | hour(s)

# Set the Time for Obtaining New Transactions
a Access Control

« 0:00 1:00 2:00 300 4:00 5:00 6:00 7:00 800 9:00 10:00 11:00
12:00 13:00 14:00 15:00 16:00 17:00 18:00 19:00 20:00 21:00 22:00 23:00
Holidays
Select All || Cancel
Access Levels A\ Getting transactions and s done at the same time.
Set Access By Levels Transactions Auto-Export
Set Access By Person Auto-Export Frequency| By Day
— v — v (hourminute)
Set Access By Department
Export Mode: Daily Transactiens

® Al Data(export up to 30000 pieces of data)
Interlock Recipient's Mailbox

Linkage

Anti-Passback

A\ Enter multiple mailboxes, separated
First-Person Normally Open

Real Time Manitoring

Multi-Person Group

The Real Time Monitoring Page Pop-up Phota Size Max Height{140 px

eight

A\ Refresh the realin

Multi-Person Opening Door

» Type of Getting Transactions
Periodically

The system will download new transactions at the selected time interval.
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Set the Time for Obtaining New Transactions

The system will download new transactions automatically at the selected time instances.
» Transactions Auto-Export

Auto-Export Frequency

It supports to set the Auto-Export Frequency by Day or Month. When the Auto-Export frequency is set by
day, you have to set the Hour and minute.

Auto-Export Frequency: By Day v

0a v . 00 ¥ | (hour:minute)

When the Auto-Export frequency is set to month, you have to select whether to export on the first day of
the month or on a particular date.

Auto-Expert Frequency: By Manth v
® First day of the month
Specific Date ;| 28 ¥ (1-28)
Export Mode

It supports to export the Monthly Transactions or All Data. At a time, the device can export 30000 data.

Export Mode: Monthly Transactions{All transactions between date of last month and this month)
®) All Data{export up to 30000 pieces of data)

Recipient's Mailbox

Set the Recipient's Mailbox.

Recipient's Mailbox

Example

» The Real Time Monitoring

You can select the checkbox accordingly.

#| Enable Display Photos Function
#| Enable Audio Alert Function

If the display photo is selected, the real-time monitoring page will display the personnel photo during an
access control event. You can set the quality of the image as required; the more px value will give a clearer
photo.
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Alarm Monitoring Recipient Mailbox: The system will send emails to alarm monitoring recipient’s
mailbox if there is any event.

4.3 Access Reports

nou

Includes “All transactions”, “Events from Today”, “All Exception Events” and so on. You can export after the
query.

You can generate statistics of relevant device data from reports, including card verification information,
door operation information, and normal punching information, etc.

About the Normal and abnormal event please refer to Real-Time Monitoring for details.

Verify mode: Only Card, Only Fingerprint, Only Password, Card plus Password, Card plus Fingerprint, Card
or Fingerprint etc.

& Note: Only event records generated when the user uses an emergency password to open doors will
include only password verification mode.

4.3.1 All Transactions

Because the data quantity of access control event records is more, you can view access control events as a
specified condition when querying. By default, the system displays the latest three months’ transactions.
Click [Reports] > [All Transactions] to view all transactions:

The time from | 2018-09-27 000000  To 2018-12-27 23:50.50 Personnel ID | Device Name Morer Q ®
The current query conditions The time from'(2018-09-27 00:00:00) To:(2018-12-27 23:59:59)
“+ Refresh (" Clear Al Data [ Export

EventID Time Device Name Event Point Event Description Media File Personnel ID First Name Last Name Card Number Departmen Dep¢
Number Nam

2018-12-27 191548 SpeedFace-V5 Disconnected =
2018-12-27 1755730 192.168.213 99 Disconnected
Everts Eron Jodat] 64376 2018-12-27 17:56:04  192.168.213.99 Device Started
64375 2018-12-27 17:48:46  192.168.213.99 Device Started
Last Known Position
64374 2018-12-27 17:45:16  192.168.213.99 Device Started
S e 64373 2018-122717:4324 192.16821399 Connected to the servt
Access Rights By Door 64372 2018-12-27 17:43.06  192.168.213.99 Device Started
Access Rights By Personnel 2018-12-27 17:43:01 SpeedFace-V5 SpeedFace-V5-1 Normal Verify Open 575 Jeff 1 pag
2018-12-27 17:4253 SpeedFace-V5  SpeedFace-V5-1 Normal Verify Open 575 Jeft 1 z+
2018-12-27 17:2529  192.168.213.99 Disconnected
64371 2018-12-27 1356146 192.168.213.99 Connected to the serve
64370 2018-12-27 13.56.01  192.168.213.99 Device Started
2018-12-27 11:46:48 SpeedFace-V5  SpeedFace-V5-1 Normal Verify Open 575 Jeft 1 b3

Media File: You can view or download the photos and videos.
Clear All Data: Click [Clear All Data] to pop up prompt and click [OK] to clear all transactions.

Export: You can export all transactions in Excel, PDF, and CSV format.
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All Transactions

Event Time Device Name| Event Point Event Personnel | First Name | Last Card Depart | Department| Reader | Verification| Area | Rem
ID Description 1D Name Number ment Name Name Mode Name | ark
Numbe
r
-1 2018-12-27 Disconnected Other Other Area
19:15:48 Name
-1 192.168.213.9 Disconnected Other Other Area
9 Name
64376 | 2018-12-27 |[192.168.213.9 Device Started Other Other Area
17:56:04 9 Name
64375 2018-12-27 |192.168.213.9 Device Started Other Other Area
17:48:46 9 Name
64374 2018-12-27 [192.168.213.9 Device Started Other Other Area
17:45:16 9 Name
64373 2018-12-27 |192.168.213.9 Connected to Other Other Area
17:43:24 9 the server Name
64372 | 2018-12-27 |[192.168.213.9 Device Started Other Other Area
17:43:06 9 Name
1255 2018-12-27 SpeedFace- |SpeedFace-V5-| Normal Verify 575 Jeff 1 ZKTeco |SpeedFace- Face Area
17:43:01 V5 1 Open V5-1-Out Name
1254 2018-12-27 SpeedFace- |SpeedFace-V5-| Normal Verify 575 Jeff 1 ZKTeco |SpeedFace- Face Area
17:42:53 V5 1 Open V5-1-Out Name
-1 2018-12-27 |192.168.213.9 Disconnected Other Other Area
17:25:29 9 Name
64371 2018-12-27 |192.168.213.9 Connected to Other Other Area
13:56:46 9 the server Name
64370 2018-12-27 |192.168.213.9 Device Started Other Other Area
13:56:01 9 Name
1253 2018-12-27 SpeedFace- |SpeedFace-V5-| Normal Verify 575 Jeff 1 ZKTeco |SpeedFace- Face Area
11:4A:4R Vs 1 Nnan VE=1=lut Nama

4.3.2 Events from Today

Check out the system record today.

Click [Reports] > [Events from Today] to view today’s records.

The current query conditions: None

(* Refresh [ ClearAllData [ Export

Time Card Number Personnel 1D First Name Last Name Department Device Name Ewvent Point Ewvent Description Media File Reader Name Verification
Name Mode

2015-05-26 16:4156 2182405 54 dany nee General 1921681134  192168.1.134-1 Normal Verify Open 192 168.1.134-11 Only Fingerprin
2015-05-26 16:41:54 2182405 54 dany nee General 192.168.1.134  192.168.1.134-1 Normal Verify Open 192.168.1.134-11 Only Fingerprin
2015-05-26 16:41:52 2152405 54 dany nee General 1921681134  192168.1.134-1 Normal Verify Open 192 168.1.134-11 Only Fingerprin
2015-05-26 16:41:49 2182405 54 dany nee General 192.168.1.134  192.168.1.134-1 Normal Verify Open 192.168.1.134-11 Only Fingerprin
2015-05-26 16:41:42 2182405 54 dany nee General 192.168.1.134  192.163.1.134-1 Normal Verify Open 192.168.1.134-11 Only Fingerprin|
2015-05-26 16:41:37 2182405 54 dany nee General 1921681134  192168.1.134-1 Normal Verify Open 192 168.1.134-11 Only Fingerprin
2015-05-26 16:41:27 2182405 54 dany nee General 192.168.1.134  192.168.1.134-1 MNormal Verify Open 192.168.1.134-11 Only Fingerprin
2015-05-26 16:41:22 2182405 54 dany nee General 1921681134  192168.1.134-1 Duress Open Alarm 192 168 .1.134-11 Only Fingerprin
2015-05-26 16:41:18 2182405 54 dany nee General 1921681134  192168.1.134-1 Normal Verify Open 192 168.1.134-11 Only Fingerprin
2015-05-26 16:41:14 2182405 54 dany nee General 192.168.1.134  192.168.1.134-1 Normal Verify Open 192.168.1.134-11 Only Fingerprin
2015-05-26 16:41:03 2182405 54 dany nee General 1921681134 192168.1.134-2 Normal Verify Open 192 168.1.134-2- Only Card

You can export all events from today in Excel, PDF, and CSV format.
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ZKTECO
Events From Today
‘Card Number Personnel ID First Name Lasthame | D Name | Devics Nam= Event Point__| Even g Reader Name i Mode | AreaName Remark
20171215 18:20: 4820038 & Amber Lin Financial 162.168.218.60 | 182.188.278.50-2 | Dockaround Venfy | 192.168.218.80-2- Only Card AreaName
02 Department Success In
2017-12-15 18:28: 4628038 & Amber Lin Financial 10218021860 | 102.188.21m60- | DaCkEround Verfy | 162,188 218.80-1- Only Card Area Name
o Department Success In
2017-12-15 1828 Marketi B d Verty | 162.168.218.602-
12260070 5 Necal Ye larketing 102.168.218.60 | 182.188.218.60-2 | Sockaround Verify Only Card AreaName
a5 Department Success In
2017-12-15 1828 Marketi B d Verty | 182.168.218.60-1-
12260070 5 Necal Ye larketing 102.168.218.60 | 162.188.218.60-1 | Dockaround Verify Only Card AreaName
a1 D Success In
2017-12-15 18:28: 4481253 1 Jerry Wang General 10216821860 | 182.188.218.60-2 | Dockground Verify | 102.168.218.80-2- Only Card AreaName
38 Success In
2017-12-15 18:28: 4481253 1 Jerry Wang General 102168.218.60 | 102.188.21a 601 | Dackaround Verdy | 162.168.218.80-1- Only Card AreaMame
35 Sucess In
20171215 18:28: 1411237 2040 Shemy ¥ang Hotel 162.168.218.60 | 182.188.278.50-2 | Dackaround Verify | 192.168.218.80-2- Only Card AreaName
23 Sucess In
20171215 18:28: 1411237 2040 Shemy ¥ang Hotel 162.168.218.60 | 182.188.278.50-1 | Dockaround Verify | 192.168.218.80-1- Only Card AreaName
20 Success In
20171215 18:28: 9508830 o Lilian Mei Development 162.168.218.60 | 182.188.278.50-2 | Dackaround Verify | 192.168.218.80-2- Only Card AreaName
17 Department Success In
251828 505030 o Lilisn Mei Development | ) 1 21a.60 | 102,168, 21mp0.1 | SRCRArOund Vel | 1SIOB2IB00- | o ooy Area Name
13 Department Success In
2017-12-15 18:28: 13271770 3 Leo Heu Financial 102.168.218.60 | 102.108.218,60- | Dackaround Verty | 162,188 218.80-2- Only Card Area Name
08 Department Success In
20171215 18:28: 12271770 a Lea Heu Financial 10216821860 | 182.188.218.60-1 | Dockground Verify | 102.168.218.80-1- Only Card AreaMame
0 Department Success In
2017-12-15 18:20: 4481253 1 Jerry Wang General 16216821860 | 182.188.218 602 | Cockaround Verify | 152.168.218.80-2- Only Card AreaMame
52 Success In
2017-12-15 18:20: 4481253 1 Jerry Wang General 16216821860 | 182.188.218 602 | Cockaround Verify | 152.168.218.80-2- Only Card AreaMame
18 Success In
2017-12-15 18:20: 4481253 1 Jerry Wang General 16216821860 | 182.188.218 602 | Dockaround Verify | 152.188.218.80-2- Only Card AreaMame
12 Success In
2071215 18:23: 8155208 2 Lucky Tan Development 102168.218.60 | 102.188.21a 60.2 | Dackground Verify | 162.168.218.80-2- Only Card AreaMame
02 Department Success In
20171218 18:22: 2481253 1 Jerry Wang General 102.168.218.60 | 182.108.278.50-7 | Sackaround Verify | 192.168.218.80-2- Only Card AreaName
2 Success In
T2 1820 6505930 o Lilian Mei Development | ) eg218.00 | 102108218002 | SRREround Vel | 1EZI0BIB002 | o 0oy Area Name
Department Success In
Gresma on: 20713 1936
Creea Pom 2R BcBer SR A resanes =

4.3.3 Last Known Position

Check out the latest position of the person who has access privileges to access. It is convenient to locate a
person.

Click [Reports] > [Last Know Position] to check out.

The time from 2018-09-27 00:00.00  To 2018-12-27 23.50.50 Personnel ID | Device Name Morer Q@
The current query conditions The time from;(2018-09-27 00:00:00) To:(2018-12-27 23:59:59)

+ Refresh " Clear AllData  [# Export

Event ID Personnel ID First Name Card Number Time Departmen Department Device Name Event Point Event Description Last Name
Number  Name

Reports C 0 575 Jeff 2018-12-27 174301 1 ZKTeco SpeedFace-V5 SpeedFace-V5-1 Normal Verify Open
All Transactions
Events From Today

Last K

All Exception Events

Access Rights By Door

Access Rights By Personnel

Locate the location of personnel: Personnel with electronic map authority, click on the corresponding
[Personnel ID], you can locate the specific location of the personnel in the electronic map by the way of
flashing the door.

You can export all personnel final position data in Excel, PDF, and CSV format.

Last Known Position

Event | Personnel | First Name Card Time Depart | Department | Device Name| Event Point Event Last Reader | Verification| Area | Rem
1D 1D Number ment Name Description Name Name Mode Name | ark
Numbe
r
0 575 Jeff 2018-12-27 | ZKTeco SpeedFace- |SpeedFace-V5-| Normal Verify SpeedFace- Face Area
17:43:01 V5 1 Open V5-1-Out Name
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4.3.4 All Exception Events

Click [Reports] > [All Exception Events] to view exception events in specified condition. The options are the
same as those of [All Transactions].

The time from  2018-09-27 00.00.00 To 2018-12-27 23.59.59 Personnel ID | Device Name More~ Q ®
The current query conditions The time from:(2018-09-27 00:00:00) To:(2018-12-27 23:59:59)

(+ Refresh [ Clear Al Data [ Export

pcoess Coukol Event ID Time Device Name Event Point Event Description Media File Personnel ID First Name Last Name Card Number Departmen
Number
Reports Sl -1 2018-12-27 19:15:48  SpeedFace-V5 Disconnected
-1 2018-12-27 17.57:30 192.168.213.99 Disconnected
All Transactions
-1 2018-12-27 17:25:29  192.168.213.99 Disconnected
Evens Eomjiodey - 2018-12-26 18:45:08  SpeedFace-V5 Disconnected
Last Known Position 1220 2018-12-26 18:16:58 SpeedFace-V5 SpoeedFace-V5-1 Unregistered Personne
1218 2018-12-26 18:16:52 SpeedFace-V5 SpeedFace-V5-1 Unregistered Personne
) 1215 2018-12-26 18:15:19 SpeedFace-V5 SpeedFace-V5-1 Unregistered Personn¢
Access Rights By Door
1214 2018-12-26 18:14:40 SpeedFace-V5 SpeedFace-V5-1 Unregistered Personne
Access Rights By Personnel
1213 2018-12-26 18:14:27  SpeedFace-V5 SpeedFace-V5-1 Unregistered Personne
1212 2018-12-26 18:12:48 SpeedFace-V5 SpeedFace-V5-1 Unregistered Personn¢
121 2018-12-26 18:11:12  SpeedFace-V5 SpeedFace-V5-1 Unregistered Personne
1210 2018-12-26 18:10:46 SpeedFace-V5 SpeedFace-V5-1 Unregistered Personne
1209 2018-12-26 18:10:42  SpeedFace-V5 SpeedFace-V5-1 Unregistered Personne
1208 2018-12-26 18:10:38  SpeedFace-V5 SpeedFace-V5-1 Unregistered Personn¢
1204 2018-12-26 18.08.04 SpeedFace-V5 SpeedFace-V5-1 Unregistered Personne
1203 2018-12-26 18:07:33  Spe: 5 pe V5-1 L Personne

Clear All Data: Click [Clear All Data] to pop up prompt, and then click [OK] to clear all exception events.

Export: You can export all exception events in Excel, PDF, and CSV format.

All Exception Events
Event Time Device Name| Event Point Event Personnel | First Name [ Last Card Depart | Department| Reader | Verification| Area | Rem
1D Description D Name [ Number [ ment Name Name Made Name | ark
Numbe
r
-1 2018-12-27 SpeedFace- Disconnected Other Other Area
19:15:48 V5 Name
-1 2018-12-27 192.168.213.9 Disconnected Other Other Area
17:57:30 9 Name
-1 2018-12-27 [192.168.213.9 Disconnected Other Other Area
17:25:29 9 Name
-1 2018-12-26 SpeedFace- Disconnected Other O ther Area
18:45:08 V5 Name
1220 2018-12-26 SpeedFace- |SpeedFace-V5-| Unregistered SpeedFace- Face Area
18:16:58 V5 1 Personnel V5-1-Out Name
1218 2018-12-26 SpeedFace- |SpeedFace-V5-| Unregistered SpeedFace- Face Area
18:16:52 V5 1 Personnel V5-1-Out Name
1215 2018-12-26 SpeedFace- |SpeedFace-V5-| Unregistered SpeedFace Face Area
18:15:19 V5 1 Personnel V5-1-Out Name
1214 2018-12-26 SpeedFace- |SpeedFace-V5-| Unregistered SpeedFace Face Area
18:14:40 V5 1 Personne’ V5-1-Out Name
1213 2018-12-26 SpeedFace- |SpeedFace-V5-| Unregistered SpeedFace Face Area
18:14:27 V5 1 Personnel V5-1-Out Name
1212 2018-12-26 SpeedFace- |SpeedFace-V5-| Unregistered SpeedFace Face Area
18:12:48 V5 1 Personnel V5-1-Out Name
1211 2018-12-26 SpeedFace- |SpeedFace-V5-| Unregistered SpeedFace Face Area
18:11:12 V5 1 Personnel V5-1-Out Name
1210 2018-12-26 | SpeedFace- |SpeedFace-V5-| Unregistered SpeedFace Face Area
18:10:46 V5 1 Personnel V5-1-Out Name
1209 2018-12-26 SpeedFace- |SpeedFace-V5-| Unregistered SpeedFace- Face Area
18:10:42 V5 1 Personnel V5-1-Out Name
1208 2018-12-26 SpeedFace- [SpeedFace-V5-| Unregistered SpeedFace Face Area
18:10:38 V5 1 Personnel V5-1-Out Name

4.3.5 Access Rights by Door

View related access levels by the door. Click [Reports] > [Access Rights By Door], the data list on the left
side shows all doors in the system, select a door, the personnel having access levels to the door will be
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displayed on the right data list.

@ Access Rights By Door .V5-10p¢ g
E‘,‘J v Door Name Device Name Q & (O Retresh [4 Expont
T currect quty condmions: Hoe Personnel ID First Name Last Name Department Name
Tﬂ Access Control + ("% Refresh 575 Jeff ZKTeco
' Repens Door Name Door Number Owned Device 1 abc xyz Marketing Department
SpeedFace-V5-1 1 SpeedFace-V5 2 abct xyz1 Development Departm¢
All Transactions. 192168213991 1 192.168.213.99 343 example Financial Department
Events From Today 192168213992 2 192.168.213.99 432 ex Marketing Department

Last Known Position

All Exception Events

Access Rights By Personnel

You can export all the personnel having access levels to the door data in Excel, PDF, and CSV format.

Personnel
Personnel ID First Name Last Name Department Name
575 Jeff ZKTeco
1 abc XVZ Marketing Depart ment
2 abel xyzl Development Department
43 example Financial Department
132 ex Marketing Depart ment

4.3.6 Access Rights by Personnel

View related access levels by personnel.

Click [Reports] > [Access Rights By Personnel], the data list on the left side shows all doors in the system,
select personnel, the personnel having access levels to the door will display on the right data list.

@ Access Rights By Personnel Browse:exHaving Level to Access
@] s ‘ Personnel ID First Name Morev Q (® (O Refresh [# Export
The current query conditions None Door Number Door Name
Access Conirol & C Refresh 1 SpeedFace-V5-1
Personnel ID First Name Last Name Department Name 1 192.168.213.99-1
' Reports ()
432 ex Marketing Department 2 192:100213.00.2
All Transactions 343 example Financial Department
Events From Today 1 abc Xyz Marketing Department
Last Known Position 2 abc1 xyz1 Development Department
. 575 Jeff ZKTeco
All Exception Events
Access Rights By Door
You can export all the door information in Excel, PDF, and CSV format.
Door
Door Number Door Name
1 SpeedFace-V5-1
1 192.168.213.99-1
2 192.168.213.99-2
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5 Attendance Management

To help companies perform information-based attendance management, this software implements
automatic collection, statistics, and query of employee attendance data. This improves the management
of human resources and facilitates the check-in of employees. This software enables the management
personnel to collect statistics and check the employee attendance and enables the management
department to query and appraise the attendance of all departments, thus allowing enterprises to
accurately acquire the employee attendance data.

5.1 Attendance Device

This function includes adding a device, adding area and assigning it to the personnel. Set the
communication parameters of the device. The system can communicate with the device properly only
when communication parameters are configured correctly, including the parameter settings in the system
and the device. After successful communication, you can view the information on the connected device
and can perform remote monitoring of the device/upload and download.

5.1.1 Set Attendance by Area

Area is a concept of space that facilitates the management of devices in a specific area.

In this system, area setting is a process of dividing devices by zone. A prominent feature of “Area” is to allow
the system to automatically manage the employee information on devices. According to requirements,
areas can be allocated to devices (one device can belong to one area only), and employees can be allocated
to one or more areas.

Click [Device] > [Area] > [New] to add new personnel in the area:

@ Attendance Area Attendance Area: Area Name
B Attendance Devica meahame| | O @ Personnel ID | | Name| | wmorer Q@
The current guery conditions None The current query conditions None
(" Refresh (* Refresh [ Delete Personnel | ¥ Private Message {7 Re-synchronize to device
dance By Person 5 .
Area Number  Area Name Parent Area Parent Area Qperations Personnel ID First Name Last Name: Department Name
Add Personnel Department Name
Fersonnel ID Name Department Name Q ®
The current gquery conditions None
Alternative Selected(0)
Personnel ID FirstName  LastName  Departme Personnel ID FirstName  LastName — Departme
==
Basic Information
2=
om Shift
=. Schedule
Exception 1] 50 rows per page ~
Calculate Report | m 'e - JumpTo 1 /1Page  Total of 1 records

Add/delete personnel for a specified area

1. Click [Device]> [Area], click a certain area of left side, the system will display the personnel on the right
side.
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2. Click [Add Person] under the list on the left to pop up the Add Person page. Select the person to the
right list and click [OK] to complete it;

3. Todelete apersonin the area, select the person on the right side and click [Delete Personnel] to delete
the person from the area.

Private Message
This feature can display a short message to someone regularly (device should support).
Select personnel and click [Personal SMS]. The setting interface as follows:

Frivate Message

SMS Content”

Start Time”

Short Message Duration &0

(minutes)

o oo

After the setting is completed, click [OK]. After swipe cards successfully on the device, the device will send
short message to this person. For example, the message like "Happy Birthday to you", to strengthen the
interaction between the company and employees.

The fields are described below:

Short Message: The message displayed on the time and attendance device, which supports input 40
characters.

Start Time: The start time to display private short messages.

Short Message Duration (minutes): Shows the duration of the private short message after a successful
check-in.

Re-synchronize data to the device

Synchronize personnel data from the system to the device. Select a device of a certain area, click [Re-
synchronize to device], and click the [OK] button to synchronize the data, so that personnel can verify on
the time attendance device in the area:
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Prompt

Are you sure you want to perform the Re-
synchronize to device operation?

5.1.2 Set Attendance by Person

Click [Attendance Device] > [Set Attendance by Person], add the area to personnel, the page as follows:

Personnel Personnel :
Personnel ID Name Morer O ® Area Name Q ®
The current query conditions None The current query conditions None
(C* Refresh (* Refresh (ff} Delete area
Personnel 1D First Name Last Name Department Name Operations Area Number Area Name: Parent Area Parent Area Name

Device 1 Department Name Add area

1 Area Name
Attendance Point

Device Operation Log

Add / Delete areas for specified personnel

1. Click the [Attendance Device]> [Set Attendance by Person], choose a person on the left side, and the
area to which the person belongs is displayed in the list on the right.

2. Click [Add Area] under the list of the left page. Select the area to the list on the right and click [OK] to
complete the edit.

3. Select the area on the right and click [Delete Area] to delete the person from the area.

5.1.3 Device

After a time and attendance device is added to the software, the user can search device, edit, delete, device
control, view and get information, clear device data, view commands, etc.

® Search for device

1. Click [Attendance device]>[Device] > [Search Device], as follows:
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Total Progress N | S-21ched devices count 1

ergen| | seims | ®

IP Address Serial Number Davice Typs Cperations

192.168.213.220 BYUJ180660001 Add

A\ The current system communication port is 3038, please make sure the device is set comectly.

Close

2. Click [Add] to pop up the device edit interface. After the information is filled in, click [OK] to complete

operation, and click [Cancel] to cancel the edit operation.

Davice Mame” BYU.I180660001

Serial Mumber” BYLL130660001

IP Address 192 168 .213 .220
Attendance Area” Area Name :
Time zone* (UTC+8)Beijing, Chines
Enroliment Device (]

Fields are as follows:

Device Name: Time and attendance device name, any character up to 20.
Device Serial Number: Attendance device serial number.

IP Address: The IP address of the attendance device.

Attendance Area: The equipment for regional division, to achieve regional data management.
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Time Zone: Time and attendance at different time zones.

Enrollment Device: If not selected, the user data uploaded by the device will not be processed (the
attendance record of the device will not be checked). If checked, the user data uploaded by the device will
be processed.

& Note: Before adding devices to the software, users need to set the communication IP and address of
time attendance device.

® Edit Device

Select the device and click [Edit], to modify device information.

® Delete

Select the device and click [Delete] to remove the device and its information.
® Refresh

Click [Refresh] to update the device list status information.

® Enable

After the device is enabled, the upload and download of data are enabled normally. (When the device is
enabled, users can choose whether it is a registration device or not).

® Disable
After the device is disabled, the device is not allowed to upload and send data.
® Public Message

You can set the public messages in the device so that the device can display short messages on the page
(Not all the devices support this function).

® Synchronize software data to the device

Select the device to be synchronized and send the corresponding device area data in the software to the
device.

® Get Device Option

Select the device of which you want to get information, click Get software to send command, get the device
related parameters, such as: serial number, IP address, device model, firmware version number, etc.

® View Command

After clicking [View Command], the page will navigate automatically to the device commands page in the
system management module to show command queries.
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iew Device Parameters

Parameater Nams Paramster Valus
Current Number of Users/iMaximum MNumbe 10000
Current Face Number/Maximum Number of /400
Current Fingerprint NumberifMaximum Numl 3/'3000
Current Finger Vein Number/Maximum Num 0M1000
Current Palm Number/Maximum Palm Num' /0
Current Number of Records/Maximum Num! 0/200000
Maximum Number of User Photos 2000
Face Recognition Algorithm Version -1
Fingerprint Recognition Algorithm Yersion 10

Finger Vein Recognition Algorithm Version 3

Palm Recognition Algorithm Version 5
Firmware “ersion Ver 8.0.4 3-20190613
Push “ersion “er 2.0.36-20131122

® Attendance Data Checking

Select the device to proofread data, select the proofing date, the software issues a command to proofread
the software and device attendance data.

® Upload Data again

Select the device in which you want to upload data. Click to enter the check box to upload the data type:
attendance record/attendance photo, click the confirmation to get such information again from the device.
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Upload Data again

Whether to upload aftendance records
Whether to upload aftendance photos

® Get the Specified personnel data

Select the device from the list and click Get the Specified personnel data. The below prompt will appear.

Get the specified personnel data

Enter person number”

Enter the desired person numbers separated by a comma and click [OK].

® Clear Device Commands

Select the device to be cleared. It clears the operation command issued by the software in the setting.
® (Clear the attendance photos

Select the device. This function will clear all the attendance photo records from the device.

® (Clear the attendance transactions

Select the device. This function will clear all the attendance data records from the device.

® Reboot Device

Select the device you want to restart; the software sends a reboot command and restarts the device.
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5.1.4 Attendance Point

The system supports setting access control as the attendance point. After setting the access device as an
attendance point, its access records will be transferred to the attendance system in real time as punch
records.

Altendance Point Name*

Device Module*

Area Name” Area Name [-]

5.1.5 Device Operation Log

Click [Attendance Device]> [Device Operation Log] to display the operation logs of the attendance device
in the area.

® Time From |2019.08-2500:0000 | To |2019-12.25 235858 Devceseralnumoer [ | Q @ =

The current query conditions Time From:(2019-06-25 00-00:00) To:(2018-12-25 23:59:59)

B} Attendance Device
(v Refresh

Device serial Operation time 0 Operation Qperation object description 2 Operation object description 3
number

BYUJISOBE0001  2018-12-25 10:10:14  Entermenu
BYUJS0BE0001  2019-12-2509:3652  Entermenu
endance Point BYUJ130660001  2019-122508:3646  Foweron

BYUJ180B60001  2018-12-2509:36:46  Alarm Alarm reason:Machine Been Broken

5.2 Basic Information

5.2.1 Basic Rule

Since the attendance system of the company is different, the user needs to manually set the attendance
parameters to ensure the accuracy of the final attendance calculation. The attendance rule setting is a way
to show the company’s attendance system.

1. Basic Rule Setting
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Basic Rule Setting Calculation Setting Other Setting

Check-in Rule The Earliest Rule The minimum time period should be greater
than{minimum 10 minutes)

Check-out Rule The Latest Rule The maximum time period should be less 600
than(maximum 1,440 minutes)

Late and Early Leave Counted as Absent No Attendance calculation result when the shift First Day
cross-day

Search Shift Record Department->Group Overtime Statistics Yes

Intelligent Matching Shift Rule Least Abnormal

Check-in Rule:

*  Earliest Principle: By default, it takes the first check-in within the valid time zone.

*  (Closest Principle: It will take the closet check-in within the valid time zone.

Check-out Rule:

* Late Principle: By default, it takes the last punch card record within the range of valid attendance range.

*  C(losest Principle: It takes the punch card record closest to the closing time within the range of valid
attendance).

The minimum time period should be greater than (minimum 10 minutes):120 (default); Range: 10-
999; Required.

The maximum time period should be less than (maximum 1440 minutes): 600 (default); Range: 10-
1440; Required.

Late & Early Leave Counted as Absent: No (default) Yes refers to that if it is late or early leave, then the
time period is recorded as an absence.

Attendance calculation result when the shift cross-day:
*  The first day: The effective working hours of the second day is counted to the first day;
*  The second day: The effective working hours of the first day is counted to the second day.

Overtime Statistics: Yes (default), No; the first overtime switch for statistics, if set to No, overtime will not
be calculated.

Search Shift Record: The attendance calculation is done based on this priority order

Intelligent Matching Shift Rule: Longest Working duration, Least abnormal (default). The longest
working duration will calculate each shift respectively to obtain the most effective longest time shift. The
Least abnormal will consider the shift which has a minimum number of exceptions (such as late, leave early,
etc.).
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2. Calculate Settings

Basic Rule Setting Calculation Setting Other Setting
Hour Conversion Rule ®  Take the result calculated by the formula as the standard;
Formula: Hours = Minutes / The remainder is greater than or equal to | 55 Calculated as an hour, otherwise calculate as half an hour or ignored;
60

The remainder is greater than or equal to| 25 Calculated as half an hour, otherwise ignored;

Days Conversion Rule e Take the result calculated by the formula as the standard;
Formula : Days = Minutes / Quotient is greater than or equal to the work minutes | 80 %,calculated as one day, otherwise calculat as half-day or ignored;
Number of minutes to work
ey Quotient is greater than or equal to the work minutes | 20 %,calculated as hali-day, othernwise ignored;
Absent days conversion rule Days Conversion Rule
Exact digits of the decimal 1
point

Hour Conversion Rule: Take the result calculated by the formula as the standard.

The calculation results are taken as the criterion, and then the decimal place of the calculation result is

retained in combination with the exact digits of the decimal point.

Residue range: The result of the calculation is processed according to rules, and then the decimal places
of the calculation result are retained in combination with the precise digits of the decimal point. As set in
the above figure, if the result is 55 min, then it will take as 1 hour, and if the result is 25 min, then it will take

as half an hour.
Day Conversion Rule: The settings are same as Hour conversion rule.

Absent day’s conversion rule: If you want to make this calculation effective in attendance calculation

then select Days Conversion Rule.
Decimal point accurate to digits: Default is 1; available choices are 1,2 & 0.

3. Other settings

Basic Rule Setting Calculation Setting Other Setting

The attendance result symbol setting in the report

Expected/Actual \ Late < Early > Absent o

No Check-in [ No Check- 1 Leave Q Overtime +
out

Adjust Rest c Append . Business A Out (0}
Attendance Trip

Sets the representation of the attendance results in the report: Set the required symbol for the
following data; Expected/Actual, Late, Early, Absent, No Check-in, No Check-out, Leave, Overtime, Adjust
Rest, Append Attendance, Trip, Out. Repeated symbols are allowed.

5.2.2 Custom Rule

This interface displays the rule types applicable to group schedule / department schedule. If not defined
here, group schedule or department schedule takes the settings of basic rules and supports the operations
of adding, deleting and editing.
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(G) Rule type Name Q ®
“a‘ Attendance Device B The current query conditions None
(O Refresh [@ New (i Delete
‘r‘ij Basic Information Name Rule type Using the object Operations
Basic Rule Test Grouping rules Edit Delete
Holiday
Leave Type
Automatic Report
Parameter Setting
Add
Click Basic Information > Custom rule > Add, display as the following page:
New
Name* Tast -
Rule type* Grouping rules
Group
Check-In Rule The Earliest Rule
Check-Out Rule The Latest Rule
Late and Early Leave Counted as Yog
Absent
Attendance calculation result for First Day
cross-day shift
Intelligent Matching Shift Rule Longest Working Dur
Cwertime Statistics Yag
Single shortest overtime (minutes) 10
Maximum overtime (minutes) Mo limit
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5.2.3 Holiday

» Adding

1. In the function menu, click [Basic Information] > [Holiday] > [New], the following page is displayed:

Mew
Mame™ ‘ tis recommended fo “ame|
Start Time* 2019-12-25
End Time* 2019-12-25

Femark

Csoesnon o Jcarca

2. After the information is entered, click [OK] to finish new addition, click [Cancel] to cancel new addition,
click [Save and Continue] to save and continue adding.

Field Description:

*  Number: Length 5, required

*  Name: Character length 10; required

*  Start time: Holiday start date, the format is date and time
* Endtime: Holiday end date, the format is date and time

*  Remark: Character length 50

> Delete

Select the Holiday which need to be deleted and click [Delete].
> Edit

Select holiday which need to be edited and click [Edit] beside holiday information.

5.2.4 Leave Type

There are 9 leave types by default, editable, but not allowed to be deleted: user-defined leave type can be
extended.
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>

@ Basic Information

® o —

The current query conditions None
(¥ Refresh New i} Delete

Name \Whether to substract work hours  Operations

“57,“ Attendance Device

Casual Leave Yes Ed

Basic Rule

MariageLeave  No

Custom Rule

Maternity Leave No
Holiday

Sick Leave Yes

Annual Leave No

Bereavement Leave No

Automatic Report

Home Leave No
Parameter Setting

Breastfeeding Leave No

User define Yes

Adding

In the menu, click [Basic Information] > [Leave Type] > [New], the following page is displayed:

MNew

Mame”® ‘ tis recommended to end

Whether to substract work hours™  Yas

After the information is entered, click [OK] to finish new addition, click [Cancel] to cancel new addition,

click [Save and Continue] to save and continue adding.

The default system has 9 kinds of leave type: Casual leave, Marriage Leave, Maternity Leave, Sick Leave,
Annual Leave, Home Leave, Bereavement Leave, Breastfeeding Leave, custom. We can edit these leave
type but cannot delete it.

Delete

Select the leave type and click [Delete] to delete.

>

Edit

Select the leave type and click [Edit] to edit.

Field Description:

Name: Required, maximum character length is 30

Whether to subtract work hours: Set whether to deduct the length of work for the leave of this leave.
For example, maternity leave / marriage leave / annual leave are statutory holidays without deducting

the length of work.

Page |95 Copyright©2020 ZKTECO CO,, LTD. All rights reserved.



ZKBio Access IVS

User Manual

5.2.5 Automatic Report

Automatic report supports the function to package the report into an attachment at a fixed time point

(daily or monthly) and send the attachment via email to be designated personnel or ftp server.

1. In the function menu, click [Basic Information] > [Automatic Report] > [New], the following page is
displayed:
New
Send Mode Setting Mail Delivery Time Setting
Send Mode* Mailbox Delivery Metha Send Frequency By Day
Report Setfing — v hour : |— ¥ |minute
— ¥ hour : |— ¥ minute
Report Type” Transactions ;
— ¥ hour : |— ¥ minute
File Name* ;
— ¥ hour : |— ¥ minute
yyyyMMdd — v hour : |— ¥ minute
HHmmss — ¥ hour @ — v minute
Field Field Name Field Number
Depariment Number  {deptCode}
Wail Setting
Department Name {deptMName}
Personnel ID {personPin} Receiver Sefting Set by Personnel
First Name {personMams} Mail Address* Please enter a valid email address. if more than
Last N LastN one address is entered, separate with',’
ast Name {personLasiName} Example: 123@foxmail. com, 456@foxmail.com
Serial Numb deviceS|
erial Number faevicesn Title Setting™ The Maximum Length50
Device Mame {deviceMame}
Attendance Area {areaMame} Body Setiing The Maximum Length200
Attendance Date {attDatetime}
File Type* EXCEL
e-mail fun 0 kl
M File type select EXCEL, the content format is all fields
2. Inthe Report Setting section;
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Report Type: Select the desired choice from “Transactions” or “Daily Attendance”. The report will be
according to the selected type. Transactions will give the details related to the device with Attendance
area and time of the personnel. Daily attendance will give the attendance details of the personnel.

File Name: Consists of 3 parts: custom file name + year, month, day, hour, minute and second, such
as (Department of the original records of the test section 201706271143).

A. The first field is for the custom file name
B. The second field contain two option for the format of the date: yyyyMMdd and yyyy-MM-dd

C. The third field contain the hour, minute and second format: Currently it supports HHmmss.
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Field: Displays the field name and field code of the current report type.
File Type: Currently it supports TXT.

Content Format: It will define the format of the content in the exported report. For example:
{deptName} 00 {personPin} 01 {personName} 02 {attDatetime} 03.

3. In the Mail Delivery Time Setting; set frequency for the mail delivery. The frequency has two options;
By day and By month. If you have selected “By day”, then you can set a maximum of 6 interval in a day
(only once per hour) at which the mail delivery will start.

A. ltcan only be set in increasing order of time,
B. The minute setin the first-time interval will be same for all other five intervals.

If you have selected as “By month”, then you have 3 options to choose from; first is “last day of the
month”, second is first day of the month and the third is any specific date.

4, Mail setting: Set the details of receiver mail.
> Receiver settings: Set the receiver as per below options:

* Set by Personnel: Enter the E-mail address in text box, and if more than one email is there,

u,n

then put “." to separate the e-mails.

* Set by Department: Select a department from the department hierarchy,

* Set by Area: Select an attendance area from the area hierarchy,
> Title setting: It refers to subject of the mail. The maximum length is 50 characters,
> Body settings: Write the text accordingly. The maximum length is 255 characters,
5. Make sure the sender mail settings are already defined.

6. Once all the details are filled, click [OK] to finish.

5.2.6 Parameter Setting

Calculate Settings

Calculation Setfing
Hour Conversion Rule 0 Take the result calculated by the formula as the standard.
Formula: Hours = Minutes / 60 The remainder is greater than or equal to| 55 Recorded as one hour.
The remainder is greater than or equal io 25 Calculated as half an hour, otherwise ignored,
Days Conversion Rule 0 Take the result calculated by the formula as the standard.
Formula : Days = Minutes / Number of Quotient is greater than or equal to the work minutes | 30 9% calculated as one day
minutes to work per day Quotient is greater than or equal to the work minutes | 20 %,calculated as half-day, otherwise ignored

Day conversion benchmark Days Conversion Rul

Exact digits of the decimal point 1

Hour Conversion Rule/ Day Conversion Rule: The calculation result shall prevail (Based on the calculation
result, and then combined with the exact number of decimal places to retain the decimal place of the
calculation result). Remainder range (get results according to the rules, and then combine the exact
number of decimal places to retain the decimal place of the calculation result).

Absence days: Day conversion rule; calculated as work days.
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Exact digits of the decimal point: 1 (default), 2.

Timed Calculation:
Timed Calculation

Unit | hour(s) Calculation interval : |1 hour{s)

Set the unit and frequency of timed calculation. For example, the calculation interval can be set
automatically calculate every N minutes or N hours.

5.3 Shift

5.3.1 Break Time

This page shows break time that can be selected for deduction, user can add, delete, and edit.

Name Q @

The current query conditions None

(v Refresh  [® New (ffi Delete

Mame Start Time End Time Operations
Afternoon Tea 15:00 16:00 Edit Delete
® New

Click [Shift]> [break time]> [New], like the following page:

Mew
Mame*

g * . N | R KA
Start Time: 00 - 00 | (HH:MM)
End Time* 00 © 00 = (HH:MM)

—l

The fields are described below:
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Name: Define the name of break time, 30 characters in length, required.
Start time: The start of break time

End time: The end of break time

® Edit

Click on the name of break time or [Edit] to modify the break time zone.

5.3.2 Timetable

This function is used to set the time zone that will be used in the attendance calculation and configuring
the information of each parameter with the minimum unit set. For example, allow late / early leave time,
whether itis necessary to Check-in / Check-out, set the time range of Check-in / Check-out, overtime setting
and so on.

Before setting the shift, you should set all possible time segments, that is, time zone setting. Set the shift
before scheduling, setting the attendance rules in the settings will be significant.

Click [Attendance] > [Shift] > [Timetable] to enter the time zone page:

® Browse rest periods

o ® S I—

The current query conditions None The current query conditions None

Name Timetable Type

[2]] Attendance Device

(&) Basic Information [E : reresn [® New ) Delete C Refresh  ffj} Delete

E G — Name Timetable Type Ghack-in Start Time  Gheck-In Time Gheck-Out Time GCheck-OutEnd Time  Opers Name Start Time End Time
o ©

Break Time:

® Adding Timetable

Click on [New] to add a new timetable.
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New

MName* It is recommended to start Timetable Type® MNormal Timetable
Check-In Time™ 09 (D00 | (HH:MM) Check-Out Time* 18 [1j00 | (HH:MM )
Before going to 60 | Check-in is valid within Befare going off duty” 60 | Check-in is valid within
work” minutes minutes
After work” 60 | Check-in is valid within After work” 60 | Check-in is valid within

minutes minutes
Allow Late(minutes) |0 Allow Early 0

Leave(minutes)
Must Check-In” Yas Must Check-Cut” Yes
Workday 1.0 ‘Work Time (minutes)* 540
Auto Deduct Break Time* Mo
On duty

Coneamaven | o J~carca

Set the value of each mandatory field as per the field explanation below:
All fields marked with * are mandatory.

Number: Any combination of numbers or letters. The number should not be identical with another zone
number. The length is 5 characters.

Name: Should not contain special symbols, the name of the period should not be identical with other zone

name, the length of 10 characters.

Check-in / Check-out start time, Check-in / Check-out end time: The format is "hour: minute”, set the
check-in / check-out as required. The records outside this range will be considered as invalid records. The
Check-in / Check-out start time and Check-in/ Check-out end time should not be same.

The system default check-in start time is 08:00; check-in end time is 10:00;
The system default check-out start time is 17:00; the check-out end time is 19:00.

Check-in / Check-out: The format is "hour: minutes". Check-in time should be after check-in start time and
Check-out time should be after check-out end time. The system default check-in time is 09:00; Check-out
time is 18:00.

= Note: If the Check-out time is less than the Check-in time, it means it is a two-day shift span. Currently
the system only supports creating Time Zones across one day only.

Allow Late (minutes) and Allow Early Leave(minutes): The allowed late time is the maximum time allowed
after check-in, leave early is the maximum time allowed before check-out. The check-in and check-out
should be within the effective range to be valid. The system default Allow late and Leave early minutes is
0.
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= For example: If the number of minutes allowed to be late is set as 5, and the working time as 9:00,
Suppose A Check-in at 9:03 and B Check-in at 9:06, then A is not late, because his check-in time is within
limit, B is late because he is late T minute more than the set limit. The logic of early leave is the same.

Must Check-in and Check-out: Set whether to set check-in and check-out as compulsory while
commuting to work or not within the selected time range. If set as "Yes", then check-in / check-out is
required; otherwise for “No”, it is not required. The system default setting is "Yes".

Calculated as Working days: If the value is set here, the program will count the working days according
to the set value statistics, otherwise, it will count according to the setting in the attendance rules. The
system default working days number is "1".

Deducted Time (Minutes): This function is used to set the total break time between Check-in and Check-
out. It is set according to the company lunch time and the evening break in nine to six shifts. The default
interval between the deductions is 60 minutes.

Work Time (minutes): This will be the total effective time of this shift. It is automatically set by the system
as per the Check-in/out details. The formula for calculation is Total minutes between Check-in and Check-
out subtracted by Deducted time (minutes). It also supports manual input, that is, custom work time can
be set. For example, suppose the Check-in is at 09:00 and Check-out is set as 18:00, and the deducted time
is set as 60 minutes. Now the total time in minutes between Check-in and Check-out is 480 minutes, now
to get the Work time we need to subtract deducted minutes from this time, so the value will be like (480-
60 = 420) minutes.

Delay Time calculated as overtime: For calculating the overtime we need to set the time from which the
overtime should start. If it is selected as "Yes", we need to define "Calculated as Overtime From”. Overtime
calculation formula: overtime = Check-out time - Calculated as Overtime From. The system default
overtime start hours is as "18:00"; If the "Delay Time calculated as overtime" is set to "No" then the time
after the check-out time will not be calculated as overtime. The system default is No.

5.3.3 Shift
Shift is composed of one or more timetable period(s) in accordance with a certain order and cycle of
sequence. It is set as default shift for staffs. To get staff attendance, first we must set the shift.

Click [Attendance] > [Shift] > [Shift] to enter the main menu of shift as shown below. The search function
can be convenient for shift inquiry. The list shows all shifts of the current system. The time period details
list shows the details of the time period of the shift in the form of a chart.
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New
Schedule Type Schedule Name
Name* It is recommended to start Number® It is recommended to start
Shift Type” Regular Shift Color
Unit* Day Cycle(1-99)*
Cycle Start Date” 2019-12-25 Cycle Shift in one Month™ Yes
Name ®
Mame Check-In Check-Out  Workday Select All Timetable Details Unselect All
Time Time
If the timetable detail check box cannot be checked, it indicates that there is an overlap in the timetable

If you click the [New] button, the above interface appears, the shift setting is divided into three parts, the
specific settings as follows:

1. Shift definition:
» Schedule type:
Shift type: There are two types, "Regular shift" and "Flexible shift". The system default is "Regular shift".

* Regular shifts: One or more normal timetable periods can be selected to form a regular shift
according to the rule. Regular shifts are often used in more regular work places such as offices,
governments and banks.

*  Flexible Shift: Only one flexible time period can be used to combine flexible shifts. Flexible
shifts are commonly used by Dockers and for hourly workers.

Color: Currently this field is not effective.

Number: Supports any combination of numbers or letters, and should not be identical with another shift
number, the maximum length is 5 characters.

Name: Any character, shift name shouldn’t be identical with another shift, the maximum length is 10
characters.

Unit: The unit of setting cycle, there are three options; Day, Week and Month, the default being the "day".
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Cycle: Defines the number of shift cycles, the shift cycle = the number of cycles * units. If the unit is "day",
the range is 1-99; if the unit is "week", the range is 1-15; if the unitis "month", the range is 1-12.

Start Date: Defines the start date of the shift, the date before the start date is not affected by the shift. The
system default start date is the current system date.

» Schedule name:

[G] Number | | Name shitType|——— | Q ® +  Timetable Details

The current query conditions None
(* Refresh [® New (fjt Delete

< Basic Information | New

Atiendance Device

A snin Schedule Type Schedule Name

Work Type™ Normal Work Altendance Mode™ Punch Card Accorg
Break Time Overtime Type* Normal Day Overtime Mode* Computer Automat

Timetable

Name ®

Name Check-n Check- Workday Select All Timetable Details Unselect All
Time Quit
Time

- Schedule

j, Excepiion

[l Calculate Report It the timetable detail check box cannot be checked, it indicates that there is an overlap in the timetable | . Double-click the shift pericd; you can delete the time

[Shift Management]> [Shift] here user can choose normal work, weekend OT, and holiday OT. When the
work type is normal work, you can choose to mark overtime as weekdays, rest days, and holidays; when
the work type is overtime on weekends or holidays, the overtime includes the time before/after work.

Attendance Mode: It defines the method of attendance calculation for this shift. Below are the 4 ways:

e Punch Card According to Normal Shift: This is the system default. The check-in should be as per
the shift timings.

e Punch once at any time in a day: In this option, the staff only needs to punch a card at any time
of the day.

*  Only calculate the Punch Card time: It will take two valid punch card time intervals as effective
working time.

*  Free Punch:In this option, the staff does not need to Check-in or Check-out.

Cycle shift in one month: If you have selected “Yes”, then after the cycle is finished, it will restart again.
This field is displayed only when you select Unit of the cycle as "Days", it will not be displayed in

“Week" and "Month".
Overtime Mode: This function decides the calculation of Overtime. Drop-down menus are:

¢  Computer Automatically Calculation: The computer automatically calculates whether the delay
time will be calculated as overtime or not.

e Overtime must apply: If this option is selected, then the overtime will not be calculated
automatically. It will take the overtime sheet as final. If the check-out time is less than the end
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time of overtime, it will not count overtime hours.

*  Must Work overtime or Absence: If this option is selected, then the overtime will not be
calculated automatically. It will take the overtime sheet as final. If the check-out time is less than
the end time of overtime, it will not count overtime hours and will record as an absence.

e Shorter duration between Auto-Calculation and Overtime Receipt: When overtime sheets and
automatic calculate overtime, both are enabled; the system will take the period which has the
least overtime.

*  Not calculated as overtime: Overtime applied for overtime will not be calculated as overtime
hours.

Overtime Type: Through this option, we can set how the overtime after the work time is considered. Drop-
down menus are:

* Normal Day: If selected, the entire time period of overtime hours will be marked as normal over
time.

e  Rest Day: If selected, the entire time period of overtime hours is recorded as rest day overtime.

* Holidays: If selected, the entire time period of overtime hours is marked as overtime work
holidays.

2. Shift time period definition

After all the fields of the shift definition are entered, you can define the shift time. All the timetable created
earlier will be displayed in the list. You can choose one or more timetable period only when the time for
both are not overlapping.

= Note: Regular shifts can only use the Regular time period, flexible shifts can only use flexibly the.
3. Shift cycle definition

Once the shift and time periods are defined. the shift cycle and time period can be defined. This part is
mainly to define the rules of the shift. If you do not schedule any time period on one day, you do not need
to go to work that day.

After the setting is completed, click the [OK] button to save and return to the shift page. The newly added
shift information will be displayed on the shift list.

w Note: Here are a few simple shift settings interfaces.

1) Regular shift with Day as a unit:
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l Schedule Type Schedule Name
Namer e Number R
Shift Type* Reguiar Shift [ - | Color #GEFFEG

Unit* Day Cycle(1-82)* 7
Cycle Start Date” (7) 2019-12-25 Cycle Shiftin one Month™ (7) Yes [~ ]

we . Q©®

Name Check-In Check-Out  Waorkday Select All Timetable Details Unselect All
Time Time

v Test 09:00 12:00 10 [#/MNo.1Day 2018-12-25 09:00-18:00
[#INo.2Day 2019-12-26 09:00-18:00

[#/MNo.3Day 2018-12-27 09:00-18:00

[#INo.4Day 2019-12-28 09:00-18:00

R [#INo.5Day 2018-12-29 09:00-18:00

: [_IMo.BDay 2018-12-30 09:00-18:00

[CJNo.7Day 2019-12-31 09:00-18:00

If the timetable detail check box cannot be checked, it indicates that there is an overlap in the timetable.

Save and New OK Cancel

2) Regular Shift with Week as Unit:

l Schedule Type Schedule Name

Name* Test Number*

Shift Type* Regular Shift Colar H#EEFFG6

we . Q©®

Name Check-In Check-Out  ‘Workday Select All Timetable Details Unselect All
Time Time
W Test 08:00 18:00 10 #Monday 02-00-18:00 =
[#Tuesday 09:00-13:00
[#Wednesday 0%:00-13:00
[#Thursday 09:00-13:00
R [#IFriday 09:00-18:00
" [Dsaturday 09:00-12:00
[CISunday 09:00-13:00
[#Monday 0%00-13:00
[#/Tuesday 09:00-18:00
[#IWednesday 09:00-13:00
[#| Thursday 05:00-13:00

If the timetable detail check box cannot be checked, it indicates that there is an overlap in the timetable.

Save and New OK Cancel

aNote: The shift only provides users with a cycle rule for the selected period of time within the set period.
The unselected dates will be off day. When a user schedules shift for an employee, he will simply select the
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start and end dates and the number of cycles, without having to confirm workday an off day. After the
frequency is selected, the system determines which day to go to work according to the period set by the

selected frequency.
» Adding timetable

Select a shift and click [Edit] to enter the editing interface, set the area in the shift time and shift period and
time period, and increase the shift time period and the period, click [OK] to save and exit. Then add a time

period in the shift.

= Note: This function can be used when the attendance time period is not consistent throughout the week

or if there are multiple time periods for a shift.

For example: Suppose in a company, every Monday, Wednesday and Friday have (attendance) period of 9:
00-16: 00, and every Tuesday, Thursday has (attendance) period of 10: 00-19: 00.

1. To set this shift we need to first create two timetable periods.

2. Create a timetable of 10:00 to 19:00 like the above displayed.

Edit

Name* T 10-18 Timetable Type® Normal Timetable
Check-In Time* 10 |:|00 | (HH:MM ) Check-Out Time* 19 |:|00 | (HH:MM }
Befare going to 60 | Check-inis valid within Befare going off duty” 60 | Check-inis valid within
waork” minutes minutes
After work?” 60 | Check-inis valid within After work* 60 | Check-inis valid within

minutes minutes
Allow Late{minuies) g Allow Early 0

Leave(minutes)
Must Chack-In* Yas Must Chack-Out” Yas
‘Workday 1.0 Work Time (minutes)® 540
Auto Daduct Break Time”® Mo
On duty

3. Now go to shift interface, After you click [Edit], below shift page will appear:
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New
Schedule Type Schedule Name
Nama™ Test Number* It is recommended to start
Shift Type* Regular Shift Color
Unit* Week Cycle(1-15)* 1
Name ®
Name Check-In Check-Out  Workday Select All Timetable Details Unselect All
Time Time
v T916 09:00 16:00 10 #Monday 0e:00-16:00
Tuesday 0%:00-16:00
T10-18 10:00 18:00 10
+#\Wednesday 05:00-16:00
Thursday 0%:00-16:00
_ #IFriday 09:00-16:00
° [JSaturday 03:00-16:00
Sunday 0%:00-16:00
If the timetable detail check box cannot be checked, it indicates that there is an overlap in the timetable

4. Since the company's shift schedule is weekly and has the same working conditions every week, the
setting unit is "Week" and the number of cyclesis "1".

5. Since the working days from 09:00 to 16:00 are Monday, Wednesday, and Friday, so select it at the
right side in the "Timetable Details" box.

6. ForTuesday and Thursday, do the same step as an above, first tick and click on the timetable and then
select Tuesday and Thursday as shown below:
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Schedule Type

Name”
Shift Type*
Unit*

Name

Name

v T916

~  T10-19

If the timetable deta

New
Schedule Name
Test Number® It is recommended to start
Regular Shift Color
Week Cycle(1-15)" 1
Check-In Check-Out ‘Workday Select All Timetable Details Unselect All
Time Time
0500 1500 10 Monday 10:00-12:00
#Tuesday 10:00-12:00
10:00 15:00 1.0
‘Wednesday 10:00-1%:00
#Thursday 10:00-19:00
Friday 10:00-19:00
Saturday 10:00-1%:00
Sunday 10:00-19:00
check box cannot be checked, it indicates that thers is an overlap in the timetable

[onercnew o J—come |

7. After the setting is completed, click the [OK] button to save and return to the shift page. The new shift
information will be displayed on the shift list. Click the row where the shift is located to view the details
of the shift time period at the right side of the interface, as shown in the following figure:

Number
The current query conditions None
(O Refresh [® New (it Delete
Name Number

Test 1

Name

shift Type

Sshift Type Unit Cycle

Regular Shit  Week 1

Cycle Start Date

Q ® Timetable Details
Monday 08:00-16:00
Tuesday 10:00-19:00
Work Type Operations Wednesday 05:00-16:00
_ Thursday 10:00-19:00
Nermal Work Edit Delete Clear Timetable
Friday 09:00-16:00
Saturday
Sunday

As shown in the figure above, the shift on Monday, Wednesday and Friday (attendance) is at 9: 00-16: 00
and on Tuesday and Thursday (attendance) is 10: 00-19: 00.

> Clear Timetable

In the shift list, click the [Clear Timetable] button in the [Operation] column of the shift. This operation only
corresponds to a single shift, batch operation is not available. A confirmation page will pop up; click the
[OK] button to confirm the deletion of all the timetable of the selected shift.
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Number Name Shift Type Q ® Timetable Details
The current query conditions None Monday 09:00-16:00
(> Refresh [® New [ Delete Tuesday 10:00-19:00
Name Number Shift Type Unit Cycle Cycle StartDale  Work Type Operations fErE BT
. : Thursday 10:00-19:00
Test 1 Regular Shift  Week 1 Normal Work Edit Delete Clear Timetable
Friday 09:00-16:00
Saturday
Sunday
Prompt
Are you sure you wish to clear the timetable for
the selected shift?
o |

> Delete the shift

In the shift list, click the [Delete] button in the [Operation] column where the shift is located. This operation
only corresponds to a single shift, the batch operation is not available), click [Delete] to enter the deletion
confirmation page, click [OK] to delete the selected shift and exit.

Or first select the shift to be deleted (that is, the checkbox in front of the row where the selected shift is
located), click the [Delete] button at the top of the interface to enter the deletion confirmation interface,
and click [OK] to complete the batch deletion operation.

w.Note: If this shift is scheduled, it cannot be deleted. You need to delete all scheduled shifts that is

connected to this shift before you can delete the shift.
> Export

This function will export all the details of the shift in excel, puff and CSV file format.

ZKTECO
Shift
Name Number Schedule Type Unit Cycle Start Date Cyclejgrrlflthln oue
Day Shift 1 Regular Shift Day 10 2017-12-15 Yes
Night 2 Regular Shift Day 10 2017-12-18 Yes
Flexible 3 Flexible Shift Day 10 2017-12-18 Yes

5.4 Schedule

After setting the time attendance and shift cycle, you can schedule it. Schedule management includes:
Group, Group Schedule, Department Schedule, Personnel Schedule and Temporary Schedule.

wNote: Schedule management is divided into 4 groups, departments, personnel and temporary
scheduling. So, when the shift is scheduled to repeat, then at this time there will be a priority judging. This
priority setting you can find under the "Basic Information" > "Rule" page. The default is "Department-

Group", which is the highest priority shift.
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Basic Rule Setting Calculation Setting Other Setting

Check-in Rule The Earliest Rule The minimum time period should be greater 120

than{minimum 10 minutes)
Check-out Rule

The Latest Rule The maximum time period should be less 00

than(maximum 1,440 minutes)

Late and Early Leave Counted as Absent Mo Attendance calculation result when the shift First Day
cross-day
| Search Shift Record Group->Department | Qvertime Statistics Yes

T

Intelligent Matching Shift Rule | Least Abnormal

In the same type of scheduling for a person, the software processing logic is as follows: Follow-up of the
new shift will overwrite the previous shift. Suppose, you have been added to shift A from June 1 to June
10. Now you have been added in a new shift B from June 5 to June 10, so from June 5 to June 10 you have
to work as per Shift B's schedule.

5.4.1 Group

Before group scheduling, you need to group people with the same attendance rules. Groups mainly
include "Query", "New", "Delete", "Add Personnel", "Edit", "Delete Personnel" and other functions.

Click [Attendance] > [Shift Management] > [Group] to enter the main interface of the group. The search
function can conveniently search the group if you have many groups in your system. The list shows all the
groups present in the current system. The list of people is shown in the Browse Group Personnel on the
right side of the interface.

Welcome, admin

Edit Personnel for Group

Browse the Group Personnel

Name Q ® Personnel \Dl:l Name vore Q. ®
The current query conditions None The current query conditions None
(> Refresh [® New (i} Delete [2] Add grouping rules (> Refresh fh Delete
Name Personnel  Grouping rules  Remark Cperations Personnel ID First Name Last Name Department Name
Quarity
Group Schedule
Department Schedule
Personnel Schedule
Temporary Schedule
Unscheduled Personnel
[§) Bxceptin
] Calulate Report ) o P
& perpage ~ JumpTo 1 /DFage  Total of 0 recorcs 0 S0rowsperpage ~  JumpTo 1 /0Page  Total of @ records

» Adding a group

Click on the main group interface [New] button, new group interface will popup:
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Name* It is recommended to start

Femark

Name: Does not support special characters, group name should not be identical with another group name.

The maximum length is 10 characters.

Remarks: Write any note for this group, if it has some characteristic information; the maximum length is
50 characters.

» Editgroups

Group_Test

Cancel

1. As shown above, select a group and click the [Edit] button in the [Operation] column of the group to
enter the editing group interface.

2. After modifying the fields that need to be modified, click the [OK] button and return to the group page.
» Delete Group

1. Select one or more groups and click the [Delete] button on the upper left of the group list to enter the
confirmation page for deleting the group.
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2. Click [OK] to delete the group and return to the group page.

= Note: If there is a person in the group or in group scheduling, it cannot be deleted. First, you need to
delete all the people in the group and schedule to delete the group.

> Add Personnel

| Add personnel

| @ Conditional Cluery Cepartment

Pesomeli | Name Morer Q, X

The current query conditions None

Alternative Selected(D)

Personnel  First Last Department Mame Personnel  First Last Department Mame

1] Name Name D Name Name

1 Department Name
=
=
<
E=

1-1 50 rows per page ~

Cancel

1. Select a group and click the [Add Personnel] button in the [Operation] column of the group to enter
the personnel adding interface as shown above.

2. Select the relevant personnel from the list on the left side and move it towards the right list. Click the
[OK] button to complete the addition of personnel operations.

=Note:
1) Those who have been assigned to this group will be listed on the right side of the group interface.

2) People who have been added to other groups will be deleted from the original group after they are
added to the group.

3) To search conditional query, filter through "Department” and get the list of candidates.
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> Delete people
Edit Personnel for Group Browse the Group Personnel
Name Q ® Personnel ID Name More~ 0\ @

The current query conditions None

(v Refresh New (fj Delete [2] Add grouping rules

Name Personnel Grouping rules ~ Remark
Quantity

Group Test 1

1. Asshown in the above figure, select a group and select the person to be deleted in the browser group
on the right. Click the [Delete Personnel] button to enter the interface of confirming the deletion.

The current guery conditions None

(C* Refresh (it Delete

Operations v Per&%D First Name Last Name

Edit Add personnel M

2. Click the [OK] button to delete the personnel.

5.4.2 Group Schedule

The group/department shift on the left and the shift details on the right.

Department Name

Department Name

[G) Group Name | Group_Test << 201912 >>
[©i| Attendance Device ol ( Refresh New (i} Delete [ New Temporary Shift su Mo Tu we T Fr sa
Group Name ScheduleType  SnitName Start Time
) Basic Information 1 2 3 4 5 6 7
Group Test Nomal Schedule  Test 2018-12-01 - _— . e _—
Shift
8 9 10 " 12 13 14
Tost Test Test Test Test
Department Schedule
15 16 17 18 19 20 pal
Personnel Schedule Test Test Test Test Test
Temporary Schedule
Unscheduled Personnel
22 23 24 25 26 27 28
Test Test Test Test Test
29 30 31 1 2 3 4
= Tost Test
‘5“ Exception
— »
] Caleviate Report ® 11 s0rowsperpage -  JumpTo 1 1 Page

This function is used to schedule a group to the personnel in shift(s). The new group scheduling interface

is shown as below:
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® Group Name | Group_Test << 2019-12 >>
[2]] Attendance Device [ C Retesh [ New (i Delete [ % New Temporary Snift su Mo Tu We Th Fr sa
_ v Gig lame Schedule Type Shift Name: Start Time
(s) Basic Information @ 1 2 3 4 5 6 7
= Group Test Normal Schedule  Test 2018-12-01 T T o = =
2 snir
B, schedue
8 9 10 1 12 13 14
Group Test Test Test Test Test
Department Schedule
: 15 16 17 18 19 20 21
Personnel Schedule Test Test Test Test Test
Temporary Schedule
Unscheduled Personnel
22 23 24 25 26 27 28
Test Test Test Test Test
29 30 3 1 2 3 4
@ Exception @ Test Jest
= _ »
1| Caleulate Report ® 11 Srowsperpage =  JumpTo 1 1 Page
Mew
" *
Schedule Type Normal Schedule
Start Time* Q-
[ Group_Test 2018-12-01
End Time 2018-12-31 ®
i
E MName Mumber Shift Type
+f  Test 1 Fegular Shift

Save and New “ Cancel

For Group scheduling you need to select the group, set start date/end date, shift type, select the shift.

Define the start and end date for the group schedule. From the start date, the schedule will come into effect.
Shift type: There are two kinds, Normal Schedule and Smart Schedule.

Through Normal Schedule, you can only choose a single shift. If you select more than one shift, the below
prompt will appear:
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The normal schedule can only choose one shiftl

Through Smart Schedule you can choose more than one shift. After you select the smart schedule, the
software will automatically determine the most suitable frequency according to the punch card records in
attendance calculation.

Choose the shift from the list for this group and click [OK].

5.4.3 Department Schedule

The department scheduling operation is the same as the group schedule. The difference is only in the
object of choice. Here we need to select the department from the list at the upper left side of the interface.

BECo Schedule Type* Normal Schedule

+ [ Department Name ~ Start Tme"

End Time

Name Number  Shift Type

Test2 2 Regular Shift

Test 1 Regular Shift

 —

Save and New “ Cancel

5.4.4 Personnel Schedule

Personnel scheduling operations are completely the same as group scheduling, but when scheduling
personnel, the object of choice is personnel at the top left corner of the interface.
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| New I
® T @
| Schedule Type® Normal Schedule Name Number  Shift Type
et The current query conditions None - = = -
endance Device . - Start Time Testi2 2 Regular Shift ‘ 5
[ New Tomporary End Time”
Test 1 Regular Shift

;) Basic Information

Personnel ID First Name: L
! |

ft

edule

Group Personne\\Dl:l Name ey Q @

The current query conditions None

Altemative Selected(0)
Personnel ID First Name Last Name Personnel 1D First Name LastName
Temporary Schedule 1
Unscheduled Personnel -
= 28
P
» 4
5} Seepton 11 50 rows per page ~

i) Caleulate Report I

5.4.5 Temporary Schedule

Temporary scheduling operation is the same as personnel scheduling. Because of some sudden changes
in the work shift for a temporary period, some personnel may be required to work in different shifts for a
temporary period. This function is used at this time to allow a temporary schedule for the personnel. The
temporary shift schedule has the highest priority in all shift schedules.

Welcome, admin

© Personnel ID Scnedule Type® Normal Schedule Name Number  Shift Type @
j  Start Time*
The current d
Afenciance Device current query condl Testn2 2 Regular Shift - o - -
End Time"
[® New Temparary S Test 1 Regular Snift I
(2) Basic Information | : 5 6 7
= Fi
. | G | GEEED
12 13 14
pesomelD ] Name Morer Q@ o | =
The current query condiitions None
Alternative Selected()
Department Schedule
Personnel ID First Name Last Name Personnel 1D First Name Last Name 19 20 27
. G | GEEED
Tempora
Unscheduled Personnel >
26 27 28
»
11 50 rows per page ~ E < =
Exception
Tl EGerE=REEl Kk < 11 b page o age ™ |\ AN AN AN 7
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Scheduling Type™ MNormal Schedule -

Start Date® 2019-12-07
End Date* 2019-12-12

Mame Number Shift Type

v TestD2 2 Regular Shift

(| 1 Reguiar Shift

Cancel

5.4.6 Unscheduled Personnel

Calculate the person who doesn’t have any scheduled.

® S m— N

. . The current query conditions Mone
Attendance Device

(% Refresh New Temporary Shift

Basic Information ] PersonnslID it Name st Name Department Name
2l shi oz Department Name

L Schedule

Group

Group Schedule
Department Schedule
Personnel Schedule

Temporary Schedule

Arranged scheduling for personnel.
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Personnel ID Schedule Type” Normal Schedule Name Number Shift Type
The current query condi ~ S2rt Time” Test02 2 Regular Shift
End Time*
(v Refresn [@ Nﬂ Test 1 Regular Shift I

sic Information

[+  Personnel ID

v

Personnel ID l:l Name More~ Q ®

The current query conditions None

Alternative Selected(0)

Personnel ID First Name Last Name Personnel ID First Name Last Name

2

1-1 50 rows per page ~

(o ns o o coer |

5.5 Exception

5.5.1 Appended Receipt

The appended receipt is used to enter records for the personnel in case the person is out on the business
trip, missing check-in/out, etc., Manual attendance record in the attendance report is called Appended
Receipt. Generally, it is entered by the management staff according to attendance results and the
company's attendance rules after the attendance cycle ends. This version does not support the approval
of exception, entered manually in the system. Data entered into the system will have an impact on the
attendance calculation results.

[G) Time From | 2018-09-25 00:00:00 | To | 2019-12-25 23:56:59 Personnel ID Name Morer Q ®)
The current query conditions Time From:(2019-09-25 00:00:00) To:(2019-12-25 23:58:59)

\ Refresh @ New ﬁj‘? Delete D’ Export

2| Attendance Device

- Personnal ID First Name Last Name Department Number Department Name Punch Time Remark Operation Time Operations

2 1 Department Name 2019-12-25 08:00:00 2019-12-2515:47:16 Delete

Business Trip
out
Overtime

Adjust And Append

Adjust Shift
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> New

1. Click [Exception] > [Appended Receipt] > [New]:

New
Punch Date” 2019-12-25 Remark
Punch Time 00 : 00 =
Personnel 1D Name Q ®
The current query conditions Mong
Alizrmative Selected(D)
Personnel ID First Name Last Name Department Personnel ID First Name Last Name Department
2 Department Man
1 Department Nan
=
=
=
=
1-2 50 rows perpage - Total of 2 records

saveanahew ] ok conce

Fields are as follows:

Punch Time: Set the date and time of punch.

Personnel: Select the required personnel for an appended receipt, multiple choices are available.
Remark: Enter the reason for an appended receipt, the max length is 50.

2. Afterfilling the information, click [OK] to save and exit, the appended receipt will be displayed in the
added list.

> Delete

1. Click [Exception] > [Appended Receipt] > [Delete]:
2. Click [OK] to delete.

> Export

You can export selected appended receipt data in Excel, PDF, and CSV file format.
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ZKTECO
Appended Receipt
Personnel ID First Name Last Name Diﬂlar:g; ?nl Department Name Punch Time Remark Operation Time
2017-12-15 08:40: 2017-12-15 16:40:
1 Jerry Wang 1 General
00 51
Development 2017-12-15 08:40: 2017-12-15 16:40:
? Lucky Tan 3 Department 00 51
2940 Sherry Yang hotel Hotel 2017_126105 08:40: 201'.’—12;15 16:40:
5 Leo Hou 4 Financial 2017-12-15 08:40: 2017-12-15 16:40:
Department 00 51
2017-12-15 08:40: 2017-12-15 16:40:
4 Berry Cao 1 General
00 51
Marketing 2017-12-15 09:50: 2017-12-15 16:51:
° Necol Ye 2 Department 00 00
. Financial 2017-12-15 09:50: 2017-12-15 16:51:
6 Amber Lin 4
Department 00 00
2017-12-15 09:50: 2017-12-15 16:51:
T Jacky Xiang 1 General 00 00

5.5.2 Leave

Personnel may need to leave at different circumstances. They can apply and the leave will be displayed

here:

@ Time From  2019-0%-25 00:00:00 To | 2019-12-25 23:59:59 Personnel ID Name

The current query conditions Tims From:(2015-09-25 00:00:00) To:(2019-12-25 23:59:59)

(% Refresh New ﬁf} Delste E Export

Attendance Device

Basic Information Persannel 1D First Name Last Name Department Number Department Name Leave Type Start Time

Shift

Schedule

Exception

Appended Log

Business Trip

QOut

Overtime

Adjust And Append

Adjust Shift

® New

1. Click [Exception] > [Leave] > [New]:
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New
Leave Type™ —_— Leave Requisition Photo Browse|
Start Time” 2019-12-25 15:50:12
End Time™ 2018-12-25 15:50:12
Remark
The current query conditions Nong
Alizrnative Selected(D)
Personnel ID First Name Last Name Department Personnel ID First Name Last Name Department
2 Department Nan
1 Department Nan
==
=
=
=
1-2 50 rows per page ~ Total of 2 records
[ o

Fields are as follows:

Leave Type: Set the type of leave.

Start Time: Start time of the leave.

End Time: End time of the leave.

Remark: Enter the reason for leave, the max length is 50.

Leave Requisition Photo: Upload photo of supporting document for the leave request.
Personnel: Select the required personnel, multiple choice is available.

2. After filling the information, click [OK] to save and exit, the leave information will be displayed in the
added list. Click [Leave Requisition Photo] at the end of each line to view the leave requisition photo.
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® Delete

—_

2. Click [OK] to delete.

® Export

. Click [Exception] > [Leave] > [Delete]:

You can export selected leave data in Excel, PDF, and CSV file format.

ZKTECO
Leave
: Department .
Personnel ID First Name Last Name Number Department Name: Leave Type Start Time End Time Remark Operation Time:
1 Jerry Wang 1 General Casual L 20177126175 16.36: 201771261?5 16:36. 2017712;1?5 16:36:
3 Leo Hou 4 Financial Mariage Leave 2017-12-1518:38: | 2017-12-15 18:38; 2017-12-15 18:38:
Department 20 48 8 53
5 Necol ve 5 Marketing Annual L 2017-12-1516:36: | 2017-12-15 16:36: 2017-12-15 16:36:
Department 19 19 27
. Financial . 2017-12-15 18:38: | 2017-12-15 18:38: 2017-12-15 18:39:
6 Amber Lin 4 Department Sick Leave 54 54 00
9 Lilian Mei 3 Development Breastfeeding 2017-12-15 18:39: | 2017-12-15 18:39: 2017-12-15 18:39:
Department Leave 02 02 10
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5.5.3 Business Trip

Time From | 2018-09-25 00:00:00 To  2018-12-25 23:58:50 Persannel ID

The current query conditions Time From:(201%-08-25 00:00:00) Tox(201%-12-25 23:58:58)

(% Refresh @ New ﬁ‘[‘} Delete L’ Export

Adtendance Device

Basic Information Personnel ID First Name Last Mame Department Number Department Name

Shift

Schedule

Exception

Appended Log

Leave

Out

Overtime

Adjust And Append

Adjust Shift

® New

1. Click [Exception] > [Business Trip] > [New]:

Start Time* 2019-12-25 16:03:18 Remark

End Time* 2019-12-25 16:03:13

Personnel 1D I:I Name Q @

The current query conditions Mong

Altzrnative Selected(D)
Personnel ID First Name Last Name Department Personnel ID First Name Last Name Department
2 Department Man

1 Department Nan

==

==

1-2 50 rows perpage - Total of 2 records
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Fields are as follows:

Personnel: Select personnel needs business, it can be multiple choices.
Start Time: Start time of the business trip.

End Time: End time of the business trip.

Remark: Enter the description of the business trip, the max length is 50.

2. Afterfilling the information, click [OK] to save and exit, the business trip information will be displayed
in the added list.

® Delete

1. Click [Exception] > [Business Trip] > [Deletel:
2. Click [OK] to delete.

® Export

You can export selected business trip data in Excel, PDF, and CSV file format.

ZKTECO
Business Trip
D rt t
Personnel ID First Name Last Name :ng:n Department Name Start Time End Time Remark Operation Time
4 Be Cao 1 General 2017-12-15 16:37: | 2017-12-15 16:37: 2017-12-15 16:37:
i 27 27 31
Marketing 2017-12-18 11:42- | 2017-12-18 11:42: 2017-12-18 11:42:
5 Necol Ye 2 Department 28 28 Go to Shenzhen 51
a Gloi Liu 5 Marketing 2017-12-18 11:42: | 2017-12-18 11:42: Go to Thailand 2017-12-18 11:43:
Department 55 55 08

5.5.4 Out

® New

1. Click [Exception] > [Out] > [New]:
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]
New
@ Time From E
The currentguy  Start Time” 2019-12-25 16:00°03 Remark
Attendance Device
(v Refresh I End Time* 2012-12-25 16:00:02 I
Basic Information O Person_ I
The current query conditions None
Alternative Selected(D)
Personnel ID First Name Last Name Department Personnel ID First Name Last Name Department
2 Department Nan

1 Department Nan

=z

=

1-2 50 rows per page - Total of 2 records
o]
n PO FN e marmaan e TA 4 N Dnmn  Tabal AP earardn

-
Fields are as follows:

Personnel: Select the required personnel, multiple choices are allowed.

Start Time: Start time of going out.

End Time: End time of going out.

Remark: Enter the description of going out, the max length is 50.

2. Afterfilling the information, click [OK] to save and exit, the go out information will be displayed in the
added list.

® Delete

1. Click [Exception] > [Out] > [Delete]:
2. Click [OK] to delete.

® Export

You can export selected go out data in Excel, PDF, CSV file format.

ZKTECO
Go Out
D rt t
Personnel ID First Name Last Name i]P:m:':n Department Name Start Time End Time Remark Operation Time
1 Jerry Wang 1 General 2017-12-18 11:43: | 2017-12-18 11:43: Visitor Client 2017-12-18 11:44:
46 46 00
7 Jacky Xiang 1 General 2017—12;;3 11:43: 2017—12;;8 11:43: Hospital 2017—12‘;;8 11:43:

5.5.5 Overtime

® New

1. Click [Exception] > [Overtime] > [New]:
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® Time From |20 New
The current qu¢
Attendance D OT Type™ Normal 0T Length of Overtime({minutes) 0
O [z I Start Time* 2019-12:25 16:12:12 Remark I
Basic Information [ | | Pemsont End Time’ 2018-12-25 16:12:12 Ee
hou

[F7L  shif |

The current query conditions None

L Schedule
Alternative Selected(D)
—g Exception Personnel ID First Name Last Name Department Personnel ID First Name Last Name Department
Appended Log 2 Depariment Nan
1 Department Nan
==
=
=
<<
Adjust And Append
Adjust Shift
1-2 50 rows perpage -  Total of 2 records

ETm I EETE

Fields are as follows:

Personnel: Select the required personnel for overtime, multiple choices are available.
OT Type: Normal OT, Weekend OT, and Holiday OT three types.

Start Time: Start time of overtime.

End Time: End time of overtime.

Remark: Enter the description of overtime, the max length is 50.

2. After filling the information, click [OK] to save and exit, the overtime information will be displayed in
the added list.

® Delete

1. Click [Exception] > [Overtime] > [Delete]:
2. Click [OK] to delete.

® Export

You can export selected overtime data in Excel, PDF, and CSV file format.

ZKTECO
Overtime
Department 5
Personnel ID First Name Last Name R Department Name OT Type Start Time End Time Remark Operation Time
Financial 2017-12-15 1637 | 2017-12-15 16237 2017-12-15 16237:
3 Leo Hou 4 Department Normal OT a4 2 a7
Marketing 2017-12-18 11:44: | 2017-12-18 11:44: _ 2017-12-18 11:44:
5 Necol Ye 2 Department Normal OT 03 0 Finish Project 28

5.5.6 Adjust and Append

® New

1. Click [Exception] > [Adjust and Append] > [New]:
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® Time From |2( New
_ The current qu;
Attendance Device Adjust Type® Adjust Rest Remark
O RefiEsn Adjust Date”™ 2018-12-25 I
Basic Information O Persnn; H
Ei) shift Personnel ID l:l Name CL @
Schedule The current guery conditions None
Aliernative Selected(D)
) Exception Personnel ID First Name Last Name Department Personnel ID First Name Last Name Department
Appended Log 2 Department Nan
1 Department Nan
=
=
<
P
Qvertime
Adjust Shift
1-2 50 rows per page - Total of 2 records

oo o row B0 J~corca ]

Fields are as follows:
Personnel: Select the required personnel, multiple choices are available.

Adjust Type: Select from Adjust Rest and Append Attendance. Adjust Rest is when you are on a shift, but
you want to rest; Append attendance is the opposite

Adjust Date: The date and time of adjustment.

Append Attendance Shift: When the adjust type is Append Attendance, it is necessary to select the
corresponding shift.

Remark: Enter the reason to adjusting and append the max length is 50.

2. After filling the information, click [OK] to save and exit, the adjust and append information will be
displayed in the added list.

® Delete

1. Click [Exception] > [Adjust and Append] > [Delete]:
2. Click [OK] to delete.

® Export

You can export selected adjust and append data in Excel, PDF, CSV file format.

ZKTECO
Adjust and Append
Department - . ]
Personnel ID First Name Last Name R Department Name Adjust Type Adjust Date Schedule Name Remark Operation Time
‘Append ! 2017-12-16 1354
1 Jei wan, 1 General 2017-12-18 Day Shift 123

i 9 Alttendance i 54
Development Append 2017-12-16 13.55:

2 Lucky Tan 3 Depertment A e 20171218 Flexitle 456 o
9 Lilian Mei 3 Development Adjust Rest 2017-12-18 adgustrest | 20171218 11:450

Depariment 02
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5.5.7 Adjust Shift
® New
1. Click [Exception] > [Adjust Shift] > [New]:

® Time From |2019-09-25 00:00:00 | To |2019-12-25 23:50:50 Personne! ID | Name| More

. N The current query conditions Time From:(2012-08-25 00.00:00) To:(2018-12-25 23.52.59)
3| Attendance Device

(v Refresh [ ® New (i Delete [# Export

Basic Information O Personnel ID FirstName LastMame @ Department Number Depariment Name Adjust Type Adjust Date Personnel ID Adju

New
. Schedule
: Adjust Type Adjust the personal shif
Exception Personnel ID* l:l
- First Name
Appended Log Department Name
Leave Adjust Date® 20181225 Original Schedule Name | ceeees
Remark

Business Trip

Out

Overtime

Adjust And Append

Adjust Type is divided into three shifts:

Adjust the personnel shift on the same day: It will adjust one personnel’s shift on the same day.
Adjust the personnel shift in other days: It will adjust one personnel’s shift in different days.
Two-people exchange: It will exchange shifts of two people on different days.

Adjust the personnel shift on the same day:

New
Adjust Type Adjust the personal shif
Personnel ID*
First Name
Departrment Names
Adjust Date” 2015-12-25 Original Schedule Mame | e

Remark

Personnel ID: The max length is 32. (Fill the correct ID. After you enter the ID and click on the next field,

the Name and Department are automatically filled.)

First Name: Obtained automatically based on Personnel ID.
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Department Name: Obtained automatically based on Personnel ID.
Adjust Date: The date and time of adjustment.

Remark: Enter the description of adjusting shift, the max length is 50.

3. Afterfilling in the information, click [OK] to save and exit, the adjust shift information will be displayed

in the added list.

B. Adjustthe personnel shift in other days:

Remark

MNew
Adjust Type Adjust the personal shif
Personnal ID°
First Mame
Department Mame
Adjust Date” 2019-12-25 Adjust Date 201%-12-25

Personnel ID: The max length is 32. (Fill the correct ID; after you enter the ID and click on the next field,

the Name and Department are automatically filled.)

First Name: Obtained automatically based on Personnel ID.
Department Name: Obtained automatically based on Personnel ID.
Adjust Date: The date and time of adjustment.

Adjust Date: The date and time of adjustment.

Remark: Enter the description for the shift, the max length is 50.

After filling the information, click [OK] to save and exit, the adjust shift information will be displayed in the

added list.

C. Two people exchange:

New
Adjust Type Twao people exchange
Personnel 107 Adjust Personnel 1ID*
First Name Adjust Personnel Mame
Department Name Adjust Departmeant Name
Adjust Date” 2019-12-25 Adjust Date
Remark

2019-12-25

Personnel ID: The max length is 32. (Fill the correct ID; after you enter the ID and click on the next field,

Page [129 Copyright©2020 ZKTECO CO,, LTD. All rights reserved.



ZKBio Access IVS

User Manual

the Name and Department are automatically filled.)

First Name: Obtained automatically based on Personnel ID.

Department Name: Obtained automatically based on Personnel ID.

Adjust Personnel ID: ID number of the adjust personnel. The max length is 32. (Fill the correct ID; after you

enter the ID and click on the next field, the Name and Department are automatically filled.)

Adjust Personnel Name: Obtained automatically based on Personnel ID.

Adjust Department Name: Obtained automatically based on Personnel ID.

® Export

You can export selected adjust shift data in Excel, PDF, CSV file format.

ZKTECO
Adjust Shift
Deparment ~ ‘Adjust Personnel | Adjust Persornel | Department ~ ~
Personnel ID First Name Last Name e Department Name | Adiust Type Adjust Date Personnel ID s e = Department Name | Adjust Date Remark Operation Time
Financal | Agust the personal 2017-12-18 1358
3 Leo Hou 4 Deparment | shitincerams | 20171218 2017-12-18 o
‘Rgjustthe persanal )
4 Bery Cao 1 General shift in the same 20171218 Change to flexitle 2DTFAZAE 1400
day
Marketing Two people Marketing 2017-12-18 14:02
5 Mecol Ye 2 Department exchange 20171218 B Glori Liu 2 Depariment 2017-12-18 exchange 21
5.6 Calculate Report
5.6.1 Manual Calculate
@ Personnel ID ‘ | Name‘ | Q ®
. . The current query conditions None
2| Attendance Device
[F) [=] | /Subordinate Level (% Refresh Atendance Calculation
i) Basic Information -
Department Name
D P 4 Personnel ID First Name Last Name Department Number Department Name
WM 2 1 Department Name
= |1 Aftendance Calculation Depart Name
Schedule
s Start Time* 2019-10-26 00:00:00
End Time* 2019-12-25 23:50:50
Exception
Pl Including resigned personnel Yes @ No
Calculate Report
Transactions
iy
Daily Attendance -
Atiendance Calculation
Leave Summary
Daily Report
K < 12 3 3 50rows perpage ~ JumpTo 1 /1Page  Tofal of 2 records

Attendance calculation can be done by selecting the department on the left department hierarchy or by

selecting the right person. If both are selected, they are overwritten. After selecting the personnel click

attendance calculation, a confirmation box will pop-up.
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Processing command

Total Prograss

e

'I-'h.e ﬂl-tréﬁﬂ-n-cnéndition is ready!
Initialization of database completel

The window will close after 1 second(s). Suspend Close

5.6.2 Transaction

Attendance records of all employees will be displayed on this interface, including the attendance record
of uploaded attendance transactions. The record of the normal punch on the device will be uploaded to
the software as the original record. When a particular data is selected, the details will be displayed on the
right side of the page.

[G) Time From | 2019-09-2500:0000  To |2019-12-2523:59:59 Personnel ID Name vorer Q@

The current query conditions Time From:(2019-06-25 00-00:00) To:(2018-12-25 23:59:59)

[E]] Attendance Device

(% Refresh [ Import access control record [ # Import U disk record [ Export Attendance Details
(&) Basic Information - Atengance Photo
e Department Name Personnel ID  FirstName LastName Department Department Attendance Serial Device Name: Attendance Date Data
umoer Name Area Number Sources
2 Testo2 1 Depariment Name Area Name BYUJ 180860 BYUJ180660001  2019-12:25 16:19:19  Time Afte
1 Test 1 Department Name Area Name BYUJ18DB6( BYUJ180660001  2018-12-25 16:1854  Time Alte
E Calculate Report
Personnel ID 1
Manual Calculate First Name: Test
Department
g Do Department Name
Attendance Date  2019-12-25 16:18:54
Serial Number BYUJ180660001
Daily Attendance
Leave Summary
Daily Report
Monthly Detail Report
Monthly Statistical Report(By
Person)
Deparimental Report(By
Depariment)
Annual Report(By Person) »
12 S0rowsperpage v JumpTo 1 1Page  Total of 2 recorcs

® Import Attendance record

The attendance time records can be imported into attendance records through this function. Select the
start time and end time to import, check the attendance point list and click OK.
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Start Time: 2019-12-25 00:00:00
End Time 2019-12-25 23:5%:55
Aftendance Point List Flease select the attendan

OK

Cancel

Attendance point list: Only the device which is set in Attendance Point under [Basic information]

[Attendance point], will be listed here.

Aftendance Point Mame |

The current query conditions None

Alternative

Serial Deavice Name

Mumber

Aftendance
Point Name

£ < ] S |

Selected(D)
Attendance  Serial
Point Name  Number

==

e

50 rows per page -

Device Name

® Import Udiskrecord

Users can import device data to the transaction table through U disk.
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file format @ dat
Select File EEEEATE

Imported file name format requirements: device serial number
begins with and is separated by an underscore ™_", for
example: "3517171600001_attlog.dat’,

Cancel

® Export

It will export the attendance record data. Currently, it can be exported either in three types of file EXCEL /
PDF / CSV. You can also choose the amount of data to be exported or select the maximum amount which
supports up to 40,000 records.

The File Type | EXCEL File v

Export Mode (@) All data (Can export up to 40000 data)
() Select the amount of data to export (Can export up to 40000 data)
From the article 1 Strip, is derived 100 ‘Data

ZKTECO
Transactions
Department Device Seral Attendance
Personnel ID First Mame Last Mame Number Department Mame Number Attendance Area —— Data Sources
5 Glori Lin 2 Marketing 20100501008 Ares Name 2017-12-15 16:23: Access Ccmtrcl
Department 12 Device
. - Marketing 2017-12-15 16:23: Access Control
& Glor Li 2 20100501909 Area M.
o Department = teme 14 Device
2017-12-15 16:23: Access Control
2040 Sherry Yang hatel Hatel 20100501963 Area Mame ==
18 Device
2017-12-15 16:23: Access Control
T Jacky Xiang 1 Gemeral 20100501989 Area Mame 20 Dieice
2017-12-15 16:23: Access Control
T Jacky Xiang 1 Gemeral 20100501989 Area Mame 21 Dieice
° Lilian Mei a3 Development 20100501008 Ares Name 2017-12-15 16:23: Access Ccmtrcl
Department 23 Device
2017-12-15 16:23: Access Control
1 Jemy Wang 1 Gemeral 20100501989 Area Mame a7 Device
2017-12-15 16:23: Access Control
1 Jemy Wang 1 Gemeral 20100501989 Area Mame 25 Dieice
2017-12-15 16:23: Access Control
1 W 1 General 20100501909 Area M.
Jemy ang e a Mame 24 Dieice
2 Tan a3 Development 20100501008 Ares Name 2017-12-15 16:23: Access Ccmtrcl
Department 42 Device
2 Tan a3 Development 20100501008 Ares Name 2017-12-15 16:23: Access Ccmtrcl
Department 43 Device
Development 2017-12-15 16:23: Access Control
2 Lucky Tan 3 D ent 20100501909 Area Mame 51 Device
Development 2017-12-15 16:23: Access Control
2 Lucky Tan 3 D 20100501909 Area Mame 50 Dieice
Development 2017-12-15 18:34: Access Control
2 Lucky Tan 3 D 20100501909 Area Mame 0 Dieice
2017-12-15 16:24: Access Control
1 Jemy Wang 1 Gemeral 20100501989 Area Mame 03 Dewice
2017-12-15 16:24: Access Control
1 W 1 General 20100501909 Area M.
Jemy ang e a Mame 04 Device
2017-12-15 16:24: Access Control
1 Jemy Wang 1 Gemeral 20100501989 Area Mame 05 Device
1 Jemy Wang 1 General 20100501909 Area Mame 2017-12-15 168:34: | Access Control

Created on: 2097-12-45 18:38:47

[E]
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5.6.3 Daily Attendance

The table shows personnel’s daily attendance status, punch time, the early leaving time, the latest time,

and the detailed punch time during the selected period.

[G) Time From | 2012-02-2500:0000  To | 2019-12:25 23:59:59 Personnel ID Department Name vorer Q@

The current query conditions Time From:(2019-08-25 00:00:00) Tox(2018-12-25 23:59:59)
[E]] Attendance Device )

(O Refresh  [# Export

() Basic Information ) Degarment Name

Personnel ID First Name Last Name Department Number Department Name Record Date Record Times Earliest Time Latest Time

[E2, st )
=07 - 1 Test 1 Department Name 2019-12-25 1 16:18:54 16:13:54

2 Test02 1 Depariment Name 2018-12-25 1 16:12:19 16:18:19

[Z Schedule

@ Exception
E Calculate Report

Manual Calculate

Transactions

Leave Summary
Daily Report

Monthly Detail Report
Monthly Statistical Report{By
Person)

Deparimental Report(By
Depariment)

Annual Repori(By Person)
12 50 rows per page ~ JumpTo 1 11 Page Total of 2 records.

® Export
It will export the daily attendance record data. Currently, it can be exported either in three types of file
EXCEL / PDF / CSV. You can also choose the amount of data to be exported or select the maximum amount

which supports up to 40,000 records.

Export

The File Typs EXCEL File T
Export Mode = All Data (export up to 30000 pieces of data)

Select data volume export (export up to 30000 pieces of data)

From the article 1 Sirip, is derived 100 Data
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ZKTECO
Daily Attendance

Department

Personnel ID First Name Last Mame
Number

Department Name Record Date Record Times Earliest Time Latest Time Punch Time

16:33:27;16:33:29;
16:33:34;16:34:03;
16:34:04;16:34:05;
16:34:08:18:35:02;
16:35:03;17:35:25;
17:35:28,17:42:50;
17:42:51,17:42:52;
17:58:48;17:58:50;
18:04:44,18:04:45;
18:22:20;18:22:21;
18:23:12;18:23:18;
18:23:18;18:23:18;
18:23:36,18:23:37;
18:23:52;18:24:50;
18:25:00:18:25:13;
18:25:14;18:28:34;
18:28:3518:28:37;
18:28:38;
16:33:42;16:33:43;
16:33:51;16:33:58;
16:34:00:18:35:05;
16:35:08:17:35:3%;
17:42:4717:42:48;
17:50:03;17:50:04:
2017-12-18 26 16:33:42 18:28:56 17:50:38;17:50:30;
18:04:58;18:05:00;
12:05:07;18:05:08;
12:09:35;18:08:38;
18:23:00:18:23:01;
18:23:02;18:28:53;
18:28:55;18:28:56;
16:33:16,16:34:08;
16:34:10;16:35:08;
16:35:08;17:35:18;
17:43:01:17:43:02,

1 Jemy Wang 1 General 2017-12-15 35 16:33:27 18:28:38

Development

2 Lucky Tan 3 Department

2040 Shemy ‘Yang haotel Hotel 2017-12-15 17 18:33:18 18:28:23

Created on: 2047-12-15 18:38:31

Crested from ZKEicSecurty sofware. Al rights reserved. k)

5.6.4 Leave Summary

The report summarizes the valid time for all valid leave records, leave type, within the selected date range.
Select the time range from which you want to view the leave record.

@© Time From |2010-08-2500:0000 | To | 2016-12:25 23.50:50 Fersonnel ID Department Name voer Q &

The current query conditions Time From:(2013-09-25 00-00:00) To:(2019-12-25 23:59:59)

|‘i"‘ Attendance Device

(» Refresn [ Export
(&) Basic Information ) Department Name
= P Personnel ID First Name LastName ~ DepartmentNumoer  Department Name Casual  Mamage Matemiy  Sick Amnual  Bereaveme Home
leave  leave  Lleave  leave  leave  Lleave  Leave

Schedule

Exception

Caleulate Report

Manual Calculate
Transactions
Daily Attendance

Lea

Click on the leave type number, as shown above, a pop-up window shows the person within the search
time frame, leave details of the type, including personnel number, name of the person, type of leave, leave
start time, leave end time.

® Export

It will export the leave summary data. Currently, it can be exported either in three types of file EXCEL / PDF
/ CSV. You can also choose the amount of data to be exported or select the maximum amount which
supports up to 40,000 records.
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Expaort

The File Type EXCEL Fil v
Export Mode % All Data (export up to 30000 pieces of data)

Select data volume export (export up to 30000 pieces of data)

From the article 1 Sirip, is derived 100 Data

o oo

ZKTECO

Leave Summary

Personmel 1D First Hame Last Mame DL Department Mame Lea.w_a 'I:yp-e
Mumibser Statistics
Casual Leave(1)
Mammiage Leave(D)
Matemity Leave(0)
Sick Leave(d)
Annual Leave()
Bereavement
Laawe(0)
Breastfeading
Leave(D) Custom
0

Casual Leave(d)
Mammiage Leave(D)
Matemity Leave(0)

Sick Leave(d)

Marketing Annual Leave(1)

Department Bereavement
Laawe(0)
Breastfeeding
Leave(D) Custom
(0)

Casual Leave(D)
Marriage Leave(D)
Matemity Leave(0)

Sick Leave(d)
Development Annual Leave(0)
Department Bereavement
Laawe(0)

Breastfeading
Leaws(1) Custom

(0)
Casual Leave(l)
) Finangial I'u'lam'ag_;e Leave(1)
3 Lea How 4 Department Matemity Leave(0)
Sick Leave(d)
Annual Leave(D)

1 Jemy Wang 1 Semeral

5 Mecol e 2

g Lilian Mei 3

Creafed on: 2097-12-15 12:39:22

Creafed from ZK BloSeourty sotware. All rights reserved. 2

5.6.5 Daily Report

This function is used to get the daily report within the specified range of date and time attendance details
of personnel, including attendance, late arrival, early leaving, overtime and so on.
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Time From | 2018-08-25 00:00:00 | To |2018-12-25 23:50:50 Personnel ID | Department Name vorer Q@
_ The current query conditions Time From:(2018-05-25 00:00:00) To:(2019-12-25 23:59:59)
i Attendance Device
(v Refresh  [# Export
Basic Information I Department Name
P Personnel Depariment Aftendance  We Shift Information Punch Punch  Atiendance (minutes) Overtime (mint
Date Time Count
Shift - [} First LastName Number  Name Number  Name Work on/off Should  Actual  Valid Weekday W
Name Time
1 Test 1 Department 2018-10-25  Fr
=, Schedule
~ 1 Test 1 Department 2018-10-26  Sa
Bl Excepion 1 Test 1 Department 2018-10-27  Su
1 Test 1 Department 2019-10-28 Mo
Calculate Report 1 Test 1 Department 2018-10-28  Tu
1 Test 1 Department 2018-10-30  We
Manual Calculate
o1 Test 1 Department 2018-10-31  Th
Transactions h
1 Test 1 Department 2018-11-01  Fr
Daily Attendance 1 Test 1 Department 2019-11-02  Sa
lemm STy 1 Test 1 Department 2018-11-03  Su
. 1 Test 1 Department 2018-11-04 Mo
1 Test 1 Department 2018-11-05  Tu
Monthly Detail Report
° 1 Test 1 Department 2018-11-06  We
Monthly Statistical Report(By
Person) 1 Test 1 Department 2018-11-07  Th
Departmental Report(By 1 Test 1 Department 2018-11-08  Fr
Department)
1 Tast 1 Nanartmant IN10-11.00  Qa M
Annual Report(By Person) »
150 > 31 SDrowsperpage ~ JumpTo 1 13Page  Total of 124 records

® Export

It will export the Daily report data. Currently, it can be exported either in three types of file EXCEL / PDF /
CSV. You can also choose the amount of data to be exported or select the maximum amount which
supports up to 40,000 records.

Export

The File Type EXCEL File v
Export Mode # All Data {export up to 30000 pieces of daia)

Select data volume export (export up to 30000 pieces of data)

From the article 1 Sirip, is derived 100 Dala

ZxrEco
[
pre—— = =y [E———
= T =Ty = i ) L) der——y = e = = T i3 =Ty
) E) ) o ) T T o e o
0 =3 = e £ m o 0 3 <
3 Loty - s = o o B
oy = = £ = T =
e = = Ey = = o 3

5.6.6 Monthly Detail Report

This function will automatically give the report for a selected month on a daily basis. The report includes
attendance status and characters, and summarizes the actual attendance time, absence, leave, business
trips and outings in the month.

Page |137 Copyright©2020 ZKTECO CO,, LTD. All rights reserved.



ZKBio Access IVS User Manual

® Statistics of Month | 2018-12 Personnel ID Department Name vorer Q@

The current query conditions Statistics of Month:(2018-12)
[Ei] Attendance Device

(C+ Refresn [ Export
(i) Basic Information

Department Name Personnel D First Name Last Name: Department Number DepartmentName ~ 1st 2nd 3rd 4th 5th 6th 7th Sth Sth 108 11t 120 138 148 158 168 174 1

2 1 DepartmentName NS NS NS NS NS NS NS NS NS NS NS NS NS NS NS NS NS NS

1 1 DepamentName R @ © o o © o © o @ © 8 o R R o =@

Eu Exception

E Calculate Report

Manual Calculate
Transactions
Daily Attendance
Leave Summary

Daily Report

Monthly Statistical Report(By
Person)

Deparimental Report(By
Department)

Annual Report(By Person) Expected/Actual - ¥ Late-L Early-E Absent-o NoGheck-n-[ No Check-Out-] Leave -A Overtime-+ AdjustRest-c Append Aftendance - e Business Trip-T Out-G

12 SDrowsperpage v  JumpTo 1 /1 Page  Total of 2 records

The attendance status is displayed as per the following priority at the bottom of the interface:

Expected/Actual « V' Late r = Early = Absent :o No Check-in : [ No Check-out :] Leave : Q) Owverfime : + Adjust Rest : o Append Aftendance

® Export

It will export the Monthly Detail Report data. Currently, it can be exported either in three types of file EXCEL
/ PDF / CSV. You can also choose the amount of data to be exported or select the maximum amount which

supports up to 40,000 records.
Export

The File Type EXCEL File v
Export Mode ® All Data (export up to 30000 pieces of data)

Select data volume export (export up to 30000 pieces of data)

From the article 1 Sirip, is derived 100 Daia

elefe|e[z]¢]
elefefe[e]e]

wfefefefe] e
wfefefefe] e
wfefefefe] e

elefefefe]e]

g
f
elefe]ee]e
elefe[eee
elefe[es]e
Hele|efe]e]s

5.6.7 Monthly Statistical Report

This function will give details for a selected month. The details include personnel attendance summary

status and detailed information, including attendance, late, leaving early, etc.
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® Statisties of Montn | 2019-12 PesomelD| | Cepanmentiame vorer Q. ®

y The current query conditions Statistics of Month:(2018-12)
[S}] Attendance Device

(v Refresn [ Expon

(&) Basic Information [} Department Name

Personnel Depariment Aftendance (hour) Aftendance (day) Late Early Overtime (he

D First LastName Number  Name Should  Actual  Valid Should  Actual  Vaid Duration  Times Duration ~ Times  Weekday
Name (minutes) (minutes)

. 2 Test02 1 Department 0.0 00 0.0 0.0 0o 0.0 o o 0 0 0.0
B, schedule @

1 Test 1 Department 162.0 00 00 200 00 00 0 0 0 0 0.0

[5) Bxception
ﬁ Calculate Report

Manual Calculate
Transactions
Daily Attendance
Leave Summary

Daily Report

Monthly Detail Report

[ e
Department)

Annual Report(By Person)

12 S0rowsperpage ~ JumpTo 1 {1Page  Total of 2 records
® Export

It will export the Monthly Statistical Report data. Currently, it can be exported either in three types of file
EXCEL / PDF / CSV. You can also choose the amount of data to be exported or select the maximum amount
which supports up to 40,000 records.

Export

The File Type EXCEL File T
Export Mode = All Data (export up to 30000 pieces of data)
Select data volume export (export up to 30000 pieces of data)

From the article 1 Sirip, is derived 100 Data
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5.6.8 Departmental Report

Select the date to get the detail record of all departments. Details include details of all personnel in the
department, attendance, late, leaving early, and so on.
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© Statistics of Month | 2019-12

The current query conditions Statistics of Monih(2018-12)
2| Attendance Device

(O Refresh [ Export

) Basic Information [ Department Name

Shift - Number  Name Should

1 Department 162.0
Schedule

EIE

Calculate Report

Manual Calculate
Transactions
Daily Attendance
Leave Summary
Daily Report

Monthly Detail Report

Monthly Statistical Report{By
Person)

Annual Report(By Person)

® Export

Department Aftendance (hour)

Actual Valid

0.0 00

Department Name || Q ®

Attendance (day)

Should Actual

Vali

Late

d Duration  Times
(minutes)

0 0

11 SDrowsperpage - JumpTo 1 M Page  Total of 1 records

Early

Duration  Times
(minutes)

0 0

Overtime (hour)

Weekday ~‘Weekend Holiday  Total

It will export the Departmental Report data. Currently, it can be exported either in three types of file EXCEL

/ PDF / CSV. You can also choose the amount of data to be exported or select the maximum amount which

supports up to 40,000 records.

Export

The File Type EXCEL File ¥

Export Mode

= All Data (export up to 30000 pieces of data)

Select data volume export (export up to 30000 pieces of data)

From the article 1 Sirip, is derived 100 Data
canco
Z0TECO
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5.6.9 Annual Report

This function will give details for a selected Year. The details include personnel attendance summary status

and detailed information, including attendance, late, leaving early, etc.
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[G) Statistics of Year 2019 PesomeliD[| | DepartmentName vorer Q. ®

The current query conditions Statistics of Year(2013)

‘I’ﬂl Attendance Device

(O Refresh  [# Export
(@) Basic Information 1 Department N
= epartment Rame Personnel Department Attendance {hour) Attendance (day) Late Early Overtime (ho
D First LastName Number Name  Shoud  Actual  Valid Shoud  Actual  Valid Duraton  Times  Duraon = Times  Weskday
Name (minutes) (minutes)
2 Testoz 1 Department 0.0 00 00 0.0 00 00 0 0 0 0 00
1 Test 1 Department 1620 0.0 00 200 00 0o 0 0 0 0 0o

E Calculate Report
Manual Calculate
Transactions
Daily Attendance:
Leave Summary
Daily Report
Monthly Detail Report
Monthly Statistical Repori(By
Person)
Departmental Report(By
Depariment)

,
12 s0rowsperpage ~  umpTo 1 1 Page  Tolal of 2 records

® Export

It will export the Annual Report data. Currently, it can be exported either in three types of file EXCEL / PDF
/ CSV. You can also choose the amount of data to be exported or select the maximum amount which
supports up to 40,000 records.

Export

The File Type EXCEL File T
Export Mode = All Data (export up to 30000 pieces of data)
Select data volume export (export up to 30000 pieces of data)

From the article 1 Sirip, is derived 100 Data
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6 VMS

VMS function and VMS Plugin (client program) are software application functions based on the video
service launched by ZKTeco. It can be used with Digital Video Recorder (DVR), Network Video Recorder
(NVR), Network Camera or IPC, Network Storage Devices, and more. It supports multiple functions such as
device management, preview, playback, event reception, decoding management, video alarm, log query,
and access control video linkage.

It provides flexible and diverse deployment solutions to meet the needs of various environments in small
and medium-sized projects.

6.1 Installation

Install the VMS Client

*  Please choose to install the VMS module during the installation of ZKBio Access.

*  There are two versions of the VMS client program, MySQL, and SQLite. There is no difference in use.
Please choose any one to install.

& ZKBioVMSPlugin_sqlite.exe
@ ZKBioVMS5Plugin_mysqgl.exe

6.1.1 VMS Client Configuration

After the installation of VMS client, double-click to open the client application.
» Configure the Client Server

On the Login page, click [Choose site], and then click [Site management] to go to the site configuration
page.

@ZKBiO VMS Plugin

admin

Ii
> H
[J Remember d [ Auto login
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Setting the Server Information on Site Management:

* Name: Enter the site name or the arbitrary name.

* IP address: Enter the Server address. If the client and server are on the same computer, the address
can be filled in as 127.0.0.1.

*  Port: Enter the port number as 5252.

Site list

No. o Name

Leo

» Login to the VMS Client
*  After setting the Server information you can login to the VMS Client.

* Thelogin Username and Password of the VMS client are the same as that of the VMS server.

@ZKB'O VMS Plugin

admin €) User Name

L

s csesseee e Password

English v

] Remember ar L Auto login
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» Login to the VMS Server- ZKBio Access VMS Module

*  Enter the server's IP address and port number in the web browser address bar to access ZKBio Access
VMS module.

* Onthe Login page, enter the username and password to go to the VMS module.

) Access Vs

User Login

Forget Password?

*  On the VMS module of ZKBio Access, click the [Video] icon to go to the VMS module management
interface.

Device Name l:l Serial Number More~ O\ ®

. The current query conditions MNone
e Video Device

(_* Refresh E.j Mew @ Delete Q Seach .4 Equipmenttiming % Enable @ Disable

Device Name Serial Number Area Mame IP Address Port Protocol Type Device Model Status Enable Operations
Video Channel

192.168.214 253 OB1101237AD10DB3E712 Mom de zone 192.168.214.253 80 ZKTeco NVR Al Cnline L] Edit Delste

192.168.214.160 OBCD012340CESE053979 Mom de zone 192.163.214.160 80 ZKTeco NVR Al Edit Delete

a3 Decoding

7]
& Face Recognition
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6.2 VMS Management

6.2.1 Video Device

On the VMS module, click [Video Device] to go to the Video Device module.
» Add aVideo Device
On the Video Device module, click [Video Device], and then click [New] to manually add the video device.

Fill in the relevant fields with the corresponding values:

Host Address: Enter the IP address of your system.

IP Port: Enter the Port number.

Device Name: Enter the Device Name.

Username: Enter the Username.

Password: Enter a unique password.

Area Name: Select the Area name from the drop-down list.

Protocol Type: Select the protocol from the drop-down list for transmitting the data.

Click [OK] to add the device.

Mew

|P Address®
Port® 80
Device Name™
Username®
Password
Area Name* Area Name
Protocol Type® OMNVIF

ok
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Search and Add Video Device

On the Video Device interface, click [Search Device] to search and add the Video Device.

On the Search Device window, click the [Search button] on the upper left corner and it will list the search
results.

During the search process the device with “ONVIF” protocol type will not display the serial number, and
it can be viewed only after adding the device.

m W Welcome, admin

@ Device N Search Device
S ~ The curre
[ | Video Device
o Rent I
| Total Progress Searched devices count:4 F
D¢ Jerations.
Video Channel | |
IP Address Protocol Type | ——— v
IP Address Communication  Protocol Type Serial Number Cperations
port
192.168.214.170 80 ZKTeco OBD3012366AECFS31ED2 Add
192.168.214.197 80 ZKTeco 0BD3012317EB3BBBASS7 Add
==y Decoding 192168 214 224 20 ONVIF Add
192.168.214.245 80 ONVIF Add
Face Recognition
[®] Real-Time Monitoring
-
Record
Report
M- Linkage Management
Connection Management K < 0 P S0rowsperpage ~ JumpTo 1 /0 Page  Total of 0 records

On the Search list, the Add operation will not be available for the devices that have been already added.
On the Search list, click [Add] to add the required devices.

On the New window, enter the Username and the Password.
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IP Address* |192_158_214_1?D

Port™ | a0

Device Name™ | 192.168.214.170

Username® |

Password |

Area Name® |Area Name

Protocol Type® | ZKTeco

Cancel

& Note: On the New window the other information (Host address, IP Port, Device Name, Area Name, and the
Protocol Type) will get automatically updated by the software.

Equipment Timing

On the Video Device interface, click [Equipment timing] to set the timing.

On the Equipment timing window, you can either select the Manual calibration and set the time or can
select the Automatic timing.

Manual calibration

(") Automatic timing

Calibration time |D - |hour|[] - |minule|[] - |second

Regular calibration interval Day
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» Video Channel

On the Video Device module, click [Video Channel] to go to the Video Channel interface.

Enable / Disable Channel

On the Video Channel interface, you can edit the channel name, and enable or disable the required video

channel.

® cewenane| | Chmeten| | metew B

The current querv conditions ;Jone
1

¢ Video Device
(v Refresh ~/ Enable (/) Disable
Video Device ) .
Channel Name Channel Area Name Device Name Serial Number
Number
|pCamera 1 | 3 Edit |ECF531EDZ
Channel Name™® IpCamera

Device Name™
Channel Number*

Channel Status’

f=my Decoding

e~

6.2.2 Decoding

The decoder can transmit the video images to the screen, which is used to set the TV wall and other such
features.

On the Video module, click [Decoding] to go the Decoding module.

> Decoder

On the Decoding module, click [Decoder] to go to the Decoder interface.

Add a new Decoder

On the Decoder interface, click [New] or [Search Device] to add a new decoder.
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2
(v Refresh  [® New (i Delete Q) Search Device

O Serial Number Decoder Name IP Address Port Status

Search Device

™% Decoding

Total Progress | O | S¢:rched devices count

Decoder Grouping

TV Wall IP Address
der Preview Settin IP Address Communication  Serial Number Operations
port
Jecoder Preview Play
192.168.214.249 5050 014D012373B812BEOSSE Add

ognition

» Decoder Grouping
The grouping of Decoder can be set for different video channels.
On the Decoding module, click [Decoder Grouping] to group the decoder.

The left side of the Decoder Grouping interface displays the Group list and the right side of the interface
displays the video channel corresponding to the group.

Welcome, admin  50¢
ZKTzco ‘

@ Decoder Grouping

Test Bound channel :

[0 video Device GroupNzme Q ® Channel Name Q ®
The current query conditions None The current query conditions None
™% Decoding DBl (- Refresh [© I&ew [} Delete (_+ Refresh > Delete
Decoder GroupName ~ Operations Channel Name Device Name Channel Devise Serial Number  Pause Time Operations
) Number
De ping Test LED GEEEE) IpCamera 192168214170 1 0BD3012366AECF531ED2 20 Delete

TV Wall

Decoder Preview Settings

Decoder Preview Play

Add a New Decoder Group

On the Decoder Grouping interface, click [New] to add a new decoder group.

On the New window, enter the group name.
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ZK
®

[k Video Device

@™h Decoding

Decoder

™V Wall
Decoder Preview Settings
Decoder Preview Play

Face Recognition

Real-Time Monitoring

Record

Report

Add Channel:

Decoder Grouping

GroupName‘ | Q ®

The current query conditions None
1

(+ Refresh [ @ New [} Delete

GroupMame Operations
Test Delete Add Channel
Mew
GroupMame* Hello

2

Test Bound cha

Channel Name

The current quer
(v Refresh

Channel

lpCamera

Csoveanavow o< W oo

Click [Add Channel] to add a video channel to the decoder group.

On the Add Channel window, select the video channel to be added to the group from the list on the left

side of the window.
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The selected video channel will be reflected on the right side of the window.

Add Channel
Channel Name Device Name Pause Time |20 Q ®
The current query conditions None
Alternative Selected(0)
Channel Name Device Name Channel Name Device Name
IpCamera 192.168.214.170
==
>
<
<
1-1 50 rows perpage ~  Total of 1 records
» TV Wall

The TV wall is used for setting the size of the video display that is joined together by the display screen. It
can be added, edited, enabled, or disabled in the TV Wall menu.

On the Decoding module, click [TV Wall] to go to the TV Wall interface.

@ (+ Refresh Eﬁ New

|:}:] Video Device s ™ Wall Name Enable Descrption Operations

Test [/] Test Edit Delete Enable Disable

@™ Decoding

Decoder

Decoder Grouping

Decoder Preview Settings

Decoder Preview Play
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Add a new TV Wall Settings:

1. Onthe TV Wall interface, click [New] to add new TV wall settings.

2. Fillin a unique name for the TV wall, where the names cannot be changed once saved.

3. Set the Matrix (here, the matrix refers to the number of rows and columns of the TV wall).
4, Add adescription for the TV wall.

5.  Click [Next] Step to go to the next setting.

Edit

TV Wall Name :

{The TV wall name cannot be modified after it
is saved)

Test A 1

Matrix 4 X4 2 m

TV Wall Description :
Test A 3

4

On this Next window, perform the below action to set the TV Wall.

*  Click the required (D screen from the matrix on the right side of the window, then select a 2) decoder
to be displayed, and then click 3® [Complete] to update the TV Wall settings.
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Edt
— ~ i X A
= Decoder Channel List 1
245 Decoder
249 Decoder-1
247 Decoder 189 Decoder-1 249 Decoder-1
47 Decoder-1
164 Decoder
162 Decoder-1
X
24T Decoder-1
3
Proso ic

» Decoder Preview Settings

The Decoder Preview settings facilitates in setting up the video preview screen.

On the Decoding module, click [Decoder Preview Settings] to go to the Decoder Preview Settings

interface.

Features available on the Decoder Preview Settings:

TV Wall: On the top right corner of the interface, select the type of TV wall to be previewed from the
drop-down option.

Save: Click [Save] to save the preview settings plan.

Save As: Click [Save As] to save the preview settings in a different location or name.
Delete: Click [Delete] to delete the preview settings.

Stop Plan: Click [Stop Plan] to stop the plan.

Start the plan round: Click [Start the plan round] to initiate the plan.

Plan Setting: Click [Plan Setting] to set a new decoder plan.

Exit Plan Editing: Click [Exit Plan Editing] to exit from editing the existing plan.

New: Click [New] to create a new preview plan.
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Z'(7-E cd ,8 [% @ Welcome, admin

[G] Video Device

2 Tvwall Test

k) Video Device Device

@™% Decoding

4 (@3 Area Name

Decoder 192 168.214.170

IpCamera 1
Decoder Grouping

TV Wall
Dec evi
Decoder Preview Play

o~
& Face Recognition

Real-Time Monitoring
81 Record

[E repot @ ¢ Stop Plan Starttheplanround  Plan'Seting  ExitPlan Editing [l 83 &
-E- Linkage Management

69 Connection Management (%)

Create a New plan
To set the preview, it is essential to create a plan first if there is no existing plan.
On the Decoder Preview Settings interface, click [New] to create a new plan.

On the Plan Setting window, enter the Plan Name (e.g. Division) and Residence Time (e.g. 15), and then
click [OK] to save.

sy Welcome, admin
Z‘( ; Ecd

@ o TV Wall | Test v
— “4 i
() Video Device ) Device e v
a

4 (&3 Area Name
4 (5 192.168.214.170
«, |pCamera

@™ Decoding

Decoder

Decoder Grouping

2
TV Wal Plan Setiing

e . Plan Name®

Residence Time* 5 (10-500second)
Decoder Preview Play

o~
& Face Recognition

@
Rea Time Morioing @) [ o< |
8: Record

@ Report @ Save As Delete Stop Plan Start the plan round Plan Setting Exit Plan Editing

g Linkage Management

@g@ Connection Management ()

Division (Created/Existing Plan Name)

The newly created or the existing plan name will be displayed at the bottom of the interface as shown in
the below image.

To Divide the Decoder Screen

On the Decoder Preview Settings interface, click [Division] (plan name), and then select the required
decoder screen from the matrix.
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Then select any one of the matrix screens from the options to further divide the selected decoder screen.

—— Welcome, admin
(™

[G) Video Device TV Wall | Test

[} Video Device Device

@™=% Decoding

4 (&) Area Name

Decoder Pl 192.168.214.170

IpCamera
Decoder Grouping

TV Wall

Decoder Preview Play

g Face Recognition

Real-Time Monitoring

a Record

E_] Report @ Delete Stop Plan Start the plan round Plan Setfing ExitPlan Editing ([l &

g Linkage Management

@"9 Connection Management (%)

Add the Video to the Screen

*  On the divided decoder screen matrix, select any one of split screen, then select the required video
channel from the list on the left, and then click 3 Save to update the plan settings.

[ Welcome, admin
ZKTe=a A 0 ‘

® Video Device TV wall Test v

[} Video Device Device

Search

@ Decoding
4 (23 Area Name

192.168.214.170

IpCamera 2

Decoder
Decoder Grouping

TV Wall

Decoder Preview Play

Decoder Playback

E Face Recognition

Real-Time Monitoring

Bﬂ Record

Delete Stop Plan Start the plan round Plan Setting Exit Plan Editing [l
Report

‘(Y- Linkage Management

/&) Connection Management

» Decoder Preview Play

On the Decoding module, click [Decoder Preview Play] to go to the Decoder Preview Play interface.

1. Selecta TV wall type from the drop-down list.

2. Click [Division] (the plan name) to initiate the preview.

3. Click [Start the plan round] and the display connected to the decoder will perform the video roving.

& Note: There is no default video available in the software.
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ZK7-EC.'J & Welcome, admin

@ TVWall Test 1

[k video Device

@ Decoding

Decoder Grouping
TV Wall
Decoder Preview Settings
Decc view Play
Decoder Playback

:8: Face Recognition

Real-Time Monitoring
-

@ Record (
%\ Report @ Stop Plan Start the plan round

‘Y- Linkage Management [

{-9 Connection Management (3
7

» Decoder Playback
On the Decoding module, click [Decoder Playback] to go to the Decoder Playback interface.

Functions and Operations

1. TV Wall - The upper right corner is the TV wall, and the binding relationship between the TV wall and
the video device can be selected.

2. Device and Storage Server - Select the required video from the Device or the Storage server on the
left upper column of the interface.

3. Search:
Search the video channels in the bottom left of the interface, which filters the search video types.
You can search for different videos according to four different conditions.

Date: Search by the required date.

- Search
'8 Face Recognition

Date: 2020-02-20 1

| @ | Real-Time Monitoring & ;

! Bitstream Main BitStream 2 v
Type :
Retrieval .
Mode : Any D "
Search Type : | Normal 4

':@," Linkage Management
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Bitstream Type: Select either Main Bitstream or Sub bitstream from the drop- down list.

Search

Face Recognition

Date: 2020-02-20
Real-Time M.:nnitoring -
BitStream Main BitStream v
Type :
_ Main BitStream
Record Retrieval Sub BitStream

Mode :

Search Type : | Normal

Report

Linkage Management

Retrieval Mode: Select either Any or All from the drop- down list.

AlL If the Retrieval mode is All, then all the alarm options will be selected in the Search type field, and
the Search function searches and retrieves the videos that meet all the alarm options.

Any: If the Retrieval mode is Any, then the Search function searches and retrieves only the videos that

meet the checked-in alarm options.

Search
Face Recognition
Date: 2020-02-20
Real-Time Monitoring .
BitStream Main BitStream v
Type :
Record Retrieval An
Mode : ny M

Search Type : [ All

Report

Linkage Management

Search Type: You can choose Normal, Motion, Alarm, Counting Alarm, Cross Line Alarm, Area Alarm and
Object Alarm.
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™V Wall
Clear QoK

Decoder Preview Settings » MNarmal
Motion
B Alarm
B Counting Alarm

Decoder Preview Play

Search B Cross Line Alarm
Face Recognition . R

Date: . Object Alarm
Real-Time Monitoring BitStream

Type :
Record F Retrieval

Mode : Select Al

Search Type :  Normal

Report

4. The Decoder displays the selected video.

5. The lower right corner is the playback control panel.

ZK A Sl & et

(6] Tvwal|Test 1w

Device Storager Server

Search Q

4 (%3 Area Neme

(X Video Device

@™ Decoding

Decoder Grouping 4 192.168.214.170
IpCamera 3
TV Wall
Decoder Preview Settings
Decoder Preview Play
Decoder Playback
~ Search 4
& Face Recognition
Date: 2020-02-20
.ﬂ Real-Time Monitoring
= BitStream ! pain Bitstream
Type :
) Retrieval
Record v
& Rl oce : Any
= Search Type :  Normal
b—;] Report (

.'g- Linkage Management

2020-02-20 00:00-00

You can even split the screen by choosing the matrix option below and then add the video channel to
the corresponding split screen.
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BE TV Wall |22 B
X

[} Video Device D Device SIGEN SN 169 Decoder-1

a [T T ET T STy b T
@ Decoding
Decoder
192.168.213.120
Decoder Grouping CcHO1
TV Wall ‘ 192 168232161
e B ST 2084
O review ngs
. 102.168.232.162 - L
Decoder Preview Play - >
k Search
Date. 2019-12-26
EI Real-Time Monitoring Feagll EitStream | Main BitStream v
. Retri Any v
a - ‘ - _
= I Search  Normal, Motion Alar
?T'l Repart ( Type :
202200000

6.2.3 Face Recognition

The face recognition module is mainly used to manage the face NVR function, which can be used for the
control and monitoring of block and allow list. It can view the results of the camera capture, identify in
real time, and can support the image search.

» Allow List Group

Allow List Group Management of Personnel:

On the Video Device interface, click [Face Recognition], then click [Allow List Group], and then click [New]
to add a new allow list group.

Enter the Personnel Group name and click [OK].

Allowlist Group Browse pe du p

Personnel Group l:l Q @ Personnel 1D | ‘ MName |
The current query conditions Mone The current query conditions Mone
( Refresh New (i Delete (+ Refresh [}’ Delete Person [ Image ~

O Personnel Group  Operations

Groupe du persennt  Edit Add Perzon

allowlist253 Edit Add Person
New

|

123213 Edit Add Person

o oo |

Add Person

On the Allow List Group interface, click [Add Person] to add the personnel to the allow list group.
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8 0
Allowlist Group Browse Personal:Groupe du personne

[k viteo Devis & Personnel Group Q ® Personnel ID Name Q ®
The current query conditions None The current query conditions Nons

‘w3 Decoding [GIN ( Refresh [ New ([ Delete (* Refresh [}’ Delete Person [ Image ~

Personnel Grou Operations
Face Recognition 4 P

Groupe du personni Edit Add Person

allowlist253 Edit Add Person

Blocklist Group 123213 Edit Add Person

Face Control
Device Monitoring

Face Monitoring

Image Search

Real-Time Monitoring

On the Add Person window, select the required Personnel ID from the left side, then click the
button to move the selected Personnel to the right side of the Add Person, and then click [OK] to update
the selected Personnel ID to the Allow List Group.

Add Person
Personnel 1D o\ ®
The current query conditions None
Alternative Selected(1)
Personnel ID First Name Last Name Personnel ID First Name Last Name
2 ZKTeco 1 Test

>
=
£
<<

1-1 S0rows perpage ~  Totalof 1records

> Block List Group

Blocklist group management of personnel:

On the Video Device interface, click [Face Recognition], then click [Face Recognition] > [Block List Group] >
[New], add a new group, fill in the group name, and click [OK] to confirm.
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A& 0

Blocklist Group Browse oupe du 11

(X Video Device G Personnel Group Q ® Personnel kD[:I Name Q ®

The current query conditions None The current query conditions None

w3 Decoding @ (% Refresh [ ® New [} Delete _\ Refresh [}’ Delete Person (] Image ~

o Personnel Group ~ Operations

* Face Recognition

Groupe du personnt

Edit Add Person
Edit

Allowlist Group

blocklist dit Add Person

Face Control
Device Monitoring

Face Monitoring

To manage block list personnel, you can () add existing personnel in the ZKBio Access system to the

blocklist group; @ you can temporarily add personnel to the blocklist group for control.

ZK Welcome, admin 922 (1)

(G) Black List Group Browse BlackWhite: Test02

Personnel Group Q ® Personnel ID Q ®

The curent query conditions None The current query conditions None

[Tk video Device

fmm Decoding : (% Refresh  [® New [fj* Delete (% Refresh ffj* Delete Person = List ~
o ” Personnel Group  Group Type Operations Personnel ID First Name Last Name Type Media File
* Face Recognition 1 2

Test02 Black List Edit Ada Person Manual Add Person 73 test2 [~}

White List Group

Distribute Device

> Face Control

Itis used to deliver black and white list groups to NVR devices that support face recognition.

T W

The current query conditions None

[k Video Device
(% Refresh [ Mew [[]* Delste [ Synchronize Data

(w3 Deceding

Task Name Distribute Device Host Address Group Name Group Type Operation Type Alarm Type Operations
g = 2. X 2.168. ]
.l Face Recognition i = 192.168.214.160 192.168.214.160 Groupe du personni Blocklist Remate Normally O Target Hit Alarm Edit Delete
=1 132 168 214 150 192 165 214 160 Groupe du personni Allowlist Remote Opening  Target Mon-hit Alarr  Edit Delete

Allowlist Group

Blocklist Group

Device Monitoring

Face Monitoring

Click [Face Recognition] > [Face Control] > [New] to add a device group for block and allow list
assignment.

(D Select the NVR device to which the blocklist and allow list needs to be sent.

@ Select the block / allow list group that needs to be sent.
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3 Select the Alarm type, the available options are Target Hit Alarm and Target non-hit alarm. If you
choose Target Hit Alarm, the NVR will only push alarm when it recognizes the allowlist or blocklist. If you
choose Target Non-hit alarm, the NVR will push the stranger alarm to ZKBioAccess as well.

@ Select the Operation type, the options are Remote Opening / Remote Normally Opening / Remote
Close, the related doors which bound with face recognition cameras will open / normally open/close.

® Finally set the Door open time duration.

New
Task Mame™ Block
Distribute Device™ 192.166.214.253 1
Group Mame® blocklist 2
Alarm Type™ Target Hit Alarm 3
Operation Type Remote Dpening| 4
Open 5 zecond(1-254

Synchronize Data

As the personnel group information is updated, click [Face Recognition] > [Face Control], to select the
"Task" which the person has updated and click [Synchronize Data] to synchronize the personnel
information to the facial recognition NVR device.

Task Name

The current guery conditions Mone

(: Refresh E‘? MNew [EP Delete E',) Synchronize Data

[k Video Device

3 Decoding

Task Mame Disfribute Device Host Address Group MName Group Type Operation Type
™ — i
* Face Recognition @ Block1 192.168.214.160 192.165.214.160 Groupe du personm Blocklist Remote Nomally &
Allow1 192.168.214.160 192.168.214.160 Groupe du personm Allowlist Remote Opening

Allowlist Group

Blocklist Group
. The operation succeeded!
Fa ntro

Device Monitoring

» Device Monitoring

Click [VMS] > [Face Recognition] > [Device Monitoring], to monitor the commands that the ZKBioAccess
software send to face recognition device. The displayed information are Device name, Serial number,
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Number of commands to be executed, Operations that can be performed, etc.

(+ Refresh

Commands List

Device Mame Serial Number Operations

(X1 Video Device

182.168.214.160 0BCDO12340CES8053878 1] Clear Command ‘iew Command

Decoding

(- @ 182.168.214.253 0B1101237AD10DB3B7T12 1] Clear Command ‘iew Command

raa
* Face Recognition
Allowlist Group

Blocklist Group

Face Control

» Face Monitoring

Face Monitoring option is used to monitor the allow list and blocklist personnel in real-time by using the
NVR Camera.

(D Monitors and displays the Allow list Personnel List.
2 Monitors and displays the Block list Personnel List.

3 Monitors and displays the Strangers.

| U (E)] @ ‘,} e admin ~
2020-07-21 11:18:23 Real-Time Monitoring
X Video Device
L0 ! g0
= Decoding " ©'mw
o 2
- 1 e by
.& Face Recognition °\
Allowiist Group I ‘ I ‘ .
& B
Blocklist Group
Name: Mot de pa
B JE—
Face Control
Mot de pa.. Mot de pa... Channel:CH1
Device Monitoring tere: (soot) tam (s001)
Channel CH1 Channel- CH1
Time-2020-7-1 15:41:26 Time-2020-7-1 15:41:25 b G
& B
- 2
Image Search ST — Name: Mot de pa
_ . [(Strangerfiam ™ &)
Channel:CH1
Real-Time Monitoring [ 4 Time20207-1 15:32:42
a Record Q £,
=
g Linkage Management N ' a
Channe:GH1
I_;F-‘ Report Time:2020-7-1 18:11:22
nection Management (%) O
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. : Controls the alarm sound.

. : Allows the user to confirm all the alarms at one-time.
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. : Full Screen button.

©8 20 7
displays the count of all types of personnel in the monitoring page

i.e Green represents Allow list, Orange represents Strangers, and Red represents Block list.

Alarm Details

Click the 8 / =] button on the Alarm list to view the specific alarm details.

® C)

Perscnnel ID:6002

Name: Quais s30 os sintomas nos
Channel: CH1

Time: 2020-7-1 18:22:53
Remarks:

Event: Blocklist Alarm

Click ® to view the real-time monitoring screen; click @ to view the video alarm recordings.
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L

Real-Time Monitering

07-01-2020 18:22:52

QDevice
| @Storager Server

Full Screen
|
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The following operations can be performed:
e Play the video on the device.

*  Play the video in the storage server.

* View the video in the full screen.

e  Click Download to download the video.

. Cick ¥ /8

remarks of this alarm and supports sending the notification to the specific email receiver.

(=]

g
to confirm this alarm, then the alarm button will change to Green

Remarks

Remarks -
Alarm Confirmed!

[#]Send E-mail Motification
E-mail Address

leo hou@zktecocom|:

> Image Search

button, the ‘Alarm Confirmation’ box will pop up. It allows the user to fill the

Click "OK’

You can search for matching faces captured by related NVR and camera devices by uploading photos of

personnel.
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ZK A U ©CEl @ wkone, sumn 4

(G) Search Criteria Search Result

[} Video Device
Decoing

": Face Recognition o 0
White List Group
Black List Group

Distribute Device

Capture Contrast

Start Date®  2020-02-20 18:35.58
EndDate®  2020-02-20 18:35:58

% | Real-Time Monitoring

B] Record @) 4
\:EL'J Report

@ Linkage Management

nnection Management (%)

Upload Image: Click to upload photos of personnel who needs to be searched.
Personnel ID: Enter the Personnel ID.
Channel: Select the camera channels to be searched from the drop-down list.

Similarity: Set the similarity value for accurate search i.e the search accuracy depends on this value so that you
can view the resembled images.

Start Date and End Date: Enter the start and end date to search, and then click [Search] to search.

The results will be listed on the right side of the interface.

[k Vvideo Device

Decoding

. Name : “3)  Name: <) | Name: [
Face Recognition =) Channel Mame : CH1 Channel Name : CH1 Channel Name : CH1
Time : 2020-07-20 14:35:44 Time : 2020-07-20 14:38:44 Time : 2020-07-20 14:38:45
Group Name : Stranger Group Name : Stranger Group Name : Strangsr

Allowlist Group
Blocklist Group (Optimal Size 120%140)

Face Control

Channel*  4,CH5,CHB CHT.CHS)
Device Monitoring

Perslgnnel 5001

Face Monitoring

Start Time® | 2020-D7-20 00:00:00

End Time*  2020-07-20 23:59.00

Real-Time Monitoring D Similarity” 85

a Record

g Linkage Management

|§| Report

The result interface allows you to view the similarity between the uploaded photos and captured photos,

Personnel ID, Channel name, Time, Group name, and click = to view the video playback.
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» Personnel Tracking

Click [Video] > [Face Recognition] > [Personnel Track] to view the personnel tracking interface. Based
on the MAP from the [Access] module, you can upload the personnel photo, select the search start time
and end time, enter the similarity value to accurately search the specific personnel. It simulates the
personnel track on the map.

Do

0 N @ O @ admin

[K Video Device
@ Decoding

:‘ Face Recognition

Allowiist Group

Optimal Size 120°140

Blockiist Group

Face Control
Msp Name® 134234

Start Time* | 2020-07-02 00:00:00

Device Monitoring
Face Monitoring

Image Search
End Time*  2020-07-02 23:59°59

Similarity” |85

3 Recor

.@ Linkage Management

'Er Report @

Click Search to view the result.

On the left side, you can view all the captured photos by facial recognition cameras in chronological
order, along with Personnel name, Channel name, Time, and Group name.

Click . to view the video playback.

On the real-time map, you can view the first captured photo by the facial recognition camera above the
camera icon.
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Mot de passe d...
CHO1

llow(Allowlist)
7-02 10:16:47

Mot de passe d.

CHO1
253allow(Allowlist)
2020-07-02 10:16:48

Mot de passe d...

‘ CHO1
253allow(ANowlist)
2020-07-02 10:16:48

Mot de passed... &
CHO1

253allow(Allowlist)
2020-07-02 10:42:52

Mot de passed...

| ‘ cHO1

253allow(Allowlist)
2020-07-02 10:42:54

Mot de passe d..
CHo1

253aliow(Allo
2020-07-02 1

6.2.4 Real-Time Monitoring

The real-time monitoring menu has three sub-menus, Group, Layout, and Video Preview.

The group and layout settings are for the third menu-preview. You can choose to preview in the form of

group and layout.
» Group

It can manage video channels in groups.

Click [Group] > [New] to add a new group, fill in the Group Name, and click [OK] to confirm.

e — e —

The current query conditions None The current query conditions None

m]

O | Group Name ‘ Operations

Device Name ‘ Channel Name ‘

nagement

ion Management

« I
Click [Add Channel] to add video channels to this group.
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Device Name

The current query conditions None

Alternative

Device Mame

192.168.214.170 IpCamera

11 50 rows per page

» Layout

Channel Name

Channel Name

Add Channel

Q ®

Selected(0)

Device Name

>

<=

-

Cancel

It sets the display style of the OCX and displays the bound video channels.

Click [Layout] > [New] to add layout

[} Video Device

3 Decoding

L nl .
.8, Face Recognition

@ | Real-Time Monitoring

Group

Video Preview

settings.

Layout Name |

The current query conditions Mons

(v Refresh [® New [fj Delete

Layout Mame Stay Time(s)

Channel Name

Type

For the first time users, click “Click to download.” and install the "zkVideoActiveX" plugin.
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G —~ — -
¢ New

® Layl Video Device
[ Video Device - The € Layout Name Test
e (&3 |1 Stay Time(s)” 20
G Decoding _ Screen Style” Normal Screen 6
Channel* 4 f.}* Area Name
;"_,Q; Face Recognition t 4 192.168.214.170 Unable to preview, processing methods are as follows

IpCamera 1.your computer is not installed to browse the video controls, or the installation of the
- ono ne QO no ne igic
_you are not allowed 1o use the NPAPT plugin. Please use IE or IE kemnel browser .Note:
Chrome 42 or Firefox 52 and FirefoxESR 52.9 more version does not support previews.
A 3.after the operation, please restart or refresh the browser.

@ | Real-Time Monitoring
==

Group

Video Preview

BJ Record

% Report

m @ E'
o
- a mwace iom@ o recars

Q Linkage Management

' Connection Management

12

Add layout settings:

@ Fill in the Layout Name on the left, @ Fill in the Stay Time, the preview time of the video channel set
by this layout. @ Select the Screen Style of the layout. There are Normal Screen and Wide Screen and a
variety of screen options.

@ Click on screen and click the video channel (5 and bind the video channel to the screen. After binding
the screen, a screen will be displayed, click [OK] to save.

Layout Name
The current query. yigeo Device
Refresh |
& | - Test 1
LayoutNan  Stay Time(s) 20 2
Screen Style Normal Screen 8 3
Channe 4 (@ Area Name
192.168.214.170
IpCamera 5

CRAS
Sae w0

® < o > S0rowsperpage ~ JumpTo 1 /0Page  Total of O records.

> Video Preview

Click [Real-Time Monitoring] > [Video Preview] to enter the video preview interface. The video preview
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interface is divided into four parts.

m_."ﬁ 8 D Welcome, admin

(G} Video Device

[sCamera

J) Video Device 3 Device Group

(a3 Decoding .
4 (&3 Area Name

- 192.168.214.170
,8: Face Recognition

® IpCamera
E] Real-Time Monitoring (=)
Group 1
Layout
| PTZ Control
Zoom
AUTO Focus
B Record
Ins
2
B Report SN | setting
g Linkage Management o Preset: 1 [v] @ e e
crise: 1 |v| @ [
Tack: 1 v @ @@

/D Connection Management (2
@’ age

Alam Information 4

@ Video device selection area.

 Video preview display interface.

i: Takes a screenshot within the blue frame of the selected screen.
iz Displays the screen in the full screen preview.

iii: Stops all the preview screens.

iv: Different split screen options.

(® PTZ Control: This function is only available for dome camera.

PTZ Control
Zoom
AUTD Focus
Iris

Speed : [INNNE

@ Alarm Information list.
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® There are three tabs in the video device selection area, which are device list, group, and layout.
Online devices are green and offline are gray.
® Video list for video preview:

The device list has three levels, which are area, device, and channel. O Select the layout to be previewed.
@ @ Left click an online channel to play the corresponding channel's screen on the right preview
window (blue frame). Click again to stop playback.

< (& EmER
(G113
182.168.213.120
3 @ crnt
192.168.232.161
20BARE
182 168 232 162
20
192.168.232.163
20BARES
162168232 164 v
< >

PTZ Control

AUTO Focus

® Group Video Preview:

Click [Group] in the tab page, here is a list of all the groups set in the [Group] menu. Right-click a group
and three options will appear, which are [Start Rolling], [Stop All], and [Preview].

@ Start Rolling: After the round starts, it will automatically start timing (15 seconds) to start the group
switching preview from the selected group.

For example, group 5 is currently selected. The preview screen on the right will preview this group first,
and then switch to preview group 1 after 15 seconds, and then preview group 2, group 3 group 5 group 1
after 15 seconds and keeps looping.

(@ Stop All: Click to stop rolling and preview.

() Preview: Play the group monitoring screen on the preview screen on the right. Offline devices will not
display the preview screen.
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A 0 5 e wecome, s {3

Video Device

Dﬂ Vidoo Dewce. 3 Device Group
4 7 Group #
ecoding ®© 192
® 192 2 StopAl
Preview

1 start Roling

w

"8: Face Recognition

(2] ReatTime Monioring =

Group

Layout

< >

PTZ Control

.| AUTO fYFocus

B3, Recod 3 ) s @

L‘T* Report 0 Speed : | EE—

@ Linkage Management

P
@) Connection Management (% i

® |ayout Video Preview

Click [Layout] in the tab page, here is a list of all the layout settings that have been set in the [Layout]
menu. Right-click a layout and three options will appear: [Preview], [Start Rolling], and [Stop All].

@ Preview: Play the layout monitoring screen on the preview screen on the right. The offline devices will
not display the preview screen.

(@ Stop all: Click to stop rolling and preview.

(@ Start Rolling: After the round starts, it will automatically start timing (can be set in Layout) to start the
layout switching preview from the selected layout and keep looping.

Z’(T:Tca & D & @ Welcome, admin 305

(G) Video Device froo

DJ Video Device : Group Layout
4 7 TestA

ga Decoding @ Peew 1
@ Start Rolling 2
3
"8: Face Recognition D Stop Al
@ Real-Time Monitoring (=)
Group
Layout
< >
PTZ Control
Zoom
AuTo | @Focus @

Speed : |

‘(- Linkage Management (2

2 =
@ ot NaRymat( Alam Information
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6.2.5 Record

The record function is mainly used to configure the record plan and view the related video records of the
device.

» Storage Server
® Configure the record plan

Before setting the record plan, you must first configure the storage capacity, otherwise the
corresponding records will not be generated.

o 50 ofde

® ("% Refresh

_n Video Device Server Name P Port Used Percent Used Space Cperations
X 2

1
Local_Storager 127.0.01 ] TT% 633GB / 331GB Record Plan Sefting Storager Quota Setting

Decoding
e~
.8, Face Recognition

Real-Time Menitoring

==

00
- Record

Video Record

Click @ [Storage Server] > [Storage Quota Setting] to configure the record storage capacity of the VMS
server.

It will obtain the available capacity of the hard disks on the VMS server other than the system disk and
configure the disk space for storing videos.

Edit
Disk Mumber Partition Available Space(GB) Total Space(GB) CQuuota(GB) 1
ST1000DM D10-2EP102 SCSI Disk Device D: i3] 278 50
ST1000DM D10-2EP 102 SCSI Disk Device E: Lili] 277 28
ST1000DM 010-2EP102 SCSI Disk Device F: a5 276 12
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® Record Plan Setting
Click @ [Record Plan Setting] to enter the record plan setting page.

Click [New] to select a video channel to set the record plan.

[vfSubordinate Level Contained
4 [ {Z) Area Name
4 [ 1f3,192.168.214.170
| |« IpCamera
4 [1F3,192.168.214.197

[ ] #% tete

CEWCENGRNEN [ | Select Al

After selecting the video channel, you can set the corresponding record plan, as shown below:

Video Channel Record Plan
1 2 3 4 B 6
@ New H Copy Channel Config m Delate Record Model | Stop Video Re:ordinﬂ Pre-Record Time  No Pre-Record ~ | DelayRecord Time | No Delay -
Delet 0 Delete Al
O Device Name Channel Operations X Delete I Delete
Mame
7 0 2 4 & & 10 1z 14 16 16 ] 2z 74
= sun I
a 2 4 [ g 10 1z 14 16 18 70 2z 74
Mon I
a 2 4 [ g 10 1z 14 16 18 0 2z 74
£ Tues I
i 2 4 [ & 10 1z 14 16 1 0 2z 24
Wed. I
i 2 4 [ & 10 1z 14 16 1 20 2z 24
Thur I
i 2 4 [ & 10 1z 14 16 1 20 2z 24
Fri.
i 2 4 [ & 10 12 14 16 1 20 2z 24
Sat.
Save and New

@ Add a record video channel.

(@ Copy Channel Config can copy the record plan of the 7 weekly record panel to the selected video
channel.

3 Delete the selected record plan;
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@ Record Model:

i: Stop Video Recording.
li: Timing Video.

lii: Alarm Video.

Ilv: Timing Video + Alarm Video.

Record Model | Timing Video + Alal Pre-He
Stop Video Recording
Timing Video |j
Alarm Video jjj
v Timing Video + Alarm Video

® Select Pre-Record Time: When the record model is in Stop Video Recording or in Timing Video, the pre-
record time should be “No Pre-Record” by default.

Pre-Record Time | Neo Pre-Recerd
Mo Pre-Record
Es
10s
20s
30s

® Select Delay Record Time: When the recording type is Stop Video Recording and Timing Video, the
default delay record time can only be "No Delay".

DelayRecord Time | No Delay
Mo Delay
Bs
20s
30s
1min
2min
Emin

10min

@ Record plan panel, drag to select the record time.
» Video Record
Video playback can be viewed on the [Video Record] interface.

The video playback interface is divided into four areas:
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(@ in the device area, there are two-tab pages, the device list interface and the local storage server.
(@ Video search area.
(®) Video download area.

@ Video playback area.

Z’(7-ECG 8\ @ u% @ Welcome, admin

® B8

[k Video Device Device Storager Server

4 ¥ 7 Local_Storager

=y Decoding @ % 192.168.214.170-pCamera

1
.8, Face Recognition

Real-Time Monitoring

Search

00 . -
ecord
- el | 0:te: 2020-02-21

BitStream

Main BitStream
Type :

Storager Server

Video ord Refrieval

Mode : Any

Search

oo Normal

:

2020-02-21
=] Report @ 09 : 46 : 28

09 . 46 . 28

y..

@;’? Connection Management (2) P @@

Y- Linkage Management

® Device area:

Video device selection area, there are 2-tab pages, which are device and local storage server. Online
devices are shown in green and offline devices are shown in gray.

Select the video channel to be searched in (©), select the conditions for video search in 2), and click
[Search] to search for video. If there is a video, it will display the video segment that can be played; if
there is no video, it will pop up [No data].

® Video search conditions:

There are four search filter conditions: @Date, 2)Bitstream Type (Main or sub Bitstream), @Retrieval
Mode (Any and All), @Search Type (there are 7 options, multiple options can be selected)
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Search

Date: 2018-12-30 1
BitStream Mszin BitStrearn o 2
Type : —
Retrieval Al ' 2
Mode : —

Search Mosmal
Type :
el Mormal
Motiom
B 2larm
B Counting Alarm
[l Cross Line Alarm
B &res Alarm
B Cbject Alarm

® Video download area:

Before downloading, select the device in the device area, select the date and start/end time of the video
@@WQ), click Download, if there is no data, it will pop up [No data]; If there is a video will directly start to
download and show the @) download progress. After the download is completed, the progress will

display [Download Completed].

Download

Date: 2018-12-30 1

St i5:3:2:28 £2
Erd [i7:32:-22 =3

® Video playback area:

@ Play button; @ Pause button; 3 Stop button; @ Mute button; G Play by frame; 6 Screenshot button.
@ Full screen playback button; ®@©@@d Double speed adjustment button.

(®ay video clips; @Jdeo playback window.

& Note: The video playback area can only play up to 4 videos at the same time.
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6.2.6 Report

The Report feature of the video module can query the operation records of the user on the Video device,
Video alarm records, Facial recognition alarm report, and the Video linkage records.

» Face Recognition Report

It is mainly used to list the operation records of the system users on video device.

The Facial Recognition report displays the details of all face recognition done through the configured Face
recognition devices. It also supports viewing the captured photo and video records.

A 0
Operation Time From | 2020-04-21 00:00:00 To | 2020-07-21 23:59:58 Type | ——— More O\ ®

_ ) The current query conditions Operation Time From:(2020-04-21 00:00:00) To:(2020-07-21 23:59:59)
[ Video Device

* Refresh [ffj* Clear Al Data

[y Decoding

Time Device Name Type Personnel 1D First Mame Last Name Media File
B: Face Recogniton 202007-21 08:1T:11 192.165.214.253 Stranger [=[cC}
2020-07-20 20:00:14 192.165.214.253 Stranger [=JC]
ReaTime Monitoring (1) [E R IE e REE e 192 165 214 253 Stranger [=~IcC}
2020-07-20 19:56:39 192 168214253 Stranger [=IC}
Ei! T EE 100720 19:51-06 192.168.214.253 Stranger [=IC)
o . 2020-07-20 19:27:19 192.168.214 253 Stranger = ®
-[J- Linkage Management
2020-07-20 18:55:33 192.168.214 253 Stranger = ®
' Report Sl 2020.07-20 18:32:21 192.168.214.253 Stranger = ®
20200720 18:26:51 192.168.214.160 Alowiist 11 =¥ & ®
2020-07-20 18:26:50 192.168.214.160 Alowiist 11 = = ®
(i i i (e i 2020.07-20 18:26:49 192.188.214.160 Allowist 11 = & ®
Video Alarm Report 2020-07-20 18.26:47 192.168.214.180 Alowiist 11 =Y & ®
Linkage Event Report 2020-07-20 18.26:46 192.165.214.180 Alowiist 11 =Y = ®
Video Operation og 2020-07-20 18:23:50 192.165.214.253 Stranger [=IcC}
. 2020-07-20 18.23:10 192.165.214.180 Alowiist 11 i [=Ic}
Report 2020-07-20 18:23:09 192.165.214.160 Alowiist 1 =Y [=[cC}
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» Recognition Alarm Report

Itis mainly used to list all the facial recognition alarm record reports including Blocklist alarm and Stranger
alarm. It also supports viewing the captured photo and video record.

Alarm Time From | 2020-04-21 00:00:00 | Te  2020-07-21 23:59:5¢ Type | ———— Morer Q. &
¥ Vidso Devi The current query conditions Alarm Time From:(2020-04-21 00.00:00) To:(2020-07-21 23:59:59)

| Video Device

_ (v Refrssh = List ~ (f} ClearAllData [# Export

(= Decoding

Alarm Time Device Name: Personnel ID Name Alam Type Remarks Confirm Alarm  Media File
[y ) 2020-7-21 08:17:11 192.168.214.253 Stranger Alarm RRRRRERERRERRERRERRRRERY [=[C]
8 Face Recognition
20207-20 20:00:14 192.168.214.253 Stranger Alarm ° [~[C]
[®] Real-Time Monitoring sl 2020-7-20 19:58:58 192.168.214.253 Stranger Alarm ] @
2020-7-20 19:56:39 192.168.214.253 Stranger Alarm ° [=[C]
81 Hecaul 2020-7-20 18:51:06 192.168.214.253 Stranger Alarm © [=Ic)
. 20207-20 18:27:18 192.168.214.253 Stranger Alarm ° =
- ‘@. Linkage Management ©
2020-7-20 18:55:33 192.168.214.253 Stranger Alarm ) [=[C]
' Report C 2020-7-20 18:32:21 192.168.214.253 Stranger Alarm ) [=[C]
20207-20 18:23:50 192.168.214.253 Stranger Alam © [~[C]
Face Recognition Report
2020-7-20 18:22:44 192.168.214.253 Stranger Alarm © @
2020-7-20 18:21:41 192.168.214.253 Stranger Alarm ) [=[IC]
Video Alarm Report 20207-20 18:13:37 192.168.214.253 Stranger Alarm ® [=IC]
Linkage Event Report 2020720 18:13:37 192.168.214.253 Stranger Alarm ° [~[C]
2020-7-20 18:12:44 192.168.214.253 Stranger Alarm ° =]
Video Operation log ®
2020-7-20 18:12:38 192.168.214.253 Stranger Alarm
Face Template Distribute B @ e
Report 2020-7-20 18:12:34 192.168.214 253 Stranger Alarm © [~[C]

» Video Alarm Report

It is mainly used to view all the video alarm records.

You can select the start time, the serial number of the video channel and different alarm types to filter the
report. You can search from the following criteria: Motion Detection, Video Loss, Video Occlusion, Alarm
Input, Counting Detection, Area Detection, Item Detection, and Cross-Line Detection. Click Media File to
view the alarm video.

Operation Time From  2020-D4-21000000 | To | 2020-07-21 23:59:59 Alam Type | ———— Q ®
— . The current query conditions Operation Time From:(2020-04-21 00:00:00) Te:(2020-07-21 23:55:58)
|_k1_| Video Device
(_+ Refresh
3 Decoding Start Time: End Time Serial Number Alarm Type Alarm Source Media File

g Face Recognition

Real-Time Monitoring
==

a Record

Q Linkage Management

' Report

Face Recognition Report

Recognition Alarm Report

Linkage Event Report

Video Operation log

Face Template Distribute
Report
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» Linkage Event Report

The linkage event report comes from the captured and the video recorded data generated by the linkage
between the Access control and the Video module.

You can search the event report data based on the time period and device name. You can select any one

option to display the related report: List, Image, Video.

e admin v

Operation Tims From | 2020-04-21000000 | To | 2020-07-21 235859 Device Name Event Nams morew Q. ®)
— . The current query conditions Operation Time From:(2020-04-21 00:00:00) Te:(2020-07-21 23:58:58)
[ K1 Video Device
(% Refresh  [ffj* ClesrAllData = List ~
Decoding " .
Start Time: End Time Ares Name Device Name Channel Name Media File  Persons! Information Event Name Origin Status Re

o » 202007-2109:06:37 20200721 0:07:07  Nom de zone 192.188.214.180 cH1 [~[C] Nom de la liaison:11{l Video Capture Success Videt 11
Face Recognition 1
2020-07-2109:06:15  2020-07-21 09:06:45  Nom de zone 182.165.214.160 CH1 [=~[C] Nom de la lisison:11(l Video Capture Success Vide: 11:
Real-Time Monitoring 2020-07-2109:06:08  2020-07-21 09:06:33  Nom de zone 192.165.214.160 CH1 [~[C] Nom de la ligison:11(1 Video Capture Success Videc 11
20200721 09:06:05 20200721 09:08:35  Nom de zone 192.188.214.160 CH1 [~[C] Nom de la liaison:11{l Video Capture Success Videt 11
Recad 202007-2108:06:03 20200721 08:06:33  Nom de zone 192.168.214.160 CH1 [~[C] Nom de la liaison:11(1 Video Capture Success Videt 112
_ 2020-07-2109:04:32  2020-07-2109.05:02  Nom de zone 192.165.214.160 CH1 [~[C] Nom de la ligison:11(1 Video Caplure Success Videt 11
Linkage Management
202007-2109:04:27 20200721 09:04:57  Nom de zone 192.188.214.180 cH1 [~[C] Nom de la liaison:11{l Video Capture Success Videt 11
Report 202007-2108:04:17 20200721 09:04:47  Nom de zone 192.168.214.160 CH1 [~[C] Nom de la liaison:11(l Video Capture Success Videt 11:
2020-07-2109:04:13  2020-07-21 09:04:43  Nom de zone 182.1658.214.160 CH1 [~[C] Nom de la liaison:11(l Video Capture Success Vide: 11:
Face Recognition Report
202007.2109:04:11  2020-07-2109:04:41  Nom de zone 192.188.214.180 CH1 [~[C] Nom de la liaison:11({l Video Capture Suceess. Videt 11
Recognition Alarm Report 202007-2108:04:08 20200721 09:04:38  Nom de zone 192.168.214.160 CH1 (=[] Nom de Ia liaison-11(l Video Capture Success Videt 11
Video Alarm Report 2020-07-2109:03:02  2020-07-21 09:03:32  Nom de zone 182.1658.214.160 CH1 [~[C] Nom de la liaison:11(l Video Capture Success Vide: 11:
202007.2108:59:17  2020-07-21 08:59:47  Nom de zone 192.188.214.180 CH1 [~[C] Nom de la liaison:11{l Video Capure Success Videt 11
20200721 08:56:37 20200721 08:58:07  Nom de zone 192.166.214.160 CH1 [=[C] Nom de la liaison:11(l Video Capture Success. Videt 11
Video Operation log
2020-07-2108:58:32  2020-07-21 08:58:02 Nom de zone 182.165.214.160 CH1 Nom de la liaison:11(l Video Capture Success Vide: 11:
Face Template Distribute =® i i
eport 202007.2108:58:30  2020-07-21 08:59:00  Nom de zone 192.188.214.160 CH1 [~]C) MNom de Ia liaison-11(l Video Capture Success Videt 11

® (lick the location of the image to display it.
® (lick the Video Play button to play the video.

» Video Operation Report

Itis used to view the operation records of the system users on the video device.

You can choose the Start time, Operation type (User Login/Device Management/Linkage Rule), and other

conditions to filter the report.
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Operation Time From | 2020-04-21 00:00-00 To | 2020-07-21 23:59:59 Operstion Type |-———— Q @
. The current query conditions Operation Time From:(2020-04-21 00:00:00) To:(2020-07-21 23:59:59)
e Video Device
(% Refresh [ # Export

(== Decoding

Time Operation  |P Address Operation Type Target Address
User
() _
8 Fate Recognition ( 2020-07-21 08:17:11  admin 192.168.214.15 Logout
2020-07-2020:00:14  admin 182168 214 16 User Login

Real-Time Monitoring
=

Eﬂ Record

@ Linkage Management

' Report

Face Recognition Report
Recognition Alarm Report
Video Alarm Report

Linkage Event Report

» Template Distribute Report

It is used to list the operation records of the Allow/Block group list personnel in the software. It supports
choosing Operation Time, Personnel Name, Device Name, Operation Type, to filter the reports.

Operation Time From | 2020-04-21 00-00-00 To’ 2020-07-21 23:58:59 Name l:l Serisl Mumber moe~ Q@)

— The current query conditions Operation Time From:(2020-04-21 00:00:00) To:(2020-07-21 23:5%:59)
|_}'_| Video Device
(+ Refresh (i Clear All Data

iy Decoding Time Serial Number P Address Device Name Personnel ID First Name Last Name Operation Type  Status  Remark

[ .07-20 17-10: )
& Face Recogniion 2020-07-20 17:10:52 0BCD012340CES305 192.168.214.160 192.163.214.160 12 =3 Delete Blocklist @

Real-Time Monitoring

BJ Record

@ Linkage Management

' Report

Face Recognifion Report

Recognition Alarm Report
Video Alarm Report
Linkage Event Report

Video Operation log

6.2.7 Linkage Management

Alarm linkage management is mainly used to configure the alarm linkage trigger conditions and action
types of video device in the management system.

» Video Linkage

Click [Video Linkage] to enter the linkage management interface and click [New] to add an alarm
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management.
@ Enter Rule Name.

@ Alarm Type, there are 8 options (Motion Detection, Video Loss, Video Occlusion, Alarm Inputs,
Counting Detection, Area Detection, Item Detection, Crossline Detection).

() Select the Alarm Source, that is, select a video channel.

@ Linkage Action: there are five options: Capture, PTZ, Videotape, Pop-up image, TV wall.
® Action type.

® Remarks.

#sNote: When the alarm type is selected as Alarm inputs, the pull-down option of the alarm source will
become the alarm input. Not all devices have alarm inputs. There are two types of alarm input: local alarm
source and network alarm source. IPC devices have only local alarm source and no network alarm source.
NVR devices have network alarm source.

e Q@

The current query conditions None

ow \

Edit F
Operations
: Rule Mame® 1 22 |

L Edit Delete Di

Alarm Type® 2 Motion Detection

Alarm Source® 3 CH1

Linkage Action® 4 [] Capturs O p1z

[ Videctape [] Pop-up Image [ ™ Wall
Action Type* 5
Remarks &

There are five options for linkage actions:
@ Capture, @ PTZ, @ Videotape, @ Pop-up Image, & TV Wall.

You can select multiple options, but you can configure the actions one by one only.
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Linkage Action® 1 [ Capture 2”_! PTZ
3
3 7 Videotape 4 7 Pop-uplmage o TV Wall

» When selecting [Capture], select the video channel that needs to be captured.

4 @ MNom de zone
4 71 192.168.214.253

~ #% CH1

% CH2

% CH3

# CH4

% CH5

% CHB

2 CHT

% CHa

Save Cancel

» When selecting [PTZ], you can choose to call the present point or turn on the round.

4 @ Mom de Zone Mode ~
« £ 192.168.214.253 -

* # CHA (® Call Present Point
#CH2

&2, CH3

#, CH4

2, CH5

#2, CHE

%, CH7
#2 ~Hp

() Tum On the Round

il

Save Cancel

» When selecting [Videotape], select the video channel that needs video; multi-channel can be
selected.
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A @ Mom de zone
4 £ 192.168.214.253
#% CH1
“% CH2
ST CH3
“% CH4
#% CHS
“%, CHE
#%, CHY
#% CH3

» When [Pop-up image] is selected, select the output channel and set the duration of the pop-up
image. There are Automatic (stop when the alarm stops) and pop-up time setting.

4 @ Maom de zone
4 £ 192.168.214.253
# CH1
#% CH2
#% CH3
#% CH4
#% CH5
% CHE
% CHT
% CHS

Stop Mode mautomatic (TiAfter [20 |seconds Stop

» When [TV-Wall] is selected, you can select the corresponding alarm linkage output video channel.
You need to add a decoder first.
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j@wcmdezone N 1111
4 192 168.214.253
*= CHA1
* CH2
*2 CH3
* CH4
*= CHS
*2 CHE W

O T

Stop Mode mautomatic (Cbfter Sec onds Stop

Corce

> Global Linkage

Click [Linkage Management] > [Global Linkage] to open the global linkage management interface and
click [New] to add global linkage settings between the Video and Access Module.

- £
[ ,l &5 )] pl
Global Linkage Browse Personnel
|:“ Video Device ~ Linkage Mame Q @ Personnel ID Name Q @
The current query conditions None The current query conditions MNenes
fmm?) Decoding SN (: Refresh [® New [ Delete ~/ Enable (Z) Dissble (j Seftings ~ (C+ Refresh [} Delete Personnel
v » : Linkage  Linkage Trigger Conditions ~ Enable Personnel  Operations Personnel ID First Name Last Name
& Face Recognition @ Name Range
2 Allowlist Blocklist, Stranger [ Al Edit Delete
Real-Time Monitoring
- ki Allowlist Blocklist, Stranger [ Selected Pe  Edit Delete Add Personnel

BJ Record

n Linkage Management

Video Linkage

= Note:

® Before setting up a Global Linkage, the user needs to configure the related Video Devices /
Access Control Device / Email Service.
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® The user must configure a Video Record Plan in [Record] > [Record Server]-[Record Plan
Setting] so that the video linkage can generate a video record.

Add
Click [Linkage Management] > [Global Linkage] > [New].

‘ Mew

| Linkage Name™ Apply To All
|
‘ Linkage Trigger Conditions*  Add Input Point*  Add
Linkage Output Arcess Linkage E-mail
[] Pop Up Video Digplay time 10 5(5-60)
[ Video “ideo length 30 s(10-180)
[] Capture [] In the monitoring page immediately pop up
Display time 3 s(1-60)

Save and New “ Cancel

The fields are as follows:

Linkage Name: Set a linkage name.

Apply to all personnel: If this option is selected, this linkage setting is effective for all the personnel.
Linkage Trigger Condition: Linkage Trigger Condition is the event type of the selected video device.

It includes Motion Detection, Video Loss, Tampering, Counting Alarm, Area Alarm, Object Detection,
Cross Line Alarm, Human Detection, Allow list, Block List Alarm, Stranger Alarm.

Input Point: Select the Video Channels as input point.

Output Type: It represents the linkage output action type, including Video Action, Access Control
Linkage, E-mail Action, and Send SMS Action.
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Video Linkage:
Linkage Output Access Linkage E-mail
[] Pop Up viden Dizplay time 10 s(5-60)
[ Video “ideo length 30 s(10-180
[] Captures [] In the manitoring pags immediately pop up

Display time 3 s(1-60)

Pop up video: It decides whether to set the pop-up preview window and set the pop-up time duration.

Video: Enable or disable the background video recording and set the duration of background video
recording.

Capture: Enable or disable the background snapshots.

Access Control Linkage:

Linkage Output Access Linkage E-mail
Door Add Auxiliary Output  Add
|o#] farya. 1858-1
Action type* Open Action type* Close
Action Time* 0 5(1-254)

® Select the doors.
® Select the Auxiliary Output Point.

The Action Type has five options:

Action type® Elose
Close
Open
Mormally Open
Lock

Unlock
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Email Notification Linkage:

Linkage Output

E-mail Address

Arcess Linkage

Example:123@foxmail.com; 456@foxmail com

=1
iF
[

A\ Enter multi

E-miail

[
i
[=]
=]
%]

After setting the e-mail address, the system will send the linkage events to the recipient’s Email.

[k Video Device

ecoding

g Face Recognition

Real-Time Monitoring
=

Eﬁl Record

n Linkage Management

Video Linkage

Global Linkage

Linkage Mame

Q ®

The current gquery conditions Mone

(+ Refresh [ New

([} Delete ~/ Enzble (/) Disable  Seftings ~
i5¢  Set Global Pop-up Option

Linkage Link

MName Range
22 Allowlist Blocklist, Stranger [-] All Edit Delete
11 Allowlist Blocklist, Stranger (] Selected Pe  Edit Delete Add Personnel

tage Trigoer Condition Enahle Per.

Browse Personnel

Personnel ID
The current query cond

( Refresh ([ Delet

Personnel ID

® Enable/Disable

Select Linkage Settings, click [Enable/Disable], to Start / Stop using the linkage setting.

® Edit/Delete

Select the linkage, click [Edit] / [Delete] to edit or delete the linkage setting.

® Settings

Set Global Pop-up Option: When the linkage is triggered, this setting decides whether to pup-up a

floating window.
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[] Whether display pop-up in all modules

Set Global Pop-up Opficn

Cancel
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® Add Personnel / Delete Personnel

Add Personnel option is used to add personnel to a specific linkage.

Add personnel
The current gquery conditions Mone
Alternative Selected(D)
‘ Personnel ID First Name Last Mame Personnel ID First Mame Last Name
6001 PrénamB001 désactive6001
=
=
=
==
1-1 SOrows perpage —  Total of 1 records
zNote:

Only the Allow list/Blocklist personnel are only available for these linkages.

6.2.8 Connection Management

The Connection Management function is used to configure the Server path for Video linkage. Here you
can also set the storage location of Video linkage files.

» Connection Manager
Click [Connection Management] to open the connection management configuration interface.
You need to configure the following parameters:

1. The Address and Port number of the VMS client.

Note: The VMS Client must be installed and configured on the ZKBio Access Server.

2. Configure the Server path of ZKBio Access to ensure NVR access.
3. Configure the storage address of the video linkage captured pictures and video files.

4, Configure the space size where the video linkage media files are stored. When the media file
capacity reaches the configured space size, there are two options: "Delete old files" which deletes the
previous files and "No longer capture" which does not capture any more linkage videos.
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I’_\I | r‘:"
-:’“"._ |__ ,| @ @ Lo I‘p
WS System
_ 1 ; . .
|_h Video Device - WMS Connection Path hitp:if192.168.214.143:3459
- Server
@™ Decoding
g Server Path hittp1192.1658.214.143:8093
e
.& Face Recognition
Save The File
Real-Time Monitoring EM 3 \ideo Fils Path, E:\BinSecurityFilewidwideoLinkageFile
a Record & “ideo File Clean Up
% \When disk space is less than 1 GB,@ delete the previous photos () do not capture

@. Linkage Management

6.3 Access Control Module and VMS Video Linkage Function

Description

6.3.1 Access Control and Video Linkage Function

» Function Description

VMS video function can replace the original Video module to make a video linkage with the access
control module. The setting method is the same as the original setting linkage method of access control
and video module.

The steps to set up the linkage between access control and VMS video are as follows:
1) Under VMS device interface, add video device.
-

© Device Name l:l Serial Number More~ Q @

The current query conditions None

¢ Video Device
(_% Refresh @ New [ﬁ‘} Delate Q Search Device (o4 Equipmenttiming s Enable @ Disable

Device Name Serial Number Area Name 1P Address Port Protocol Type  Device Model  Status  Enable  Operations
Video Channel

192.168.214 197 0BD3012317 BBA297 Area Name 192.168.214.197 80 ZKTeco IPC2.0 Online (/] Edit Delete

192 168 214 170 0BD3012366AECFA. ! Area Name 192.168.214 170 80 ZKTeco IPC20 Online ] Edit Delete

2) Add the access control device under the device interface of the access control module.
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Welcome, admin

Device Name Serial Number 1P Address veer Q@

The current query conditions None
E Device ¢

. Refresh EE?NEW mx Delete Ln’ Export  (Q Search Device 2, Device Control ~ {g@ Setup ~ @\Aewana Get Device Infe ~ @ Communication =
Device

Device Name Serial Number  Area Name  Communicatiol Network P Address R435 staius  Cevice Register  Firmware Version Operations
Connection Parameter Model Device
1O Board Mode
Door 192.168.0.105 ‘CJHB192960013 Area Name HTTP Wired 192.163.0.103 Offling SmartAC1 e Ver 9.0.1.5-20190725
- 192.168.10.232 CJI4193360005 AreaName ~ HTTP Wired 102.152.10.232 Offine  SpeedFace Ver 8.0.1.10-6600-01
eader
192.163.10.218 CJTS192460017 AreaName  HTTP Wired 192.168.10.212 Ofine  ProFace XICt @ Ver £.0.1.10-20190320
Auxiliary Input
I CJ74192960006 Area Name HTTP Wired 192.168.1.76 Offline ProFaceX @ Ver 9.0.1.4-20180716

Auxiliary Output

3) Under the Reader interface of the access control module, bind the reader of the access control
device to the VMS video channel that needs video linkage. A reader can bind up to 5 video channels.

Note: The combined channel must first set the alarm video in the Storage Server-Record Plan Setting, so

that the access control linkage can produce the video.

Reader Name l:l Door Name Q ®

. . The current query conditions None
E Device (=)
(" Refresh
Device
Reader Name Door Name Mumber Communication Communication  In/Out Bound camera Operations
Type Address
/O Board
192.168.0.105-1-In 192.168.0.105-1 1 In Edi Binding/unbinding the camera
Door
192.168.0.105-1-Out 192.168.0.1051 2 Out Edit Binding/unbinding the camera
192.168.10.232-1-In 182.168.10.232-1 1 In Edit Binding/unbinding the camera

Auxiliary Input 192 168.10.232-1-Out 192.168.10.2321 2 Qut Edit Binding/unbinding the camera

192.168.10.219-1-In 182.188.10.21%-1 1 In dit Binding/unbinding the camera

Auxiliary Output

192 168.10.219-1-Out 192.168.10.21%-1 2 Out Edit Binding/unbinding the camera

Event Type
182.168.1.76-1-In 182.188.1.76-1 1 In Edit Binding/unbinding the camera

Daylight Saving Time 182 168.1.76-1-Out 182 168 1.76-1 2 out Edit Binding/unbinding the camera

4) Setthe linkage trigger conditions, input point, output point, etc., click [OK] to save. For details,
please refer to [Linkage] setting instructions of access control module.
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New
Linkage Name

The current query condition Linkage Name™ Test Device” 192.168.10.219

(> Refresh [ ® New d Linkage Trigger Conditions®  Add Select All Unselect Al Input Point* I

Normal Verify Open m 3
First-Personnel Open A . Any
Multi-Personnel Open " 192168 10.219-1 E
Emergency Password Open

Open during Passage Mode Time Zone

Cancel Alarm

Remote Opening

Remote Closing

Operation Interval too Short

Daoor Inactive Time Zone Verify Open

lllegal Time Zone

Access Denied &7

cess Control [] Linkage Name De

Time Zon

Holidays

ARRARER AR

Oufput Point* Video Linkage E-mail

« Pop Up Video Display time 10 s

| Video Video length a0 s(10-180)

¥ Capture In the monitoring page immediately pop up

Display time 10 s(10-60)

I I T

5) Real-time monitoring interface preview linkage effect is as follows: linkage triggered, pop up the
video playback window.

m 8 Welcome, admin

© Area Status - Device Name Morew @

Device Door Auxiliary Input Auiliary Output

AllDoors || Remote Opening [ | Remoe Closing % Cancel Alam £ Remote Nomally Open = More ~
Device
110 Board ] a |} o =} | ] o

192.168.0. 192.168.10 192.168.10 192.166.1
Door 105-1 2321 2181 761
Reader

x

Auxiliary Input
Awuxiliary Output
Event Type

Current Total:4 @ Online0 & Disable:0 @ Offine:4 & Unknown:0 Door Name

Daylight Saving Time o

_ 5 Real-Time Events
Device Monitoring

Time Area Device Event Point Event Description

T

‘Alarm Monitoring

Map

Access Control

Event Reminder Sounds (¥ Show Photos ¢!

Total Received: 0 @ Normal:0 w Exception:0 @Alarm:0 Clear Data Rows Event Description
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6.4 VMS Client Instructions

6.4.1 VMS Client

» VMS Client Module Function Description

The VMS client is called ZKBio VMS Plugin, and its functionality is similar to that of the VMS server. After
logging into the VMS client, the control panel lists as follows. @10 common function modules (Preview,
Playback, Decoder, Alarm, Log, Device management, User management, Decoder configuration, Alarm

configuration and Local configuration) and (2) Alarm event center.

[

Click the icon in the upper right corner to log out of the system.

L) x (E3

b ©

Users Decoder Alarm Local
management configuration configuration configuration

o Alarm « 4 0

Alarm Time Alarm Type i Alarm Source Alarm State

Click [Preview] to open the client preview interface, and you can select video channel, group and layout
for screen preview. For the operation of preview interface, please refer to Video Preview.
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L] X G
Ed
sss

Preview

Alarm Event « 0

Click [Playback] to open the client playback interface. The function of the playback interface is basically
the same as that of the VMS server. Please refer to Video Record for the operation method.

< ([ .

ans
LLL
L LI

o

&

o

=3

Main Stream ~

ntellige [T]

Alarm
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There are two differences: @ on the client side, you can replay nine video channels at the same time,
while on the server, you can only replay four channels at the same time. @ Add a download
configuration interface.

Download

Location Storage

Channel

Range  2020f/01/01 — 00:00:00

Path

Progress

Click [Decoder] to enter the decoder operation interface. The decoder interface of the VMS client
integrates the three functions of decoder preview settings, decoder preview play and decoder playback
on the VMS server into one interface. Please refer to Decoder Preview Settings, Decoder Preview Play and

Decoder Playback.

ooo pd G

LI
LI
LI
B
(P
oo
oo
oo

eESHDEERELED

Alarm Event o o

Click [Alarm] to enter the alarm report interface. It is the same as the report on VMS, except you can't

Page |197 Copyright©2020 ZKTECO CO,, LTD. All rights reserved.



ZKBio Access IVS User Manual

immediately view the alarm video. If you need to view the alarm video, you can go to the Video Alarm
Report on the VMS server.

User: admin

] ]
' —— e Right: administrator
Eba Control Alarm Time: 2020-01-02 16:49:54

panel Site: Leo

BeginTime  2020/01/02 00:00:00 0 2020/01/02 16:30:24 - Type  Alllype
ALARM SOURCES Alarm Type START TIME END TIME

Motion detection
Mation detection
Mation detection
Motion detection
Votion detection
Area alarm

Motion detection
Motion detection
Motion detection
Motion detection
Motion detection
Motion detection
Votion detection
Motion detection

Motion detection

170alarm logs, 1/12pages

Alarm EUEREN o 4

Click [Log] to query the user's operation record of the video device. The content is the same as that seen
Video Report.

User: admin

Right: administrator

Time: 2020-01-02 17:07:54
Site: Leo

Starttime:  2020/01/02 00:00:00 Endtime:  2020/01/02 23:59:59 : Search

Time User IP address Operation type Target

1-02 15:22:41 admin 192.168.213.133 Login
EGI 192.168.213.133 Logout
admin 19 1 Login
admin Logout
admin 92.1 Logout
admin Login
admin 1 Login
admin 10 Login
admin Login
admin 3 Login
admin 1 1 Logout
admin 127.0.0.1 Login
admin 127.0.0.1 Login

admin 192.168.213.133 Login

Previous
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Click [Device management] to enter the device management interface of VMS client.

- Demdero Group e Layout e Storage o Dec Gn:nupo

Device List
Device name Device type Protocol Type IP address

r B cms

ONVIF

Previous

Alarm Event « 4

Including: O is the Device monitoring interface, which is the same as the information listed in the Video
Device interface on the VMS server. @Decoder management interface, the same as the content of
Decoder. (3 Video group management interface, please refer to Group. @ Video channel layout
management interface, please refer to Layout. ) Storage service configuration interface, please refer to
Storage Server. In the record plan module, right-click to add or delete the record plan. See figure 1 below.

(®Decoder group, please refer to Decoder Grouping.

Page [199 Copyright©2020 ZKTECO CO,, LTD. All rights reserved.



ZKBio Access IVS User Manual

Timing&Alarm Record *

X NN NNNNN]

Mo Pre-record i

Mo Pasl-record =

Click [User management] to enter the user management interface of the system. This interface lists (D all
the users of VMS system, click @ to set different permissions for each user to access the device, map, TV
wall. The admin has all permissions by default.
Users
management

Username User type Operation

administrator Right

achministrator L2
Guest | Rem

EUent N & i
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Right manage

Common right Map right erright

‘ & Maps 4 @ TV Walls
. N 22
« @& cms ! W Tén twing
& EEER
4 0 192.168.213.120
@B CHO1
& 1321334
0 192.168.232.161
om0tz
0 192.168.232.162
om0tz
0 102.168.232.163
om0tz 3

Wl
" 102.168.2

o Walat -

Click [Decoder configuration] to enter the management interface of TV wall. Please refer to TV Wall for
specific setting steps.

"
Decoder
configuration

TV Wall Name State Description Operation

Event « 4
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Click [Alarm configuration] to enter the alarm linkage management interface of the client, and the alarm

linkage setting is the same as Linkage Manager.

Rule Name

Alarm

LLL
L L
L L

Alarm Source

Ed

Enable Description

=]

Click [Local configuration] to enter the system configuration interface of the client. @ Capture,

download, export log path can be set. (2) Different alarm sounds can be set. @The record storage path

can be set. @The client database can be backed up and restored.

Click [Save] to save the configuration.

Alarm Event
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¥ o

>

Interval 1
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7 Temperature Detection

MTD (Mask and Temperature Detection) module is primarily designed to work with the access control
devices which have body temperature detection and mask detection features. It provides real-time
monitoring of temperature and mask detection of all the users and various analysis reports.

7.1 Temperature Management

7.1.1 Real-Time Monitoring

Click [Temperature Detection] > [Temperature Management] > [Real-Time Monitoring].

2020-05-13 14:06:07

Real-Time Monitoring

V[ ——

m oo:15:80

& e !
- aw

The Real-Time Monitoring interface allows the user to monitor the body temperature of the users with
their image captured during verification. The mask and temperature data is collected at every entry and
exit point of the premises if the personnel is registered in the device. There are 3 different categories of
records that are displayed on the monitoring page. They are:

® Personnel with abnormal temperature (masked or unmasked).

® Personnel without a mask.

® Personnel with normal body temperature and mask.
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Real-Time Monitoring

Total0 |_,g§|0 w0 A0

mal Temperature d Body temperature® 370 C ﬂ

Department Da

o I o

i NoMasks N
The system allows the users to set the body temperature threshold which determines the category that
the user data will be recorded i.e Abnormal Temperature or Normal Temperature.

7.1.2 Statistic Panel

Click [Temperature Detection] > [Temperature Management] > [Statistic Panel].

i) o
& 0 ®
Stafistics ViewNormal temperaturePeople
° Temperature Management () Time | Today Personnel ID Department Name
The current query conditions None The current query conditions None
Real-Time Monitoring .\:. Refresh ._:. Refresh
Personnel ID First Name Department Department Name
Mumber
Temperature Raw Record
o
Individual Temperature Record Unmeasured bo

dy temperatur

Abnormal Temperature Record

Department Daily Statistic
Monthly Statistics

Parameters

mperature a
brnormal

Normal temperature [l Temperature abnarmal

Unmeasured body temperature
ol P

The statistics panel provides statistical data for the Administrators to analyze the number of users with
normal body temperature, abnormal temperature, and unmeasured body temperature in a specific time
period. The statistics can be filtered by time i.e., Today, This Week, and This Month.

You can also click on any category on the Pie-chart and the corresponding personnel details will be
displayed on the right side of the interface. Also, personnel can be searched by entering the Personnel ID
or Department Name on the top-right corner of the interface.
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sNote: The statistics are only available for system personnel.

7.1.3 Temperature Raw Record

Click [Temperature Detection] > [Temperature Management] > [Temperature Raw Record].

The Temperature Raw Record displays the reports in event-time order i.e. sequentially as it happens

regardless of Normal Temperature/Abnormal Temperature/Department/Masked/Unmasked. It also

displays the Department Name, Body Temperature, Status, and Photo which a user can check instantly

after verification.

(@) mn &
ZKT=za A O 2
TimsFrom 2000127 W00 | To 2asz I | Name s Toe Regstes

The current query conditions. Time From (2020-01-27 00.00.00) To.(2020-04-27 235959) Type (Registere)

° Temperature Management

* Retresh [ # Expont

Real-Time Monitoring

Record  Event ime AeaName  Oavicanams  EventPont Personnel  FrstName  LastName Departmant Nams Mask Body Orignal  Status Fhoto
number 0 temperature  bocy
temperature
87 20200424 190113 AreaName  ZKMKVSLTD ZKMKVSLTD-1 128128 Roeky Chan 2K7ECO Yes =
36 20200424 190035 AeaName  ZKHKVSLTD  ZKMKVSLTD-1 128128 Roeky chan ZKTECO Yes 837 %37 =
%4 20200424 165010 AreaName  ZKMKVSLTD  ZKHKVSLTD-1 128128 Roeky Chan 2K7ECO Yes 841 3841 =
. w 20200424 184940 AreaName  ZKMKVSLTD ZKMKVSLTD-1 128128 Roeky Chan ZKTECO Yes 851 %51 =
day stabeics 1o W A1 AsMme  ZOKUSTD  ZOKSUDY  mams Ray  Ome adeco ve  me  wa @
Pi 81 20200424 184237 AreaName  ZKMKVSLTD  ZKMKVSLTD-1 128128 Rocky chan zKTECO Yes 882 %52 =
61 2020-04-24 163548 Area Name 1921685243 19216852431 190199 Mia Znao Financisl None 85 %5 =3
L) 2000424163545 AreaName 1921685263 19216852431 180188 Ma nao Nane £ %8 =
™ 20000424 143536 AeaName 1921685218 19216852301 1% Jamie Frando Yes =
17 2000624143534 AreaName 1921685238 1921685231 1 Jamie Frando Yes =
0 20200624 143505 AeaName 1921685238 19216852381 1 Jomie Frando None =
154 2020-04-24 143527 Area Name 192168 5238 192.168.5.238-1 16 Jarmie Frando Yes I~
165 2020-04-24 143531 Area Name 1921685238 19216852381 16 Jamie Frando Yes e
1 0200624143503 AsaName 192168523 19216852381 16 T None (~]
61 2020062 143504 AreaName 1921685213 19216852381 1 Jamie Frando None [~
165 20000624 143532 AreaName 1921685218 19216852381 1 Jomie Frando Yes =
5 20200624 163328 AreaName 1921685243 19216852431 10199 Ma znao Nane %5 55 =
8 20000624 163233 AreaName 1921685203 19216852431 100189 Ma Znao Financial Yes 88 %5 =
7 20000624 163230 AreaName 1921685243 19216852431 190199 Ma znao Financial Yes 85 65 =
% 20000024 162023 AeaName 1921685203 19216852431 19019 Ma Znao Financial Yos 85 %5 orm; =
4 20000624162019 AreaName 1921685243 19216852431 190199 Ma Znao Financial Yes 86 386 ™ =
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Normal
Normal
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Export
1| Temperature+Raw+Record
Record Body Original body
2 number Event Date Area Name Device Name Event Point Personnel ID First Name Last Name Department Name Mask temperature temperature Sta
3 37z 2020-07-01 14:12:04 Area Name 192.168.214. Zdﬁﬁﬁg 192.168.214.249-1 4146 pavay:o) liuliu 1 Department Name Yes 37.0 37.0 Mor
4 37 2020-07-01 14:12:02 Area Name 192.168.214. Zdﬁﬁﬁg 192.168.214.249-1 4146 pavay:o) liuliu 1 Department Name Yes 369 369 Mor
5 3764 2020-07-01 14:06:23 Area Name 192.168.214. Zdﬁgﬁg 192.168.214.249-1 4146 FAVAYN: liuliu 1 Department Name Yes BT BT Mor
6 3763 2020-07-01 14:06:21 Area Name 192.168.214. Zdﬁgﬁg 192.168.214.249-1 4146 pavay:c) liuliu 1 Department Name Yes 3638 3638 Mor
7 3761 2020-07-01 14:06:18 Area Name 192.168.214. 24E§§§ 192.168.214.249-1 4146 Foa liuliu1 Department Name Yes 3BT 3BT Mor
8 3760 2020-07-01 14:06:10 Area Name 192.168. 21424B§§§ 192.188.214.249-1 4148 ravas: | liuliu 1 Department Name: None 369 369 Mor
9 3758 2020-07-01 14:06:08 Area Name 19216321424E§§E 192.188.214.249-1 4148 ravas: | liuliu 1 Department Name: None 369 369 Mor
10 3758 2020-07-01 14:08:08 Area Name 192.168. 214245@& 192.188.214.249-1 4148 ravat: | liuliu 1 Department Name: None 372 372 Mor
" 3751 2020-07-01 14:05:32 Area Name 192.168.214. 249858 192.168.214.249-1 4148 7 liuliu1 Department Name: Yes 368.5 36.5 Mor

Temperature+Raw+Record

& Note:

If the Personnel ID field is blank, it represents a Visitor.

“Body Temperature” can be revised in “Abnormal Temperature Record”.

7.1.4 Individual Temperature Record

This report displays all the body temperature details of a User or Personnel daily.

ZK

0

@

Temperature Management
( * Refrash [ Export

Real-Time Monitoring

Fersonnel D First Name
Statistics Panel
L 4
mperature Raw Record
Abnormal Temperature Record
Departmental body temperaturs
daily statistics report
Parameters
128128 Rocky
1236 Jackis
1234567 hshsh
1120188 Mia

101
100 oven

1

Time From |2020-02-13 00:00:00

Last Name

Brown

Chan

Zhao

xiong

To | 2020-05-13 23:58:59

Name

The current query conditions Time Fram:(2020-02-13 00:00:00) To:(2020-05-13 23:50:50)

Personnel ID

Department Depsriment Nsme  Event time
Number
1 Department A 2020-05-07
100 Depsriment B 2020-05-07
100 Department B 2020-04-30
100 Depsriment B 2020-05-08
1 Department & 2020-04-23
1 Department A 2020-05-08
1 Department & 2020-04-24
1 Department A 2020-04-30
1 Depariment A 2020-04-24
1 Department A 2020-04-24
1 Depariment A 2020-05-08
1 Department A 2020-04-24
1 Depariment A 2020-04-24
100 Department B 2020-04-20
Ingenieria Ingenieris Dessrroll 2020-05-07

Click Body Temperature to view the details of each record.
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Welcome, admi

worer Q. @
Body tempersture: Status.
! 35535 as8as 367.357 Morms!
3 - 36.16,/- - 36.21,36.18,36.95 36.21,36.2 36.01.36.04,358] Normal
35,6235 62 36.15.36.15.26.21.36.21.36.19.26. 10.38.12.36.13.36.2. 36 2. Normas|

26.51,26 51,38 52,36 52,96 26 26,36, 36. 44,38 55 36 56,36,56,96 58,285 Normal

5.3 37.37.0. Norms!

37.51,37.41,37.58 -i-.20.98,36.98,35.94.36.04,36.56,36.85,36.04,36.94.3 Exception

The “Original body temperature” is usually measured by the device, and it can’t be modified. But the

n

6.6.36.4.36.6,36.5.36.5.30.6.36.4.30 4 36.5,36.4.30.4.36.5.36.5.36.8.36, Normal
36.3,36.2.38.3,38.3 Nermal
7.1.27.1.28.27 26.37.36,41.36 4126 43 28 49 26 5136 513552 38 52 Normsl
-1-.36.5,36.5,36.4.35.4,36.5,36.5,36.3,36.3, Normal
36.02.38.0 Normal
6.5,36.5,36 6,36.6,36.5.36 5,36 5,38 5,36 5,36 5,36 5,36 5,36.5,36.5,36. Normal
5.4.36.4.26.3,36,3,36.5 6.5 36,5 28 5 36.5,36.5 26 6.36.5.35.4.36.4.38, Normal
Unmnessured
4167410734 12341334234 2 24 18,34 18 24 1524 15,34 21 24 21 | Exception
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Edit
"% Refresh I
Area Name Device name Ewent Point Personnel First Name Last Mame Department Mask Body Original Status Photo
D Name temperature  body
temperature

52731 Area Name Barnes-test Barnes-test-1 2 Department & Yes 3751 3751 Exception ] A
5:27:05  Ares Name Barnes-test Barnes-test-1 2 Department A Yes T4 T4 MNormal (=]

5:27:02  Ares Name Barnes-test Barnes-test-1 2 Department A Yes 37.58 3758 Exception (]

5:26:17  Area Name Barnes-test Barnes-test-1 2 Department A Yes Unmeasured [

1:13:58  Ares Name 192.168.5.239 192.188.5.2391 z Financial Yes 36.95 36.95 Mommal ]

1:13:46  Ares Name 192.168.5.239 192.168.5.239-1 2 Financial 36.94 36.94 Mommal (=]

1:13:44  Ares Name 192.168.5.239 192.168.5.239-1 2 Financial 36.86 36.86 Mommal ("]

1:08:51  Area Name 192.166.5.229 192.166.5.239-1 2 Financial Yes 36.94 36.94 Mormal ]

10845  Ares Name 1921685239 192188 5 2391 2 Financial Yes 36.87 36.87 Mommal ]

1:08:46  Ares Name 192.168.5.239 192.168.5.239-1 2 Financial Yes 3708 7.08 Mommal (]

1:08:43  Ares Name 192.168.5.239 192.168.5.239-1 2 Financial Yes 36.95 36.95 Mommal ("]

1:05:03  Ares Name 192.166.5.229 192.166.5.239-1 2 Financial Yes ke v Mormal ]

10500 Ares Name 1921685239 192188 5 2391 2 Financial Yes 3724 3724 Mommal ] e
iN453  Ares Name 107 1RR 5 730 107 1RR & 7301 ) Finanrisl Var K1der] a7 77 Mnrmal (] 5

1-50 > >l S0 rows per page = JumpTo 1 /2Page  Total of 59 records

7.1.5 Abnormal Temperature Record

It displays the record of exceptional body temperatures i.e. above the body temperature threshold and the
temperature of personnel which is not detected.

Click [Temperature Detection] > [Temperature Management] > [Abnormal Temperature Record].

A& 0 O

Time From | 2020-04-21 00.00.00 | To |2020-07-2123:59:59 Name Processing status ——— Morer Q@

The current query conditions Time From.(2020-04-21 00.00.00) To:(2020-07-21 23.59.59)

a Temperature Management (=)

(v Refresh [ # Expot Q) Enquiry of Persons in Close Contact with Suspected Cases

Real-Time Monitoring

Event Date AreaNams Device Nams  Personnel FirstMame Last Name Depsrtmen Mask Body Status Prosessing fime Processing Prosessor Remark  Process
- o Name temper: method status
Statistics panel ;
UL VB O U 2 - aran nuny .
Temperature Raw Record 2020-07-21 15:00:4  Nom de zon¢ 249 4146 liuliu Unmeas
s T T T 2020-07-21 14:43:05  Nom de zone 243 None 371 Exceptic
2020-07-21 14:47:45  Nom de zone 71 None 372 Exceptic
2020-07-21 14:47:43  Nom de zone 249 None 371
Department ly Statistic
2020-07-21 14:47:39  Nom de zone 249 None 3
[ T 2020-07-21 14:47:35  Nom de zone 248 4146 [ Yes 372
Parameters 2020-07-21 14:47:14  Nom de zone 249 37
2020.07-21 14:47:12  Nom de zone 4 £l
2020-07-21 14:47:10 Nom de zone 43 372
2020-07-21 14:47:07  Nom de zone 43 E2l
2020-07-21 14:47:05  Nom de zone 4243 372 Exceptio
2020-07-21 14:47:02  Nom de zone 249 373 Excesiic

A user can click on ‘Edit’ options to do further operation such as revise the user’s body temperature by
manual measurement. The following window pops-up:
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Body temperature”
Processing method”
Processor®

Remark

36.2
Manual measurement

admin

After manual measure
the body temperature, it
is normal.

Inquiry of Persons in Close Contact with Suspected Cases

It will help the user to check the personnel who had contact with any suspected persons.

Enter the

contact time, 1 to 120 minutes is applicable.

Time From |202n.m.21 D0:00:00 | To |2umn7.21 23:59:59 ‘

Processing status - More™

MName |

The current query conditions Time From:(2020-04-21 00:00:00) To:(2020-07-21 23:59:59)

(» Refresh [ # Export (O Enquiry of Persons in Close Contact with Suspected Cases

Event Date Area Mame  Device Name Personnel  First Name  Last Name Departmen  Mask Body  Status P
LD I I _ MName temper:
[ ULUUi-21 130U o ue zone | Condition I UnimeEs
|| 2020-07-21 15:00:49 Nom de zone Unmeas
Clese contact time {minutes)”
v 2020-07-21 14:48:06 Nom de zone MNone 371 Exceptia
|| 2200721144746 Nomdezone , - I I — None 372  Exceptic
| | 2020-07-21 14:47:43  Nom de Zone o None 37.1  Exceptic
| | 2020-07-21 1447:33 Nom de zone |Nnne kTl Exceptia
| | 2020-07-21 14:47:35 Nom de zone Yes 372 Exceptic
| | 2020-07-21 14:47:14  Nom de zone | 37 Exceptio
|| 2020-07-21 14:47:12  Nomde zone [5EH7.249 i Exceptic
Click OK to view the search results.
Intimate Contact of Suspected Case
Abnormal Temperature | List of Persons in Close Contact
Event time AreaName  Device name  Event Point Personnel First Name Last Name Depariment ~ Mask Body Status Photo
([n] Name temperatu
2020-06-18 11:55:] Area Name  192.168.5.239 19216852331 0 Yes 372 Normal =]

37.6°C
Person ID: 678
First Name: William
Last Name:

Mask: Yes

Department: Department Name
2020-06-18
11:53:27

Time:

1-1 50 rows per page ~
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7.1.6 Department Daily Statistics

It displays the department-wise temperature detection records. A user can select a department from the
list of departments in the left panel which displays the number of persons with normal temperature,
abnormal temperature, and unmeasured in the specific department daily. It also displays the proportion of
abnormal body temperature.

Time From 20200127 00.60.00 | To 2020-04-27 235050 Department Number Depariment Name Q ®

B The current query conditions Time From: (2020-01-27 D000-00) To/(2020-D4-27 2350 50)
o Temperature Management (—)

ae (* Refresh [ # Export
Real-Time Monitoring =
Financia(@)
Depariment  Depariment Name  Event time No ofpecpie  The numberof  Number of Actuai number  Total number of  Proporion of abnormal body temperature
Number ith normal abnarmal body paople who 5
temperature temperature have not
Temperature Raw Record [L;T;::g‘“
Personnel Temperature »
L 1 Financial 20200424 4 2 1 7 e 4286%
1 Financial 2020-04-23 ] 3 [ 3 [ 100%

Abnormal Temperature Record

Paramelers

7.1.7 Monthly Statistics

Click [Temperature Detection] > [Temperature Management] > [Monthly Statistic] to view the
infographics of monthly temperature detection.

g & e

Monthly Statistics

Month  2020-07

0 Temperature Management (=)

The current query conditions None

Real-Time Monitoring @B Abnormal B Normal ([l Unmeasure d
Statistics panel
150+
Temperature Raw Record
Individual Temperature Record
Abnormal Temperature Record
120
Department Daily Stafistic
2
Abnormal: 0
Parameters 90 Normal: 0
Unmeasured: 0
60
30+

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31

7.1.8 Parameters

It allows the user to set the body temperature threshold which determines the category to which the
recorded temperature falls-in i.e Abnormal Temperature or Normal Temperature. For example, assume that
the threshold temperature is set to 37.3°C. If the recorded temperature is 37°C, it will be saved as “Normal
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Temperature” and if the recorded temperature is 38°C, it will be saved as “Abnormal Temperature”. The

temperature unit can also be chosen between °C or °F.

Temperature Management (—)

Real-Time Monitoring
Statistics panel

Temperature Raw Record
Individual Temperature Record
Abnormal Temperature Record
Department Daily Statistic

Monthly Statistics

Temperature threshold satting

Body temperature® 37.0

Unit*

®COF

&sNote: After setting the body temperature threshold, the Real-Time Monitoring Page will refresh, and the

persons will be categorized according to the new threshold temperature.
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8 System Management

System settings primarily include assigning system users (such as company management user,
administrator, and access control administrator) and configuring the roles of corresponding modules,
managing database, setting system parameters, and view operation logs, etc.

8.1 Basic Management

8.1.1 Operation Logs

Click [System] > [Basic Management] > [Operation Log]:

@ Operation User Operation Time From To Moer Q@

The current query conditions None
E Basic Management G

(% Refresh [ % Export
s Operation  Operation Time Operation IP Module Operating Operation  Operation Content Result Elapsed Time

S o T Milliseconds;
Database Management i ype Wi )

admin 2018-12-28 02:41:46 172.31.1.10 Access Access Rights Export Export 9 15 =
Area Setting
admin 2018-12-28 02:41:45 17231.1.10 Access Access Rights  Export Export 9 13
Deperime admin  2018-12-28 02:41:43 172.31.1.10 System  User User Login - User Login:admin; ° 0
E-mail Management admin 2018-12-28 02:36:19 172.31.1.10 Access Access Rights  Export Export 9 16
Data Cleaning admin 2018-12-28 02:36:18 17231.1.10 Access Access Rights  Export Export 9 19
. admin 2018-12-28 02:28:10 172.31.1.10 Access All Exception E Export Export Failed (-] 20016
Audio File
admin 2018-12-28 02:28:11 172.31.1.10 Access All Exception E Export Export 9 1234
admin 2018-12-28 02:22.07 172.31.1.10 Access Last Known Po Export Export 9 15
admin 2018-12-28 02:22:06 172.31.1.10 Access Last Known Po Export Export 9 26
admin 2018-12-28 02:14:15 172.31.1.10 Access All Transaction Export Export Failed -] 42014
admin 2018-12-28 02:14:19 172.31.1.10 Access All Transaction Export Export 9 4970
admin 2018-12-28 01:58:14 172.31.1.10 Access Device Search Devi Search Device 9 23438
admin 2018-12-28 01:53:59 172.31.1.10 Access Linkage Edit Linkage Name Test; o9 116
admin 2018-12-28 01:48:58 172.31.1.10 System User User Login  User Login:admin; 9 0
= admin 2018-12-28 01:26:31 17231.1.10 System User User Login  User Login:admin; ] 0
EI] Authority Management  (3)
S0 = admin 2018-12-27 23.07:43 172.31.1.10 Access Holidays Edit Holiday Name:New Year, 9 73 v

1 communication ®
Q

1-50 > 2 50 rows per page ~ JumpTo 1 /3Page  Total of 133 records

All operation logs are displayed on this page. You can query specific logs by conditions.

Export: Export the operation log records, save to local. You can export to an Excel, PDF, or CSV file.
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Operation Log
O peration Operation Time 0 peration [P Module | Operating | Operation Operation Content Result Elapsed
User Object Type Time
(Millisecon
ds)
admin 2018-12-28 02:41:46 172.31.1.10 Access Access Export Export 0 15
Rights By
Personnel
admin 2018-12-28 02:41:45 172.31.1.10 Access Access Export Export 0 13
Rights By
Personnel
admin 2018-12-28 02:41:43 172.31.1.10 System User User Login User Login:ad min 0
admin 2018-12-28 02:36:19 172.31.1.10 Access Access Export Export 0 16
Rights By
Door
admin 2018-12-28 02:36:18 17231110 Access Access Export Export 0 19
Rights By
Door
admin 2018-12-28 02:28:10 172.31.1.10 Access All Export Export Failed 1 20016
Exception
Events
admin 2018-12-28 02:28:11 172.31.1.10 Access All Export Export 0 1234
Exception
Events
admin 2018-12-28 02:22:07 172.31.1.10 Access  |Last Known| Export Export 0 15
Position
admin 2018-12-28 02:22:06 172.31.1.10 Access |Last Known| Export Export 0 26
Position
admin 2018-12-28 02:14:15 172.31.1.10 Access All Export Export Failed 1 42014
Transaction
s
admin 2018-12-28 02:14:19 172.31.1.10 Access All Export Export 0 4970
Transaction
S
8.1.2 Database Management
Click [System] > [Basic Management] > [Database Management]:
@ Username [l J Q ®
The current query conditions None
E Basic Management
(?v Refresh 5] Backup Immediately 5\ Backup Schedule
Operation Log
Usermame Start Time Database Version Backup Immediately Backup Status Backup Path Operations
admin 2018-12-21 18:00:01 4001 (-] E:\SecurityDBBack\ Delete
Area Setting admin 2018-12-21 14:27:02 4001 E:\SecurityDBBack\ Delete

History of database backup operation logs is displayed in this page. You can refresh, backup and schedule

backup database as required.

® Backup Immediately

Backup database to the path set in installation right now.

#Note: The default backup path for the system is the path selected during the software installation. For
details, refer to ZKBio Access Installation Guide.

® Backup Schedule
Click [Backup Schedulel:
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Backup Schedule

Backup Schedule

From | 2014-08-08 18:00:00 Start Every 7 ¥ |Day

The last backup time:2018-12-21 18:00:01
The next backup time:2018-12-29 18:00:00,left 1 day 15 hour 2 minute 47 second.

Prompt

A\ The backup copy of the database, the database server and the server must be on the
same computer. If the backup fails, please refer to the user manual in users of the

FAQ

Set the start time, set interval between two automatic backups, click [OK].

® Restore Database
Click the start menu of the PC > [All Programs] > [ZKBio Access] > Then run “Services Controller”, and
you can find out the icon of “Services Controller” in Taskbar as follow, right click that icon, then left

click “Restore Database”.

. ZKBioAccess
0 Environment Testing Tools
(2] Services Controller
%' Uninstall ZKBioAccess
D ZKBioAccess

Caonfiguration Database Local Backup Path

Restore Database
Sernvice is running, click here to stop

Exit
2. Inthe popup window, click [Browse] to choose the backup file to restore the database.
& Note: Before restoring a database, it is recommended that you back up the current database to avoid

data loss.
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Restore Datapase

-Restore Database
Please select afile to restore the database:

| | | Browse...

| 0%

8.1.3 Area Setting

Area is a spatial concept which enables the user to manage devices in a specific area. After area setting,

devices (doors) can be filtered by area upon real-time monitoring.

The system, by default, has an area named [Area Name] and numbered [1].

® AddanArea
Click [System] > [Area Setting] > [Area] > [New]:

New

If the new area in the area failed tc show the list, please contact the
administrater to re-authorize the user to edit the areal

Area Number® ‘ |

Area Name*
Parent Area” Area Name

Remark

Coveaanen 0 Jcareo

Fields are as follows:

Area Number: It must be unique.

Area Name: Any characters with a length of less than 30.

Parent Area: Determine the area structure of the system.

Click [OK] to finish adding.
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® Edit/Delete an Area

Click [Edit] or [Delete] as required.

8.1.4 E-mail Management

Set the email sending server information. The recipient Email should be set in Linkage

Click [Basic Management] > [Email Management] > [Email Parameter Settings]:

@ Sender \ Receiver |:| Q ®

The current query conditions Nur!

(+ Refresh (i} Delete [] E!

Email Parameter Settings

=EJ Basic Management

Operation Log 1 Email Parameter Settings
| | Sender FI ) ) i
Bmliass MmiEsm | Email Sending Server’ | (smtp xxx xxx)
Port™ 25 _JSSLITLS
ieaisiing Email Account” (R @ RXX XXX)
Department Password™
Sender Name
Data Cleaning Prompt
Audio File A 1.Please fill in the correct mailbox parameters
A\ 2.Confirm the filled in mailbox SMTP service is provisioning
A\ A mail of connection test will be sent to your designated mail box

Test Connection

N T

&Note: The domain name of E-mail address and E-mail sending server must be identical. For example, if
the Email address is: test@gmail.com, then the E-mail sending sever must be: smtp.gmail.com.

8.1.5 Data Cleaning

The data cleaning time settings are available to set. The data volume increases with the use of the system.
To save the storage space on the disks, you need to periodically clean old data generated by the system.

Click [Basic Management] > [Data Cleaning]:
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(O) Rocord
E Basic Manag nt = Access Transaction Retains the recent 15 v months of data Execution Time 01:00.00 v
G Syst
Operation Log ystem
System Operation Log* Retains the recent 15 v months of data Execution Time 03.00.00 v
Database Management
Device Commands* Retains the recent 6 v months of data Execution Time 02.00.00 v Immediately Clean Up
Area Setting Database Backup File* Retains the recent 6 v months of data Execution Time 04:00.00 v Immediately Clean Up
Department
Prompt
E-mail Management
g A«
Data C g A Ex
AV

Audio File

Ei'é Authority Management

B | Communication N “
=)

The system executes [Immediately Clean Up] operation after it is clicked and [OK] is clicked. Without
clicking [OK], the system will not clean data.

&Note: In order to reduce the load of the system and not to affect the normal running, the cleaning time
should be set at 1 o’clock am.

8.1.6 Audio File

Click [Basic Management] > [Audio File] > [New]:

@ File Alias ‘ Q ®

The current query conditions None
B0 gasic Management it

23
Operation Log T = T T )
O Suffix Operations
Database Management S
D Ala"n 20KB nnnnn =it
Area Setting 57
Department File Upload” Not Uploaded |Browse| Play
File Alias™ [| :
E-mail Management
Size
Data Cleaning Suffix :
A Please upload a wav or MP3 file, the size of 0 to 10MB!

(oo 0 R cone |

You can upload a sound from the local. The file must be in wav or mp3 format, and it must not exceed
10MB.
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8.2 Authority Management

8.2.1 User

Add new users and implement levels for the user in the system.

1. Click [System Management] > [Authority Management] > [User] > [New]:

® T — e
IﬁDI Basic Management Jne eurent query,conditions Hone Username® Superviser
- (C* Refresh New ﬁ" Delete ] Username should be composed between 1-30 characters and
I.'I'.l Authority Management o UmEm — | in letters,numbers,or symbols (@//-f+/_) [ po—
| Password®  esaew
[ ] admin admin Password is a composition of 4 to 18 characters default is (]
1ML
Confirm Password® | seeee
State Enable
Superuser State ]
Role Monitoring Clerk
Auth Department Development Departme
If you select no department, you will possess all department
rights by default.
Authorize Area Area Mame
If you select no area, you will possess all area rights by
default
Email
First Name
o
E,I Conpuricatics 1€ < 1-1 > 3l 50 rows perpage ~ JumpTo 1 /1 Page  Total of 1 records.

Fields are as follows:

Username: Any characters within a length of 30.

Password: The length must be more than 4 digits and less than 18 digits. The default password is 111111.
State: Enable or disable the user to operate the system.

Super User State: Enable or disable the user to have the super user’s levels.

Role: You need to define the role as explained in Role.

Auth Department: If no department is selected, then the user will have all department rights by default.
Authorize Area: No area selected means the user possesses all area rights by default.

Email: Type your email in the correct format.

First Name: Type your initials.

2. After editing, click [OK] to complete user adding, and the user will be shown in the list.

Click [Edit] or [Delete] as required.
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8.2.2 Role

When using the system, the super user needs to assign different levels to new users. To avoid setting users
one by one, you can set roles with specific levels in role management and assign appropriate roles to users
when adding users. A super user has all the levels, can assign rights to new users and set corresponding
roles (levels) according to requirements.

1. Click [System] > [Authority Management] > [Role] > [New]:

m‘: Weicome, admin *:C:P ® @ @ C)
@ Role Name Q ®

The current query conditions None

(Hn) i
o Basic Management

(> Refresh [ New (i} Delete

L'I] WIS ) RoleCode N\ Role Name Creation Time Operations
User \
. Click to Add

E?CJ Commescabon 14 50rowsperpage ~ JumpTo 1 /1Page  Total of 4 records

2. Set the name and assign permissions for the role.

Welcome, admin ~ ©

= Role Code”
L] Basic Man:
Role Name” Management

fh Authority M Assign Permissions

Personnel Access System

User 4 M Personnel Management

S —TE————

4 MU Personnel N \\‘ 5
@D Refissh N 3. Define system role
v [ New \
] Adjust Department \.
v [ Delete X
<[] Export Personnel 2. Define access role
v [1 Import Personnel
v [ statistics
v [ Edit 5
[} Export Biometric Template '\ 1. Select aCCOrdlngly
(] Export Personnel Photo
D Import Biometric Template
™ tmnnct Aacnanmal Dhata -
selectAll [H)
|
o
Comeuncstion e« 1% > 3 50rows perpage = JumpTo 1 1 Page  Total of 4 records

3. Click [OK] to save.
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8.3 Communication

8.3.1 Device Commands

Click [System] > [Communication] > [Device commands], the commands lists will be displayed.

(G) Submit Time From To Serial Number Back To Results Moer Q@

5] = The current query conditions None
EE Basic Management (& sl
"+ Refresh " Clear Commands [ Export

[i] Qutoty Naiagemeotis D Serial Number Content Immediatel - Submit Time Return Time Returned Remark
Cmd Value
ED Communication ( 3633160800001 DATA UPDATE inoutfun Index=1 EventType=0 InAddr=1 OutType=0 OutAddr=1 Ou! @ 2018-12-28 01:53:59 =
3633160800001 DATA UPDATE inoutfun Index=1 EventType=0 InAddr=1 OutType=0 OutAddr=1 Ou! @ 2018-12-28 01:53:59
3633160800001 DATA UPDATE holiday Holiday=20190101 HolidayType=1 Loop=1 ° 2018-12-27 23:07:43
Communication Device 3633160800001 DATA DELETE holiday * ° 2018-12-27 23.07:43
Communication Monitor CGFE184760043 DATA UPDATE holiday Holiday=20190101 HolidayType=1 Loop=1 -] 2018-12-27 23:07:43
CGFE184760043 DATA DELETE holiday * -] 2018-12-27 23:07:43
3633160800001 DATA UPDATE timezone Timezoneld=2 SunTime1=0 SunTime2=0 SunTime3=0 Mc @ 2018-12-27 20:33:27
CGFE184760043 DATA UPDATE timezone Timezoneld=2 SunTime1=0 SunTime2=0 SunTime3=0 Mc @ 2018-12-27 20:33:27
3633160800001 DATA DELETE outrelaysetting Num=1 -] 2018-12-27 14.28:16  2018-12-27 142819 0
3633160800001 DATA UPDATE Pin=432 1 AuthorizeDoorld=3 | @ 2018-12-27 13:56:42  2018-12-27 135658 0
3633160800001 DATA UPDATE extuser Pin=1 FunSwitch=0 Pin=2 FunSwitch=0 Pin=343 FunSwitch @ 2018-12-27 13.56:42  2018-12-27 135658 0
3633160800001 DATA UPDATE user CardNo=547657 Pin=1 Password= Group=0 StartTime=0 End1 @ 2018-12-27 13:56:42 2018-12-27 13:56:58 0
3633160800001 SET OPTIONS DefWGFmt__ -] 2018-12-27 13:56:42 2018-12-27 13:56:58 1
3633160800001 SET OPTIONS MachineTZ=+0800 o 2018-12-27 13:56:42  2018-12-27 135658 1
3633160800001 DATA UPDATE timezone Timezoneld=1 SunTime1=2359 SunTime2=0 SunTime3=C @ 2018-12-27 13:56:42  2018-12-27 13:56:58 0
3633160800001 SET OPTIONS Reader4Of Reader20f  Reader10fflineR @ 2018-12-27 13:56:42  2018-12-27 13:56:48 1 7
>
1-50 > > S0rowsperpage ~ JumpTo 1 /2Page  Total of 91 records

If the returned value is more than or equal to 0, the command is successfully issued. If the returned value
is less than O, the command failed.

Clear Commands: Clear the command lists.

Export: Export the command lists to local host. You can export to an Excel file. See the following figure.

Device
Commands
| 0 Serial Number Content Immediately Cmd| Submit Time Return Time Returned Value

DATA UPDATE
userauthorize
Pin=2AuthorizeTi
mezoneld=1Auth

1504 20100501999 | orizeDoorld=1 false 23:]75]21;8 23[1]75122]8 0
Pin=1AuthonizeTi - T
mezoneld=1Auth
orizeDoorld=1

DATA UPDATE
mulcarduser
Pin=2CardMo=5d
ec02LossCardFla

1502 20100501999 | g=0CardType=0 false 23;?512118 23[1]7512218 0
Pin=1CardMo=44 o o
12c5lossCardFla
g=0CardType=0
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8.3.2 Communication Device

Click [System] > [Communication] > [Communication Device], the device list will be displayed:

(G) Module Device Serial Number Device Name Moer Q. ®

The current query conditions None

0
CB Basic Management

(+ Refresh  Q View Authorization Device

\K_.'E Authority Management @ Module Device Senal Device Firmware Device Name Device Address  Subnet Mask Gateway Enable Status Executory Command Count
Number
i[j Communication &) acc 3633160800001 AC Ver 576.3026 Aug 8 2015 inBIO260 Pro 19216821399  255255255.0 192.168.213.1 9 Offline 5
acc CGFE184760043 1.055 SpeedFace-V5 19216821367 255.255255.0 192.168.213.1 9 Offline 3

Device Commands

Communication Monitor

8.3.3 Communication Monitor

Click [System] > [Communication] > [Communication Monitor], the device service port and its details will
be displayed:

@ Adms Service Settings

EB Basic Management @ Adms Service Port 8881
A\ The current port is for device communication service, if there is @ network mapy g for the service port, please refer to the actual i

E%A Authority Management
i Communication
(|

Device Commands

Communication Device

& Note: While installing ZKBio Access, you need to put port number properly.
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1) Setup - ZKBioAccess (=N X

New Ul Design

Elegant and user-friendly
design with professional
access control logic

Please enter a valid port from 10-65535 (except 21,80,6380 and 5432)

Web Access Port 8098 Device ADMS Port 8088 [ <Back | [ concel | [ next> |

Add exception to the firewall

ADMS port is used to connect to the device and the web access port is used to access the website.
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Appendices

Common Operations

® Select Personnel

The selected personnel page in the system is as below:

@ Access Levels  Browse Personnel Level 1 (Area theIme Levels
38 Device Level Name Time Zone Q ® | ‘ Personnel ID Name Morey Q. ® ‘
Add Personnel ‘
Access Control @ Conditional Query () Department
P Personnel ID Name Card Number Morey Q. ® ot oo D orarent
The current query conditions None I
Holidays . Development Depart
Alternative Selected(0)
Access Levels
Personnel  First Last Card Gender  Departm Personnel  First Last Card Gender  Departm
ID Name Name Number ID Name N- Number
1 abc — Marketing 7=
Set Access By Person
>
Set Access By Department 5 Cl]ck to expand
Interlock £
Linkage
<« »
Anti-Passback 1-1 50 rows per page ~ 7 )
First-Person Normally Open

Multi-Person Opening Door

Multi-Person Group ’

ifj Reports

1« ¢ 13 5 5 S50rowsperpage v JumpTo 1 MPage & < 11 5 5 50rowsperpage v JumpTo 1 lPage

You can select the personnel from the list generated, or you can also click [More] to filter by gender or
department.

Click = to move the selected personnel into the selected lists. If you want to cancel the movement, click
L

Click on the Year to select by clicking or .Click the Month and Date to select directly.

® Import (take the personnel list importing as an example)
If there is a personnel file on your computer, you can import it into the system.

1. Click [Import]:

Import Personnel

File Format (@) Excel

Select File Choose file |No file chosen

The default is the second row.
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Fields are as follows:

Destination File: Choose the file to be imported.
2. Click [OK]:

The data is imported successfully.

& Notes:

(1) When the importing department table, department name, and department number must not be
empty, the parent department can be empty. The duplicated number does not affect the operation, it
can be modified manually.

(2) When importing a personal table, a personnel number is required. If the personnel number already
exists in the database, it will not be imported.

® Export (take the personnel list exporting as an example)
1. Click [Export]:

Export |

The File Type EXCEL File \d
Export Mode (®) All data (export up to 30000 pieces of data)
() Select data volume export (export up to 30000 pieces of data)

From the article 1 Strip, is derived 100 Data \

.

2. Select the file format and export mode to be exported. Click [OK].
3. You can view the file in your local drive.

&Note: 10000 records are allowed to export by default, you can manually input as required.

Access Event Type

® Normal Events

Normal Punch Opening: In [Only Card] verification mode, the person having open door levels punch card
at a valid time period, open the door, and trigger the normal event.

Normal Press Fingerprint Opening: In [Only Fingerprint] or [Card or Fingerprint] verification mode, the
person having open door levels press fingerprint at a valid time period, the door is opened, and trigger the
normal event.

Card and Fingerprint Opening: In [Card and Fingerprint] verification mode, the person having the open
permission, punch the card and press the fingerprint at the valid time period, and the door is opened, and
trigger the normal event.

Exit button Open: Press the exit button to open the door within the door valid time zone and trigger this
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normal event.

Trigger the exit button (locked): Indicates the normal event triggered by pressing the exit button when
the exit button is locked.

Punch during Normal Open Time Zone: At the normal open period (set normal open period for a single
door or for first-person normally open), or through the remote normal open operation, the person having
open door permission punch effective card at the opened door to trigger this normal event.

Press Fingerprint during Normal Open Time Zone: At the normal open period (set normal open period
for a single door or for first-person normally open), or through the remote normal open operation, the
person having open door permission press the effective fingerprint at the opened door to trigger this
normal event.

First-Person Normally Open (Punch Card): In [Only Card] verification mode, the person having first-
person normally open permission, punch at the setting first-person normally open time period (the door
is closed) and trigger the normal event.

First-Person Normally Open (Press Fingerprint): In [Only Fingerprint] or [Card plus Fingerprint]
verification mode, the person having first-person normally open permission, press the fingerprint at the
setting first-person normally open period (the door is closed), and trigger the normal event.

First-Person Normally Open (Card plus Fingerprint): In [Card plus Fingerprint] verification mode, the
person having first-person normally open permission, punch the card and press the fingerprint at the
setting first-person normally open period (the door is closed), and trigger the normal event.

Normal Open Time Zone Over: After the normal open time zone over, the door will close automatically.

Remote Normal Opening: When setting the door state to normal open in the remote opening operation,
this normal event is triggered.

Cancel Normal Open: When Punch the valid card or use the remote opening function to cancel the current
door normal open state, this normal event is triggered.

Disable Intraday Passage Mode Time Zone: Indoor normal open state, punch effective card for five times
(must be the same user), or select [Disable Intraday Passage Mode Time Zone] in remote closing operation
and this normal event is triggered.

Enable Intraday Passage Mode Time Zone: If the intraday passage mode time zone is disabled, punch
effective card for five times (must be the same user), or select [Enable Intraday Passage Mode Time Zone]
in remote opening operation, and this normal event is triggered.

Multi-Person Opening Door (Punching): In [Only Card] verification mode, Multi-Person combination can
be used to open the door. After the last card is verified, the system triggers this normal event.

Multi-Person Opening Door (Press Fingerprint): In [Only Fingerprint] or [Card plus Fingerprint]
verification mode, Multi-Person combination can be used to open the door. After the last fingerprint is
verified, the system triggers this normal event.

Multi-Person Opening Door (Card plus Fingerprint): In [Card plus Fingerprint] verification mode, Multi-
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Person combination can be used to open the door. After the last card plus fingerprint is verified, the system
triggers this normal event.

Emergency Password Opening Door: Emergency password (also known as super password) set for the
current door can be used for door open. This normal event will be triggered after the emergency password
is verified.

Opening Door during Normal Open Time Zone: If the current door is set a normally open period, the
door will open automatically after the set start time has expired, and this normal event will be triggered.

Linkage Event Triggered: After linkage configuration takes effect, this normal event will be triggered.

Cancel Alarm: When the user cancels the alarm of the corresponding door successfully, this normal event
will be triggered.

Remote Opening: When the user opens a door by [Remote Opening] successfully, this normal event will
be triggered.

Remote Closing: When the user closes a door by [Remote Closing] successfully, this normal event will be
triggered.

Open Auxiliary Output: In linkage setting, if the user selects Auxiliary Output for Output Point, selects
Open for Action Type, this normal event will be triggered when the linkage setting takes effect.

Close Auxiliary Output: In linkage setting, if the user selects Auxiliary Output for Output Point, selects
Close for Action Type, or closes the opened auxiliary output by [Door Setting] > [Close Auxiliary Output],
this normal event will be triggered.

Door Opened Correctly: When the door sensor detects the door has been properly opened, triggering
this normal event.

Door Closed Correctly: When the door sensor detects the door has been properly closed, triggering this
normal event.

Auxiliary Input Point Disconnected: Will be triggered auxiliary input point is disconnected.
Auxiliary Input Point Shorted: When the auxiliary input point short circuit, trigger this normal event.

Device Start: Will be triggered if the device starts (This event of PULL devices will not appear in real-time
monitoring and can be viewed only in event records of reports).

® Abnormal Events

Too Short Punch Interval: When the interval between two punching is less than the set time interval, this
abnormal event will be triggered.

Too Short Fingerprint Pressing Interval: When the interval between two fingerprints pressing is less than
the set time interval, this abnormal event will be triggered.

Door Inactive Time Zone (Punch Card): In [Only Card] verification mode, if the user having the door open
permission punch but not at door effective period of time, this abnormal event will be triggered.

Door Inactive Time Zone (Press Fingerprint): If the user having the door open permission, press the
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fingerprint but not at the door effective time period, this abnormal event will be triggered.

Door Inactive Time Zone (Exit Button): If the user having the door open permission, press the exit button
but not at an effective period of time, this abnormal event will be triggered.

lllegal Time Zone: If the user with the permission of opening the door punches during the invalid time
zone, this abnormal event will be triggered.

lllegal Access: If the registered card without the permission of the current door is punched to open the
door, this abnormal event will be triggered.

Anti-Passback: When the anti-pass back takes effect, this abnormal event will be triggered.
Interlock: When the interlocking rules take effect, this abnormal event will be triggered.

Multi-Person Verification (Punching): When Multi-Person combination opens the door, the card
verification before the last one (whether verified or not), this abnormal event will be triggered.

Multi-Person Verification (Press Fingerprint): In [Only Fingerprint] or [Card or Fingerprint] verification
mode, When Multi-Person combination opens the door, the fingerprint verification before the last one
(whether verified or not), this abnormal event will be triggered.

Unregistered Card: If the current card is not registered in the system, this abnormal event will be triggered.

Unregistered Fingerprint: If the current fingerprint is not registered or it is registered but not
synchronized with the system, this abnormal event will be triggered.

Opening Door Timeout: If the door is not closed within the specified delay time after opening, then the
sensor detects and triggers this abnormal event.

Card Expired: If the person with the door access level, punches after the effective time of the access control
and cannot be verified, this abnormal event will be triggered.

Fingerprint Expired: If the person with the door access permission presses fingerprint after the effective
time of the access control and cannot be verified, this abnormal event will be triggered.

Password Error: If using [Card plus Password] verification mode, duress password or emergency password
to open the door, this abnormal event will be triggered.

Failed to close door during Normal Open Time Zone: If the current door is in the normal open state, but
the user cannot close it by [Remote Closing], this abnormal event will be triggered.

Verification Mode Error: If the user opening door mode is inconsistent with that set for the current door,
this abnormal event will be triggered.

Multi-Person Verification Failed: When Multi-Person combination opens the door, the verification is
failed, and triggers this abnormal event.

® Alarm Events

Duress Password Opening Door: Use the duress password of the current door for verifying successfully
and trigger this alarm event.
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Duress Fingerprint Opening Door: Use the duress fingerprint of the current door for verifying
successfully and trigger this alarm event.

Duress Opening Door Alarm: Use the duress password or duress fingerprint set for the current door for
verifying successfully and trigger this alarm event.

Opened Accidentally: Except for all normal events, if the door sensor detects that the door is opened, and
this alarm event will be triggered.

Door-open timeout: This alarming event is triggered when they opened door is not locked at closing door
time.

Tamper-Resistant Alarm: This alarming event will be triggered when the AlO device has tampered.

Server Connection Failed: This alarm event will be triggered when the device is disconnected from the
server.

Mains power down: Inbio5 series controller events, external power down.
Battery power down: Inbio5 series controller event, built-in battery power-down.
Invalid card alarm: Alarm event trigger when invalid card swiping five consecutively.

& Notes: The user can customize the level of each event (Normal, Abnormal, and Alarm).
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FAQs

Q: How to use a card issuer?

A: Connect the card issuer to PC through USB port, and then select individual personnel card issue or batch
card issue. Move the cursor to the card number input box, and punch the card on the card issuer, then the
card number will be automatically shown in the input box.

Q: What is the use of role setting?

A: Role setting has the following uses: 1. Set unified level for the same type of users newly added, just
directly select this role when adding users; 2. When setting system reminder and determine which roles
can be viewed.

Q: How to operate if | want to set accounts for all personnel of the Company’s Financial Department?

A: First, create a new role in system setting and configure the functions to be used for this role. Then add a
user, set user information, and select the user’s role, thus adding a new account. For other accounts, do the
same.

Q:InWindows Server 2003, why the IE browser displayed error when access the system, how to solve

it?

A: This problem occurs because that Server 2003 has [Security Configuration Option] settings. If you want
to access the system, please configure it as follows: click Start — Control Panel - Add or Remove Program,
select [Add and remove Windows components] in the interface and click [Internet Explorer Enhanced
Security Configuration] option, clear the checkbox. Then click [Next] to remove it from the system. Open
the system again the browser will access the system properly.

Q: If backing up or restoring the database fails, the possible reason?

A: Backup fails: Please check the system environment variables, please go to Properties > Advanced to set
the environment variables as

“C:\Program Files\ZKBio Access\Main Resource\postgresql\bin:”
“C:\Program Files” is the system installation path, you can modify by your actual situation.

Restore fails: There are several reasons: The system version is too high or too low, or the database has
been damaged, you need to follow the prompts to change the system version or repair the system, re-
install the database.
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END-USER LICENSE AGREEMENT

Important information - read carefully:

This End-User License Agreement ("EULA") is a legal agreement between Sketch and you (either an
individual or a single entity). The SOFTWARE PRODUCT includes the Software application, associated
media, printed materials, and online or electronic documentation. By installing, copying, or otherwise
using the Software Product, you agree to be bound by the terms of this EULA. If you do not agree to the
terms of this EULA, do not install or use the Software Product.

SOFTWARE PRODUCT LICENSE

The Software Product is protected by copyright laws and international copyright agreements, as well as
other intellectual property laws and agreements. The Software Product is licensed and cannot be sold by
any third party.

1. GRANT OF LICENSE
This EULA grants you the following rights:
Installation and Use: You may install the software in an unlimited number of systems.

Replication and Distribution: You may distribute the software to an unlimited number of systems;
provided that each copy shall be a true and complete copy, including all copyright and trademark notices,
and shall be accompanied by a copy of this EULA. The Software Product may be distributed as a standalone
product or can be included in your own product.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS
Limitations on Deconstruction, Decompilation, and Disassembly

You may not deconstruct, decompile, or disassemble the Software Product, except and only to the extent
that such activity is expressly permitted by applicable law notwithstanding this limitation.

Separation of Components

The software product is licensed as a single product. Its components may not be separated for use on more
than one system.

Software Transfer
You may permanently transfer your ownership, provided the recipient agrees to the terms of this EULA.
Termination

Without prejudice to any other rights, ZKTeco may terminate this EULA if you fail to comply with the terms
and conditions of this EULA. In such a case, you must destroy all copies of the Software Product and all of
its components.

Distribution

The Software Product may not be sold or be included in a product or package which intends to receive
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benefits through the inclusion of the Software Product. The Software Product may be included in any free
or non-profit packages or products.

3. COPYRIGHT

All titles and copyrights in and to the Software Product(including but not limited to any images,
photographs, animations, video, audio, music, text, and applets incorporated into the Software Product),
the accompanying printed materials, and any copies of the Software Product are owned by ZKTeco. The
Software Product is protected by copyright laws and international agreements. Therefore, you must treat
the Software Product like any other copyrighted material except that you may install the Software Product
on a single system provided you keep the original solely for backup or archival purposes.

LIMITED WARRANTY
NO WARRANTIES

ZKTeco expressly disclaims any warranty for the Software Product. The Software Product and any related
documentation are provided "as it is" without warranty of any kind, either express or implied, including,
without limitation, the implied warranties or merchantability, fitness for a particular purpose, or no
infringement. The entire risk arising out of use or performance of the Software Product remains with you.

NO LIABILITY FOR DAMAGES

In no event, ZKTeco shall be liable for any damages whatsoever (including, without limitation, damages for
loss of business profits, business interruption, loss of business information, or any other pecuniary loss)
arising out of the use of or inability to use this product, even if ZKTeco has advised of the possibility of such
damages.

Acknowledgment of Agreement
| have carefully read and understood this Agreement, ZKTeco Ltd.,’s Privacy Policy Statement.

If YOU ACCEPT the terms of this Agreement:

| acknowledge and understand that by accepting this agreement, | have to abide by the terms and
conditions to use the Software Product to ensure smooth function. | also acknowledge that ZKTeco can

terminate the License Agreement if | don't comply with the terms and conditions.

IF YOU DO NOT ACCEPT the terms of this Agreement.

| acknowledge and understand that by refusing to accept these terms, | have rejected this license
agreement and therefore have no legal right to install, use, or copy this Product or the Licensed Software

that it incorporates.
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